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1 What's New

Version 4.3
This release of Mitel Phone Manager sees the introduction of Presence Profiles for controlling status and Dynamic
Extension Express features of the MiVoice Office 250.
Presence Profiles

This feature allows users to control their phone's status with a single profile which is visible to other users of the system.
Profiles also give users control over the DEE features of the telephone system.

Link to Presence Profiles section

Status on Lock

Phone Manager can now automatically switch profile or activate DND when the local computer locks. Any status change
is then reverted when the computer unlocks.

Link to Status on Lock section

Windows 10 Support
Phone Manager now supports Windows 10

Ability to hide Chat conversations
Chat conversations can now be hidden from the Chat window to reduce the number of conversations visible.

Link to Chat section

Profile Pictures

Each user can now set a personal profile picture which will be stored centrally on the server and will be visible to all
Phone Manager users.

Link to Profile Picture section

Phone Manager Mobile

There is now an option Mobile version of Phone Manager available for iOS and Android devices. The Mobile client
includes:

e Softphone

e Directory Access

e Voicemail, Call Routing & Missed Call notifications
e Call History

e Visibility of Contacts

Link to Phone Manager Mobile section

Version 4.2

This release of Mitel Phone Manager sees the introduction of the MiContact Center Campaign Manager client Ul along
with other enhancements to give users more control over their Mitel extension.

Campaign Manager

Phone Manager provides the client Ul for the MiContact Center Campaign Manager progressive dialing solution

Link to Campaign Manager section

UCD Control
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Phone Manager shows the associated extension's current UCD status and provides the ability to toggle between and
accepting or not accepting UCD calls.

Link to UCD section

Toaster Updates
Access to the Dial Pad and to Mute a call is now provided directly from the toaster while on a call.

Link to Toaster section

Phone Manager Version 3 Contact Import

For users upgrading from Phone Manager Version 3 there is now the option to import existing contacts from the
personal directory.

Link to Contacts Import section

Additional Plugin Support

Support for the following plugins have been added:
Link to Internet Explorer Plugin

Link to Netsuite Plugin

Link to SugarCRM Plugin

Link to Tigerpaw CRM

Link to Zoho CRM Plugin
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1.1 Known Issues

DPAR/ID | Description Notes/Work around

12706  Phone Manager cannot connect to the The Communication Service hostname and/or IP
Communication Service through a web address needs to be added to the relevant
proxy. exclusion list on the proxy server to enable Phone

Manager to connect.

12283  Phone Manager Softphone may be Disable any unused network interfaces.
unable to connect to the PBX when there
are multiple networks (including virtual
connections) configured on the client.

13506  Placing a SIP Softphone call on hold Don't leave SIP calls on hold longer than 14
longer than about 14 minutes will caused  minutes.
the call to be disconnected after this time.

14553  Enabling the download of Microsoft Disable the cache mode option within Microsoft
Outlook contacts can prevent users from  Outlook (https://support.office.com/en-
receiving emails when Outlook is US/article/Turn-on-or-off-Cached-Exchange-
configured in cached mode. Mode-e8966ca4-6ecd-4bdd-ade2-

64993dda432b).
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2 Quick Start

The guide provides information for frequently used features. For more information about these and other features, refer to the user
guide.

Phone Manager Ul with Presence Profiles

Profile Picture & Presence Settings & Preferences

Configure a personal picture and " Mitel Phone Manager - 0O X Access to application configuration
control presence ) including Hot Keys and CRM integration

25 Deborah Green
&
In the office ¥ Hot Desk 1024 ¥ @

Device Selection
Easily swap between extensions and

Search or Dial
control Hot Desk status if applicable (2]

| —"" Enter a number to dial or search

/ personal and global directories
earch or dial )

o

Device Control Contacts

Call history
Control ACD, access Chat \ Call History
and Voicemail features HH |7 Call log of all inbound, outbound
and internal calls
Favourites -
I Mitel Office
1846 | Free

Contacts View

Real-time view of users, A io Medi Favourites

extensions and agents throughout ntonio Medina ‘ Build up a favourites list of contacts

the organisation ¢@ 1032 | Out of the office (Free) by selecting users from existing

views or search results

I EXT 1824
1824 | Offline

2
Business Units =@ 1007 | Free
Centrally configured views of —— | Volume Control

departments and teams A Increase/decrease alerting or in call
volume and toggle mute status

j Mark Laird

Phone Manager Ul without Presence Profiles
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Profile Picture
Configure a personal picture

Device Selection
Easily swap between extensions and
control Hot Desk status if applicable

Device Control
Control ACD, access Chat
and Voicemail features

Contacts View

Real-time view of users,
extensions and agents throughout
the organisation

Business Units
Centrally configured views of
departments and teams

Phone Manager Call Banner

Call Banner
Visible whenever a call is in
progress of ringing at the extension

Call control

Use the call control

functions to clear, —
hold/retrieve or transfer

the call.

I

t. Mitel Phone Manager - 0O X

| Sarah Short
ﬁ Hot Desk 1024 ¥ @

- P

Search or dial

o | |

Contacts Call history
\a\
Favourites -
I Mitel Office
1846 | Free
Dorian Geroux
@ 1032 | Out of the office (Free)
I EXT 1824
1824 | Offline

== Candice Langlais
‘2@ 1002 | Free

Settings & Preferences
Access to application configuration
including Hot Keys and CRM integration

Search or Dial
| —"" Enter a number to dial or search
personal and global directories

Call History
Call log of all inbound, outbound
and internal calls

Favourites

Build up a favourites list of contacts
by selecting users from existing
views or search results

Volume Control
Increase/decrease alerting or in call

Neville Mayor

+44 1291 430000 _ _

®OOO ©

Hold Transfer Consult Mute Clear call

volume and toggle mute status

Use thiz icon to access the dial pad if

you naad to enter DTMF Tones on a call

Call details
"~ The main body of the toaster shows
details about the current call
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Using the Call Banner

If there are any calls at the extension then the Call Banner will appear, this provides control for features such as Hold/Retrieve,
Transferring, Answering and Clearing calls. If there is more than one call at the extension the banner will expand to display the
different calls and provide a means to swap between them.

Call Banner Buttons

Button Action
../i:\.. Answers an inbound ringing call
Ay

Clears a connected call

(o ./{:\. Toggles a connected call between hold and connected state
vy

.f”f\.l Offers the ability to divert an inbound call to voicemail or chosen destination

(o) &/
N/ Send to
Divert voicemail

,/G\. I,/G\,I Provides the ability to setup a direct transfer or consultation call

A7 AN,

Transfer Consul
."’:;_\'. When performing a consultation transfer, these buttons can be used to complete or cancel
A the transfer

e Used to toggle the mute state of a connected call
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Making Calls

Making calls using Phone Manager is a simple process and can be achieved in a number of different ways:

e Dial a number you know by entering it into the Search or Dial box and press enter
e Dial a user or device from the Contacts window by double clicking or pressing the dial icon next to it
e Search the directory by entering a name in the Search or Dial box to find a number to dial

e Highlight a number in a different application and double click the Highlight & Dial icon which can be found on the right
hand side of you screen

Transferring Calls

Calls can be transferred by using the buttons on the call banner. The main Phone Manager Search or Dial or the Contacts
Window should be used for choosing the transfer destination. After pressing Consult or Transfer on the Call Banner the main
Phone Manager window will be brought into focus ready for you to enter a number to dial.

Alternatively, dialing a number using any of the make call methods described above when a call is in progress will automatically
setup a consultation transfer without having to first press a button on the Call Banner.

When performing a consultation transfer it can be completed or cancelled using the relevant buttons on the Call Banner or
simply hand up to complete.

DND w l Logged in (1020) ¥ sa Accepted Voicemail Dial pad Mo forwarding Chat

Type or select a transfer destination

Contacts View

The contacts tab within Phone Manager provides a real-time view of information about other devices including users,
extensions, agents, speed dials and hunt groups. This gives an overview of the status of these devices and call control features
such as single click to dial.

The views available include a personal favorites view and centralized business units that have been configured on the server.
Use the binder icon to hide or show different views.

Icons Description
User icon, This icon appears on the Large view of the contact screen. The users

status shows in the circle in the bottom right-hand corner. The user profile
image will display in the large circle.

If the user has no profile picture then the icons below will be used.

User icon, an outlined icon means the user does not have Phone Manager
running
u@ u@ E@ m@ Extension icon
P P P P Agent icon
NCALNCAD

|’1 E] [\'E] Directory Contacts (Global or Personal Directory, Phone System Directory,
I — Outlook Directory)

Color Key: Gray - Offline, Green - Available, Red - Busy, Blue - Do not disturb, Yellow - Wrap up

Page 11



Mitel Phone Manager 4.3

Application Buttons

Button

Action

Highlight & Dial, this icon can be found attached the right hand side of the desktop and can be
used to dial numbers from other applications. Highlight a number to dial in another application
and double-click the icon

DND, provides control of do not disturb status and displays the current status

ACD*, provides control of ACD Hunt Group status and displays the current status

UCD?*, provides control of UCD Hunt Group status and displays the current status
Voicemail, provides access to voicemail boxes that notify the local extension and indicates how
many messages are waiting

Dial Pad, provides access to the Dial Pad which can be used to initiate calls or more commonly
to dial DTMF Tones over an existing call

Forward, provides control of the forward state of the local extension and displays the current
status

Provides access to the Chat window and to see existing conversations

Binder, controls visibility of different Contact views
Can be used to add new contacts to personal or global directories
Used to switch the view on the Contact window between large icon and details view

Mute, controls the mute status of the local extension when a call is in progress

Volume controls, used to change the alerting volume when idle and the call volume when a call
is in progress

Settings, provides access to the setting area of the application to change things like Hot Keys,
CRM integration and personal preferences

Hot Desking Toggle, if the associated extension is a Hot Desk Profile then this toggle switch will
display to control and display Hot Desk status

Toolbars*, launch one or more centrally assigned toolbars to help perform common telephony
tasks

Campaign Manager®, launch the client Ul for MiContact Centre Campaign Manager to make
and disposition outbound dialer calls

* This icon will only appear when licensed and/or when configured to appear by an administrator.
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Call History

The Call History window shows all internal, external and missed calls on all of your assigned devices.

When the Call History window is not open, any missed calls will be notified with a red circle on the tab. Calls can be returned by
pressing the handset icon.

A history of any calls made to or by any of the devices associated with your user account will be displayed. To see additional
information regarding calls expand the Phone Manager application to full screen.

Right clicking on a history line allows you to add the contact to your directory.

Contacts Call history

Mumber Time Talk time
) () Phil Taylor 12:07 09:58
& {_3 Helene Moulin 10:53 00:00
) -f‘x. Youssef Yount 10:38 00:00
@) !:_H: Tomas Mendoza  10:26 13:26
& (» (&) SalesRoom 10:07 00:00
@ (») (V) Mitel Office 09:52 08:19
W ) () 1841 09:52 00:12
) ":‘:_.-\' Alberto Puga (09:49 01:19
Icons

Button | Action

@ Inbound call that was answered (This includes calls answered by voicemail and in the case of DEE
calls answered by other devices in the DEE group)

@ Inbound call that was missed
C’; Outbound call

Redial, used to call back a number on the call history. If this icon is grayed out there is no number
available to redial

-
®©

/%  Playback™, used to playback a recording of external calls
&)

** Only available in conjunction with a Xarios Call Recording solution
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3 Overview

Phone Manager is designed to make using your Mitel MiVoice Office 250 handset as easy as possible. This document is
designed to outline the features of Phone Manager and help you get the most out of the product.

Phone Manager requires an instance of Mitel Communication Service (MCS) with the Application Server role supporting Phone
Manager clients, installed and running on the Local Area Network (LAN). The licensing for the product and many of the
features is controlled via the Application Server so you may need to contact your IT department or phone system supplier for
help should any of the features described in this document require a license.

Phone Manager runs in a Microsoft ® Windows environment and is designed to improve your productivity by integrating the use
of your MiVoice Office 250 phone with your PC and the various software applications you use to function well within your team.
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3.1 Requirements

Overview

The system requires specific information and requirements to be met for any installation. Read each of the sections and ensure that
the information requested is available prior to an installation.

System Requirements

To be able to install and run Phone Manager the client computer needs to meet the following minimum requirements. If installing into
a multi user environment where multiple instances of the client will be running, for example Microsoft Terminal Service, Citrix etc. then
see the Multi User Computer Requirements section.

Operating Systems

e Windows 7 Pro/Enterprise/Ultimate 32-bit/64-bit

e Windows 8 Pro 32-bit/64-bit

e Windows 8.1 Pro 32-bit/64-bit

e Windows 2008 SP2 Standard/Enterprise/Datacenter 32-bit/64-bit
e Windows 2008 R2 Standard/Enterprise/Datacenter 32-bit/64-bit
e Windows 2012 Standard/Datacenter 64-bit

e Windows 2012 R2 Standard/Datacenter 64-bit

[rEI The Windows 2008 or Windows 2008 R2 Server Core installation options are not supported.

The Windows 2012 Foundation and Essential versions are not supported.

Hardware Requirements

The minimum recommended hardware is dependent on the number of devices configured on the PBX and the number of
clients that will be connected.

Processor Intel Core 2 Duo 1.8GHz or faster processor (or equivalent)

Memory  Minimum: 1GB RAM
Recommended: 2GB RAM or more
When Phone Manager is running it will use a minimum of 70MB of RAM per client - this can be significan
more depending on configuration and number of devices and/or users on the system.

Network  IPv4, 100Mb / 1Gb LAN

Hard Disk Minimum: 20GB free space

Video Minimum: DirectX v9 compatibly graphics cards with 120MB RAM
Recommended: DirectX v9 compatibly graphics cards with 1024MB RAM

Software Requirements

The following software is required to be installed.

e .NET Framework 3.5 SP1
e NET Framework 4.0 Full
e Windows Installer 4.5

Multi Users & Virtual Desktop System Requirements

Phone Manager can be run in multi user and virtual desktop environments such as Microsoft Terminal/Remote Desktop Services, Citrix
XenApp or VMWare Virtual Desktop Infrastructure (VDI) with the following limitations:

e The 1st Party TAPI drivers is not supported

Page 15



Mitel Phone Manager 4.3

e Phone Manager Softphone is not supported

When deploying in these environments then the amount of memory, CPU usage and Video resource that Phone Manager will use
needs to be determined. As the resources required are dependent on configuration and the number of devices and Users in the system
then this needs to be benchmarked first to ensure the number of concurrent Users can be supported on the hardware available.

Page 16



User Guide

3.2 Licensing

Phone Manager is available in several different license levels. When you connect to the Communication Service a license will
be assigned to you based on the Client Profile assigned to your User account on the server.

All clients provide the following features:

e Standard Features: Legacy support only. Provides call control features, call history & status visibility of contacts (only
possible following an upgrade from Release 3).

e Outlook Features: As well as Standard features, adds the additional functionality of screen popping and populating call
history journal inside Microsoft Outlook as well as dialing contacts and auto-creating MiVoice Office 250 Meet Me
Conference appointments.

e Professional Features: As well as Outlook license features, adds the additional functionality of integrating with many
other CRM applications. Adds TAPI & .NET API access and supports custom Macro design.

e Team Leader Features: As well as Professional license features, adds the ability to silent monitor other users and
control their ACD group status, DND and call forward status.
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3.3 License Comparison

Feature Standard Outlook Professional Team Leader

Call control up to 4 calls
Highlight & Dial

Desktop presence

Call history

Do not disturb & Forward Control
Instant Messaging (chat)
Personal Directory

Call Recorder Playback®
Group Mailbox Notification
Profile Images

Presence Profiles

Hot Keys

Call banners including profiles
Softphone

UCD Control

ACD Control

Integrated Toolbar

Full Toolbar

TAPI (1st Party)

BEBECEBEB0O0000000000000

Macros

Application Support

o
<
f=o
o
e}
]
o
=1
<

API Access (.NET/VB)
Campaign Manager Client

Alarm Notification

BR800 000000000
BEEBO0C000000000000000000000
CO000000000000000000000000

) XY X

Hunt Group Status
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3rd Party ACD, DND & FWD Control

Silent Monitoring

x| %

) %
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3.4 Configuration

Connection Details

Phone Manager requires a basic level of configuration to get it connected to the Communication Service and controlling your
extension. The following information is required when Phone Manager starts up:

Host address

User Credentials

Extension

Server Connection

This is the IP address or host name of the server running the Communication Service
software. Phone Manager will try and find this automatically on start-up. If it does not find
an Communication Service or it finds more than one then some user interaction is
required to confirm the connection details.

Phone Manager needs to connect to the Communication Service with a user account. By
default, it will use the account you are logged into your PC with to authenticate. If you
wish to override this you can do so in the Connection settings section.

Phone Manager requires the details of the extension you are using when it starts up so
that it can show the correct call information. There are several of ways of providing Phone
Manager with this information. Please read through the Connection settings section for
more details.

The first time Phone Manager starts up it will broadcast to try and find the Communication Service. If it doesn’t find one
or if it finds more than one the user will be able to select the correct one to use. Select the correct server from the
Available hosts list or enter the IP address or host name of the server you wish Phone Manager to connect to in the

Host address field.

When Phone Manager starts it will use the Windows account details of the current logged in user. If this is not
appropriate then check the Override login details and enter the Username and Password to use instead. (This might
be necessary if for example you connect to the office from your home PC).

If the User account is linked to a Microsoft Active Directory User account then enter the username in the DOMAIN\User
format, otherwise use the username and password provided by your administrator. By default the username is your
extension number and leave the password blank to use the default value.
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4 Outlook Features

The following section covers the features that are available in the Microsoft Outlook licensed version of Phone Manager. The
specific Microsoft Outlook features that are provided are:

Call Control

Extension Control

Contacts

Call History

Chat

Directory Integration

Screen Popping
Call History
Calendar / DND Synchronization

This license also provides:

How to make and transfer calls. How to handle multiple calls and tell the
difference between different types of call.

Controlling the state of your extension. Forward states, Do Not Disturb and
ACD Agent control. Volume Control and Voicemail access.

View the status of other users within the organization. Searching for
internal and external contacts and using the contacts view to manage
favorites and speed up communications.

Track all calls you make on the system and optionally play them back
(requires Call Recording integration license).

Communicate with other users inside the organization using chat/instant
messaging.

Outlook contacts can be linked into the Phone Manager directory and
displayed on the toaster.

Outlook contacts can be screen popped.
Outlook contacts can have call history (journal entries) created.

Outlook calendar can be used to automatically synchronize the User's
DND state with their calendar items.

Hot Keys Configure global hotkeys to automate common telephony tasks.

Call Banner Profiles Toaster support for custom banner profiles.

Softphone Support for connecting as a softphone. (Requires a softphone license).

Integrated Toolbar Only available when connected as a softphone. This provides 5 buttons that can be

customized on the main window.
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4.1 Call Control

Overview

Making and receiving calls is obviously the primary purpose of a telephone. Phone Manager makes this process as simple and
efficient as possible, providing you with context sensitive action buttons and giving you all the information you need about the
calls you are on.

Making Calls How to dial internal and external numbers.
Highlight & Dial Dialing from within other applications.

Toaster Seeing details about the call you are on and performing common tasks such as putting calls on
hold, retrieving calls and clearing calls.

Transferring Performing supervised/announced or direct transfers.

Multiple Calls How to handle multiple calls at your extension.

Dial Pad Dialing out with the dial pad or dialing DTMF digits over a call to navigate through an attendant
or IVR.

Uri Schemes Click to Dial URI schemes
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4.1.1 Making Calls

Making a call to a number is a simple process that can be achieved a number of different ways.
Dialing a number you know

If you know the number you wish to dial, whether it is another extension internally or an external number then simply
enter the number into the Search or Dial box and hit the enter key or press the ‘Dial’ button to make your extension dial
the number.

If you are dialing an external number there is no need to worry about adding in any additional digits to get an outside
line or worrying about area codes as this will be done automatically as per the configuration in the server.

Dialing from the contacts screen

If you want to dial another user within your organization or a contact that is stored in a global or personal directory you
simply need to click the dial icon next to their status icon on the contacts screen or double click the status icon itself. If
the contact to dial is not currently visible start entering their name into the Search or Dial box to bring up a list of
matching contacts.

.
*

£ If you dial a contact while you are already on a call with someone else, Phone Manager will automatically
set up a consultation/enquiry call for you.

Page 23



Mitel Phone Manager 4.3

4.1.2 Highlight & Dial

Dialing from another application (Highlight & Dial)

Often you will have the need to dial a number from another application. Commonly this will be a web page that you want
to dial the contact details from or an email someone has sent you.

To do this you can use the Highlight & Dial features of Phone Manager. Simply highlight the number you wish to dial
and then double click on the Highlight & Dial button or use a Highlight & Dial hot key (See the Hot Keys section for
details). You will find the Highlight & Dial button docked to the right-hand side of your screen.

United 10th Floor 155 Bishopsgate M4 1201 436 06 n

Kihgdom London, England fax: 44 2072 565072
(London) EC2M 3TQ

You can move the Highlight & Dial button up or down the screen to suit your requirements.

Generally as long as the number can be copied to and pasted from the Windows clipboard then this should work. This
can be tested by highlighting the telephone number and pressing Ctrl+C and then opening Notepad and pressing
Ctrl+V. If the number appears then the test was successful.

/v, Some 3rd party applications can perform their own clipboard control causing highlight and dial to not
function correctly. Testing with a Phone Manager client is recommended to ensure full compatibility.
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4.1.3 Toaster

The toaster window will appear whenever a call is in progress at your extension. It is designed to give you all the details you need
about the call in progress and provide you with context sensitive buttons to perform actions on those calls such as hold or retrieving a
call.

00:03

Voicemail

2750

3\ Q) Q)
(:, ’6}* C @

-

Hold Transfer Consult Clear call

Context Sensitive Buttons
The following buttons will appear at different times on the toaster depending on the status of the call.

@ Use this button to hang up on a call.

|‘§“-'|‘ If you have the handset of the telephone in your hand you will be disconnected from the remc
party but will be left with a connection to the telephone system.

Clear call

Use this button to answer an incoming call.

a.

=/
I./;:‘nl These hold and retrieve buttons will appear once a call is in progress. If you hold a call by pressingc
S hold button on the toaster or on the telephone itself, the hold button will be replaced with a retrieve

]

button to allow you to pick the call back up.

a Ka =

f

ey

pe= ]
1]
—+

This option is displayed on incoming ringing calls. Use the divert to send an unwanted call to anotr

..\
<)

Nl destination.
Divert
I\.I This option is displayed on incoming ringing calls. Use the send to voicemail option to send an

\a0 unwanted call to your voicemail mailbox.

oicemail

I,/ﬁ\, There are 2 ways of transferring a call to another location. Using the transfer option will move the ¢

N another location immediately. The consultation option will allow you to speak to someone at the ott
T;_"_fj‘:!’ location first before putting the call through.

&)

Consult

I,/;\I These options are available if you have set up a consultation call. To complete the transfer hang u

A handset of the telephone or press the complete button. To go back to the original call press the cai
Complete button.

%):

[
=1}
3
-
m
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4.1.4 Transferring

Transferring a call can be done in several different ways depending on whether you want to transfer an answered call directly
(blind transfer) or by announced transfer. Alternatively if the call is ringing, then you can divert the call before answer.

Transfers

When connected to a call, context sensitive toaster action buttons appear to offer the user the system features that are
possible at the time.

/v, Softphone does not support transferring a connected call straight to a Voicemail box

Direct Transfer

To perform a direct transfer where the call is sent to the transfer destination before the consultation call has been made
click on the Transfer button and this will give focus to the main window with the cursor in the Search or Dial box. Search
for the contact to transfer the call to and click on the dial button next to their icon (or highlight it and press Enter) or type
in the number in the Search or Dial box and click on Dial. The call will then be sent straight to this contact and the call
will clear from your extension.

Announced Transfer

To perform an announced transfer a consultation call needs to be set up before transferring the call. Whilst on a call
click on the Consult button and this will give focus to the main window with the cursor in the Search or Dial box, or go
direct to the main window and find the contact, or use the hot key for Directory Search. Use any of these methods

to find the contact to transfer the call to in the main contact window.

Once the contact has been found, dial them and this will set up the consultation call. For example this shows a
consultation call made to extension 1801.

—. Zhao Ping

() ; 23
" 079 o023 Zhao Ping e
) EXT 1809 079

1809 00:09

Complete Cancel

As there are multiple calls at the extension now the summary panel appears to the left of the toaster. This shows all the
calls at the current extension and clicking on each call will update the details on the right hand side with the relevant
information for the call selected.

The consultation call has not been answered yet but the transfer can be completed at any time by clicking on the
Complete button.

To cancel the consultation call and not perform the transfer to this contact, click on the Cancel button (shown
above). This will then clear the consultation call and connect you back to the original call.

Alternatively swap over to the enquiry call and click on the End button shown below. This will cause the original call to
be left on hold and would need to be manually retrieved.
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-~ Zhao Ping -
Y org o126 EXT 1809 o
EXT 18049 1809
1809 01:11
=) () ) ®
N N\
Hold Transfer Consult Clear call
Divert

When a call is ringing the toaster action buttons change to reflect what you can do with this call.

Deepak Anik oo:ba
079
BEM DDI
() (=) (&)
IR
Answer call Divert Send to
voicemail

To divert a call click on the Divert button and this will give focus to the main window with the cursor in the Search or Dial
box. Search for the contact to divert the call to and click on the dial button next to their icon (or highlight it and press
Enter) or type in the number in the Search or Dial box and click on Dial. The call will then be sent straight to this contact
and the call will clear from your extension.

The toaster also provides a Send to voicemail button that enables a single click divert of a call to voicemail.
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4.1.5 Multiple Calls

The toaster popup will show multiple calls at an extension by expanding to the left with a summary pane that lists all of the calls
in progress. Clicking on the entry for a specific call will update the details on the right hand side with the relevant information for
the call selected.

For a single call the toaster will be shown without the summary pane.

Deepak Anik 0o:04
079
BEM DDI
Answer call Divert Send to
voicemail

If a second call comes in the then toaster will expand with the summary pane. This example shows the first call as connected
and the second call is ringing.

Alberto Puga ,
079 ooie  Alberto Puga oue
oy Mo caller ID 079
~ Mo caller ID 00:02 ALB DD
Hold Transfer Consult Clear call

If a third call comes in then this gets added. In this example the first call is connected and the second and third calls are ringing.

Alberto Puga ,
07g 00:56 Alberto Puga 00:58
oy Mo caller ID 079
=~ Mo caller ID 0017 ALB DDI
ey EXT 1809
HICICKG @,
Hold Transfer Consult Clear call

Next to each call in the summary pane the icon to the left reflects the state of the call.

Call connected

o

) Call ringing
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(1) call on hold
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4.1.6 Dial Pad

The dial pad can be used for dialing numbers or for navigating Auto Attendants or Interactive Voice Response (IVR) systems.
This can be opened all the time by clicking onto the dial pad icon from the main window.

t. Dialpad ? -0 X

Alternatively whilst on a call click on the dial pad icon from the toaster window to display the dial pad window.

EXT 1803 00:03
1803

© ® @

Answer call Divert Send to
voicemail

@‘ In order to ensure that the normal use of numeric keys on your computer doesn't interfere with a call, DTMF
tones will only be sent over a call whilst the Dial Pad window or toaster has focus.
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4.1.7 URI Schemes

Phone Manager supports a range of different well known URI schemes that enable applications to be able to do direct click to
dial by turning the telephone numbers into hyperlinks. For example if an application wraps the telephone number into this
format:

tel://01234567890

Clicking on this link will then cause this number to be dialled. The following URI formats are supported:

URI Scheme Example

dial dial://01234567890

sip sip://01234567890

callto callto://01234567890

tel tel://01234567890

call call://01234567890
dialfrompm dialfrompm://01234567890
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4.2 Extension Control

Overview

Phone Manager provides complete control over the status of your extension. The application can be setup to control the
extension in one of two modes. The mode used is controlled on the server using the Phone Manager Client Profile.

Presence Profiles
Different profiles contain information about how a user's primary extension is setup. To change the configuration of the
telephone users need only select a different profile. This form of control provides users with a simple way of controlling

their configuration and can be tailored to each user's needs. It is also an essential feature when working with Phone
Manager Mobile.

For more information on using Presence Profiles click here.
Direct Control

Users have direct control of the extension Phone Manager is connected to using the relevant feature buttons:

Do Not Disturb Single click access to any of the 20 do not disturb states programmed on the
telephone system to ensure you are not interrupted when busy.

UCD Hunt Group Call | Control of the UCD hunt group state of your extension. For example, to enable
Control UCD hunt group calls be taken.

Manual Forwarding Control of the local forward state of your extension. For example, divert calls to
voicemail or to your mobile when busy.

Common

The following controls are common to users using Presence Profiles or Direct Control

ACD Agent Control Login to all or selected hunt groups your ACD agent ID
belongs to.
Voicemail Access Visual indication of when you have voicemails and single

access to dial into the voicemail system to retrieve them.

Volume Control Increase or decrease the volume when ringing or during
a call or mute the audio all together.
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4.2.1 Do Not Disturb (DND)

When away from your desk or busy in a meeting you can set the Do Not Disturb (DND) message on your phone so other users
on the MiVoice Office 250 system know your status. The PBX provides 20 predefined DND messages for you to choose from.

| @' These messages can be re-programmed in Database Programming on the MiVoice Office 250 system.

The "DND" icon enables users to set their DND status and changes color to indicate what state they are currently in.

Icon Description

DND is not configured.
® DND is configured.

Clicking on the "DND" icon when not configured will allow the user to select the DND message to use from the 20 pre-
configured messages shown. When a message has been selected then a prompt will be shown to allow the user to optionally
enter up to 16 characters of DND text to supplement the DND message. For example:

"IN MEETING UNTIL — 12.30 PM"

Any MiVoice Office 250 user now calling your extension or viewing your status in Phone Manager will see your DND message.
If you are in the DND state, the Phone Manager DND icon will turn red. Clicking this will toggle the DND state to off turning the

icon blue “='. Clicking again will set DND state to on.
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4.2.2 ACD Agent Control

ACD Agent IDs can be used on the MiVoice Office 250 system to log in and out of whichever ACD hunt groups you Agent ID
belongs to. Each hunt group would generally indicate a different type of call to be answered or indicate a specific skill set to use
for that call.

The ACD icon enables users to control their ACD status and changes color to indicate what state they are currently in.

Icon Description
Logged out
‘ Logged in and free

Logged in and in wrap up

When you are logged out and press the ACD icon the list of hunt groups for the agent ID that is assigned to your user account
are shown. Clicking on "Login agent (xxxx)" will log into all ACD groups that this agent ID is a member of. Alternatively select
the specific hunt group that you wish to login by clicking on the group.

To use a different agent ID click on the "Login with agent ID" option and then enter the ID in the box shown and this will log the
agent into all groups. The list of individual hunt groups will then be updated for this agent ID to enable specific groups to be
logged out of.

While logged in a tick will show against all hunt groups that you are logged into. The menu can then be used to login or out of
any of the other groups at any time.

Z] The ACD icon will only be displayed if the user has the "Enable ACD control" flag set against their Client Profile.
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4.2.3 UCD Hunt Group Calls

UCD hunt groups can be used on the MiVoice Office 250 system to route calls to groups of extensions. Each hunt group would
generally indicate a different type of call to be answered or indicate a specific skill set to use for that call.

The "Hunt Group Calls" icon enables users to toggle their UCD status and changes color to indicate what state they are
currently in.

Icon Description

UCD hunt group calls will not be presented.

L UCD hunt group calls will be presented.

frEI The UCD icon will only be displayed if the user has the "Enable UCD control" flag set against their Client Profile.
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4.2.4 Manual Forward

Your extension can have a manual forward set to divert calls to another destination under different circumstances. The various
forward states available to choose from are:

State Description

No Answer Forward calls when you don’t answer them. The default no answer time on the PBX is 15
seconds (This system wide timer can be changed)

Busy Forward calls only when your extension is busy.
No Answer Busy This option is a combination of the first two options.

All Calls Forward all calls that alert you extension immediately.

The "Forward calls" icon enables users to set their forward status and changes color to indicate what state they are currently in.

Icon Description

No forwarding is configured.

< Forwarding is configured.

Clicking on the "Forward calls" icon when no forwarding is configured will allow the user to select 1 of the 4 options available. A
text input box will then appear to prompt for a forward destination. In this box you can enter an internal or external number such
as a mobile phone number (if external remember to include the number to access an outside line).

If the forward state is already configured, then clicking on the icon will remove the forward setting from your extension.

] The MiVoice Office 250 system also supports pre-programmed forward rules called "System Forwarding".
Manual Forwarding will override any System Forwarding rules you may have set.
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4.2.5 Voice Mail Access

The "Voicemail" icon shows a red badge indication with the number of voice or extension messages that have been left for
each different one. Clicking on the icon displays a list of the messages and selecting the individual one will either dial into the
correct mailbox or call the extension that left the message.

In this example there are 3 messages.

(3]

Sales (1077) (1)
1809 ©

Local Mailbox (1021) 'ﬂ'

e Sales (1077): is a voicemail for an un-associated mailbox with the notification extension set to this users.
e 1809: is an extension message left from extension 1809.
e Local Mailbox (1021): is a voicemail for an associated mailbox for this extension.

When there are no outstanding messages then there will be no red badge indication shown.
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4.2.6 Volume Control

The volume functions behave differently depending on whether Phone Manager is associated with your extension phone (Desk Phone)
or in SIP softphone mode.

Extension Volume control

The volume of your extension phone can be controlled using the mute , volume increase and volume decrease

icons at the bottom right of the main window.
When controlling a Mitel extension desk phone these icons are grouped together in the bottom right corner like this

Depending on the state of your extension the icons will do different things:
Idle or Ringing State Mute will be disabled.

Volume decrease will decrease the ringing volume and save it.

Volume increase will increase the ringing volume and save it.

Call in progress on the handset Mute will be enabled.
Volume decrease will decrease the handset volume and save it.
Volume increase will increase the handset volume and save it.

Additional types of call in progress include Hands Free and Headset and the volume control will apply independently to each
type of audio call.

When the mute icon is pressed it will turn blue "" to indicate that audio is now muted on the call. To turn mute off simply click
on the icon again.

Softphone Volume

The volume controls are enhanced to include a slide control when connected as a softphone. This offers a greater level of
control than when Phone Manager is controlling an extension and look like this:

When using the volume control in softphone mode you will be setting the volume of whichever audio device is configured in
Settings ---> Softphone ---> Audio within your Phone Manager software.

| Z] Volume control for a softphone is only available when using the built in softphone.

| %] When muting a call on the softphone both parties audio are muted.
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4.3 Contacts

Overview

The contacts tab within Phone Manager provides a view to provide real-time information about other devices including Users,
extensions, agents, speed dials and hunt groups. This gives a single quick view of the status of these devices and call control features
such as single click to dial.

Contacts
HE
[ | |
Favaorites -
2= SimonC Amy D I EXT 1809
— 79 1024 | Free 1809 | Free
Mitel Tech LS Office
m 2004 @ +1888-027-467°
Support -
Roberto Bastien Zhao
1836 | OM HOLIDAY 1802 | Free 1804 | Busy | 1803
‘ lsa S Shana Pippa
1819 | Free Offline 1871 | Offline

Groups

Each device that is shown is part of a group. Clicking the directory button on the top left hand corner displays the available
directories and gives the User the ability to be able show or hide each group.

Contacts

Accounts
Development
Dialler
Directors
Favourites
Sales
Support

If there is a green tick next to the entry then this will be shown. Un checking this will cause the directory to be hidden.

Each Phone Manager User has their own Favorites group which they can add and remove devices to and from and is personal
to each User. They can also add items from the Directories to this, for example Speed Dials, Personal Contacts, Central
Contacts or Microsoft Outlook Contacts.

The other groups are created automatically from the Business Unit structure configured on the server.
Device Control

For each device there are actions that can be performed. Right clicking on a device will display a menu of the available actions
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and the options available are dependent on the type of device, the state of the device and the license level of the client.

Gar——=
—_— Call control k

Chat
Rac
1871 Set DND status r
San ACD Status k

=3 Set forward status  #

Silent monitor k

Add to favorites

ﬁ A& o
Device View

The contacts tab supports displaying the device information in either a large icon or a details view. The current view can be
changed using the view selection buttons in the top right corner.

Contacts Call history

The current view is highlighted in blue, with the large icon view using the left button and the details view on the right.

e Large Icon View - Displays a grid of devices with large icons and up to *3 pieces of information about the contact
e Details View - Displays a table of devices with more detailed information about their state

* The default information shown is Number, Status & Caller ID. To change the information displayed in Large Icon View, switch
to Details View and move the columns around so that the information required is in the first 3 columns after the Name column.

The following information can be added in the Details View:

Grouping | Information | Description

Call Account The current Account Code that has been entered on the call will appear here. If more
Details Code*** than one code has been entered it will show the last one

(ifno call Call Type  The type of call; Internal, Inbound or Outbound

isin

progress Caller ID The telephone number or speed dial name of the caller

these DDI*** If the call was Inbound then this field contains the DDI number the call came in on
columns

will be Display***  This column contains the Display information form the device

empty) DNIS*** If the call was Inbound then this field contains the DNIS for the call
Duration*  The current duration of the call in progress at this device

Hunt If the call was presented through a Hunt Group it will be displayed here
Group***

Ring Time* The ring time for the current call at this device
Start Time* The start time for the call at this device
Talk Time* The talk time for the call at this device

Time On The hold time for the call at this device
Hold*
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Transferred Where the current call was transferred from

From
Trunk If the call is not Internal, this column will display the Trunk number being used
User Calls The number of calls currently queuing at the device

Details  Queuing

Calls The number of calls currently ringing at the device

Ringing

Current If the device is an Agent ID, this will show where they are logged in
Device***

Current A CSV list of ACD Hunt Groups the device is a member of

Hunt

Groups™*

Forward The current Forward State of the device

Status™**

Name The name of the current device

Number The number of the current device

Status The state of the current device. If it is a User it will show their Presence supplemented
in brackets with the state of their primary extension

Time In The time passed since the device's last state change

Status*

Voicemail  The time passed since the device's last state change

Count**
Server Contact The name of the contact on the current call
Contact i .
onac Contact The other contact fields from the server numbering 1 to 10

(ifthere  Field 1 to
isacall 10
at the

device

and the
server

has a

contact
match it

will

display in
these
columns)

* Time based columns are only calculated from when Phone Manager starts. Time based columns by default update every 5
seconds however this is configurable on the server.

** Only available when using a Team Leader license
*** These columns are not available if using a Standard license

To add or remove columns from the Details View gird, right-click anywhere on the column headers and a menu will appear.
Select or unselect items in the menu to hide or show them. Columns that are already visible will appear with a tick against them
in the menu:
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Device Icons

Each type of device has a different icon and changes color depending on the status of the device.

b |'r‘
1)L

o]
aey ey L

P ODODODOOE EmE E b e be O [0 D00

Speed dial contact from the telephone system.

Central server or personal contact, i.e. Global Directory.
Microsoft Outlook contact.
Microsoft Outlook 365 contact.

A user that has set a personal profile image. In this scenario the small circle in the bottom right-hand corner st
the user's status. The status colors match those of the user icons below.

User who is not connected with Phone Manager and has no extension/agent assigned to their User account.

User in the free state without Phone Manager connected (this shows the status of the extension/agent assigne
their User account).

User in the busy state without Phone Manager connected (this shows the status of the extension/agent assign
their User account).

User in the DND state without Phone Manager connected (this shows the status of the extension/agent assigr
their User account).

User in the free state who has Phone Manager connected.
User in the busy state who has Phone Manager connected.
User in the DND state who has Phone Manager connected.
Extension in the offline state or shown in a search result list.
Extension in the free state.

Extension in the busy state.

Extension in the DND state.

Agent is logged out.

Agent in the free state.

Agent in the busy state.

Agent in the DND state.

Agent in the wrap-up state.

Hunt group.

Page 42



User Guide

4.3.1 Directories

Overview

Contact directories can be created to provide more information about the contacts who are calling in and to provide directory
search features to help find people to call. The directories can be populated manually by users, bulk imported from files or
linked directly to other databases.

There are several different sources that can be used to import contact records. They include:

e Manually created by users.

e Imported from text or CSV files.

e Linked direct into existing databases.

e Your own Microsoft Outlook personal contacts.

e The MiVoice Office 250 PBX System Speed Dial list (Maximum 1000).

Using the contact directories, Phone Manager can search to find any matching contacts to dial. When an inbound call is
received or an outbound call made, the relevant directories are searched automatically and the matching contact information is
made available and displayed on the Phone Manager toaster.

Global directories

The system has a global directory that is accessible by all users by default. This is stored centrally to enable the users
to access this from any location that they connect from. Any user can add, edit or remove contacts.

Personal directories

Each user also has their own personal directory that is only accessible by them. The associated user then has the ability
to be able to manage this directory and add, edit or remove items from this. This is stored centrally to enable the user to
access this from any location that they connect from.

& If the user has upgraded from a Phone Manager v3 then their existing personal contacts can be
imported. This is only supported if the users personal contacts have been stored locally (either in the
%PROGRAMFILES% folder on the computer they are on, or in their "My Document" folder and NOT
centrally. If they are stored centrally then they will need to be migrated before upgrading. If these files
are present then Phone Manager will prompt the user automatically when started to import.

Database linked directories
External database can be linked to; using an ODBC or OLE DB connection. The contacts within this database are then

imported into the system on a regular basis to keep them up to date. These directories are read only as any
modifications to a contact would be lost on the next import.

CSV directories

Text files in CSV format can be used to import contacts. The contacts can be imported into the system manually or on a
pre configured schedule so that the directories are always up to date. These directories are read only as any
modifications to a contact would be lost on the next import.

& For more information see the Contact Directories section in the Communication Service help.

Microsoft Outlook personal contacts

If a User has the Download Outlook contacts option enabled in their Client Profile on the server, then personal contacts
from within Microsoft Outlook can be searched directly from Phone Manager.

| ["El The User needs to be connected with a Microsoft Outlook license to enable this feature.

| él This requires Microsoft Outlook to be running within the same session as the Phone Manager client and

Page 43



Mitel Phone Manager 4.3

only local contact folders are supported.

The contacts can be searched using the Home, Telephone or Mobile/Cell number fields as well as the first, middle, last
and company name fields associated with the Outlook contact. The only user that can search and access these
contacts is the local User. Other Users cannot access these contacts.

MiVoice Office 250 PBX System Speed Dial List

The PBX contains its own directory in the form of system speed dials. These entries are configured from within
Database Programming on the MiVoice Office 250 system and the Phone Manager server will download them directly
from the PBX when connected. Each entry only has a name and number associated with it and each of these fields can

be used to search. Any changes to this list made on the MiVoice Office 250 system will automatically update the Phone
Manager directory.

All Phone Manager users have access to search and dial the MiVoice Office 250 system speed dials.

[rEI Private speed dials can NOT be dialed.
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4.3.2 Searching

Overview

Searching for contacts is done from the main window in the Search or Dial section. Typing in a relevant search term, i.e.
telephone number or name, will shortcut to any matching entries in the contacts tab.

The search will try and find a match in any of the devices on the PBX or within any of the directories that have been assigned to
your Phone Manager user account on the server.

To cancel a search click onto the X next to the Dial button and this will restore the contacts tab back to the default view.

@” Remember to cancel a search so that your entire contacts are visible on the contacts tab.
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4.4 Call History

Overview

The call history provides a list of all of your recent call activity. This includes internal calls, external inbound and outbound calls

and missed calls that were not answered. If the User has multiple devices (extensions/agents) associated with their profile then
the history will show calls for all these whilst the User was linked with them (In other words the call history represents the Phone
Manager user rather than the device on which the call took place).

The history is refreshed after a call is cleared from the current extension phone.

£ The call history does not require Phone Manager to be running to save the call information - the server logs the
call history centrally.

£ You are only able to see the last 3 months of call history on the client.

For each call the history tab shows the following information:

e Name : This is either the name of the contact that has been matched to the call or if none is available then the outside
number.

e Time: The time of day that the call was made or received.

e Talk Time: The length of time that the call was connected.

e Ring Time: The length of time that the call was ringing.

e CLI: The caller id (Calling Party Number) or outside number. This is only populated for external calls.

e DID: The direct number dialed by the inbound caller. This is only populated for inbound external calls.
e Hunt Group: The hunt group that the call came in on. This is only populated for inbound external calls.
e Account Code: This shows any account codes that were set against the call whilst in progress.

] As the main window is resized the number of columns shown will change as there is more space to display
these.

To the left hand side of each entry the icon shows what type of call this is.

' Outbound call

) Inbound call (This includes calls answered by voicemail and in the case of DEE calls answered by other devices
in the DEE group)

&) Inbound missed call

Next to each entry, on the right hand side, there are icons to dial the contact back and if the system has call recording
integration enabled and the User has playback rights, then they can listen to the associated call recording for the call.
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4.4.1 Call Recording

Overview

Phone Manager can integrate into a Call Recorder to provide direct access to playback the recordings for the User. Call recording can
also be paused/resumed to enable specific parts of a call to not be recorded, for example when credit card details are being provided.

@‘ Additional 3rd party licensing may be required to pause/resume call recordings.
Playback

Call recordings can be played back from the Call History tab within Phone Manager by clicking onto the icon next to the
specific call.

This provides a direct link to the playback page for this call. To access the recording the User must have a valid account on the
call recorder that grants them access to the call they are trying to listen to.

Pause / Resume
Call recordings can be manually paused and resumed by configuring a Toolbar button. This can be on the main window

integrated toolbar or on an external toolbar. When used on an external toolbar the button highlight in the bottom right hand
corner of the button will change color based on the current state of the call recording.

Button State

Pause / Resume Grey highlight shows there is no call currently being recorded.

Pause / Resume Yellow highlight shows the call is being recorded.

Pause / Resume Red highlight shows the call recording is paused.

Call Tagging
Call recordings often have several custom fields that can be populated and Phone Manager provides a way to do this from a

toolbar button or from a macro. They can be configured so that a specific tag field and value is used each time, or it can prompt
the user to enter a custom value each time.
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4.5 Presence Profiles

Presence Profiles provide mechanism for controlling many aspects of a user's extension. If enabled to use Presence Profiles,
each user is given a default set of profiles that they can add to, edit or delete as they require.

Profile information

Each profile has a name which will be visible to other users of Phone Manager when it is selected. The profile name can
then be supplemented with Additional Information that can be changed as required and will also be visible to other
users.

For example, the profile 'In a meeting' could be supplemented with 'until 4pm' to provide other users with more
information about status.

["El If the profile selected is configured to enable DND then the Additional Information will be added to the
DND status text on the telephone system.

Extension Control
Each Presence Profile can control the following aspects of the user's primary extension:

Do Not Disturb

UCD Hunt Group Status

e Forwarding

Dynamic Extension Express

When a profile is changed, any extension status changes are applied to the user's primary extension and any extension
they have Phone Manager connected to (apart from the DEE control which is only applied to the primary extension).

For more information on Presence Profiles, read the section on Editing Presence Profiles.

@“ Presence profiles can only control whether each of your devices is active or not (will ring or not).
Configuration for what order they ring in must be made on the phone system.

Using Presence Profiles
The currently in use profile is visible under the username at the top of the main Phone Manager window. To change the

profile in use, use the drop down menu to the right of the current profile and select the new profile to apply. The
currently selected profile will have a tick next to it.
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‘. Mitel Phone Manager

ROBERTO DESK 1

v Extension 14130
Do not disturb
In a meeting

In the office
Search or 0
On holiday

Qut of the office

“ontacts Working from home

[ 1]
Manage Profiles .-

Selecting 'Manage Profiles; is a shortcut to edit the Presence Profiles in Settings.

Configuration Warnings

In some scenarios a warning may appear to warn of a possible configuration issues.

(. Mitel Phone Manager

Frank Spencer
In the office ¥ I Hot Desk 1024 v @)

2

When the warning triangle appears it will be for one of the following scenarios:

Your device status does not match your current Presence Profile configuration

When this message displays, it means the status of the user's Primary Extension is not as configured on the currently
selected Presence Profile. This could be because a manual change has occurred on the extension such as it has
manually been placed in DND. To fix the configuration left-click on the warning triangle and accept the prompt that
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appears.
Your extension will not ring with the currently selected profile

When this message displays it means that the extension that Phone Manager is currently connected to is not configured
to ring in the currently selected Presence Profile. If the extension is required to ring then edit the current profile or select
another one where it is configured to ring.
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4.6 Chat

Overview

Chat is an instant messaging style feature that allows Phone Manager Users to exchange short messages with each other.
When a chat session is started a new conversation is created that groups the messages sent together. If a User is offline when
a chat message is sent they will be notified of new messages when they next come online.

Pay attention to the icon for a user you wish to commence a chat session with. The colors give you a hint as to the status of
their phone and the type of icon indicates whether the user is likely to see your chat message straight away or later on.

8 This hollow Green icon means the extension for this user is free but their Phone Manager software is not running so they
won't see your message until the next time they run Phone Manager.

‘ or * This solid Green icon means the extension for this user is free and their Phone Manager is running so they
should see your chat message straight away.

‘ or ® This solid Red icon means this user is busy on a call but they should see your chat message straight away.

To initiate a chat session right click on the user's icon and select chat from the menu. (This menu shows the options available
with the Phone Manager Team Leader license for a contact centre manager)

| @“ The maximum length per chat message is 2500 characters.
This is what your chat session would look like.

L. Chat I

Conversations Hi Frank, are you free later for a caich 10:24

up on this week's support tickets?
Frank

Sure. I'll be free from 14.00 if that's ok 10:24

OK - let’s use meeting room 1. 10:25
I'll send you an Qutlook invitation.

Message Notifications

When a new message is received then the icon on the start menu will turn orange.

3y

Clicking on the icon will display the new message. Messages you send are shown on the left and messages received
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are shown on the right. The time of the message is tagged to the right of the message.

Next to each conversation if there are new unread messages then the number of them will be shown against Users
conversation.

L. INSTANT MESSAGE

Conversations

Phil (1)
Mohammed
Zhao

Tomas (1)

Multiple Chat Sessions

Multiple chat sessions are grouped by the User who the message is sent to or received from. Each User has the list of
conversations shown on the left hand side and clicking on the name will change the right hand window to show the

history.
. Chat - OXx
Conversations Did you finish that report for me? 10:43
Paloma - _ -
Just finished it - T'll bring it over now. 10:43
Maurice
David

Hiding Chat Sessions

Chat sessions can be hidden to remove completed conversations from the Ul. To hide a session right click on the user
on the left hand navigation menu and select 'Hide Conversation'.
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4.7 Hot Keys

Overview

Hot Keys enable Users to set a combination of keystrokes to access commonly used features within Phone Manager. The
configuration of the hot keys is specific to each User. The following list of hot key actions are supported:

Action

Answer call
Clear call

Directory search

Do not disturb

Highlight and dial
Hold or retrieve
Launch call history
Launch dial pad
Mute

Redial

Restore Phone Manager
Volume up

Volume down

Configuration

Description

Answers the call currently ringing. If there are any calls in progress then this is ignored.
Clears the call that is connected to the extension.

Brings the main window to the front and sets the focus and cursor to the Search or Dial
field.

Toggles the DND state at the extension. If no message is pre configured then it will
prompt for the message to use.

Dials the number that is currently highlighted in other applications.

If a call is on hold then retrieves the call otherwise puts it on hold.

Brings the main window to the front and sets the call history tab in focus.
Shows the dial pad window.

Mutes the audio for the current call. If this is a softphone then both sides of the call are
muted otherwise only the audio from the Users extension is muted. See Softphone
Limitations.

Redials the last number using the Mitel feature (default code 380). Not supported on
softphone (use call history instead), see Softphone Limitations.

Brings the main window to the front.
Increases the volume level. See the VVolume Control section for details.

Decrease the volume level. See the Volume Controlsection for details.

To configure the hot keys:

N O O WODN -

. Open the Settings window.

. Select the Hot Keys tab.

. Double click on the hot key entry to configure.

. Each hot key needs to be enabled, check the Enabled option to do this.

. Select the Key to use for the hot key.

. Check the Alt, Ctrl, Shift and/or Win checkbox's that will be used in combination to the Key selected.
. Click on Apply to save the changes/

/v, Always configure the hotkeys to use at least 3 combinations, for example Alt + Ctrl + D. Using simpler
combinations may result in conflicts with other application that are running at the same time.
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4.8 Call Banner Profiles

Overview

Banner profiles control how the Phone Manager toaster popup is displayed when calls are received at the client. The
information that is displayed, the color and text of the title bar can be changed depending on a specific set of conditions being
met for the call.

For example, using a condition on the DID number, support line calls could be shown with a green banner whilst sales calls with
a blue banner.

Support line calls shown with a green banner. Sales line calls could be shown with a blue banner.
‘. THI5 IS THE SUPPORT LINE - X \, THIS IS THE SALES LIME - X
No caller ID 00:03 No caller ID 00:01
1021 1021
" Y ' N
O @ @ L ® @
Anmswer Divert 5Send to Answer Divert 5Send to
olCEmai DICEema

Several different profiles can be created and they can be given a priority so that if two banners have a similar condition then the
one with the highest priority will be used.

This feature can be used to identify VIP callers in order to improve customer service.

gf See the Call Banner Profile section on the Communication Service server for details on how to configure these.
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4.9 Integrated Toolbar

Overview

The integrated toolbar provides five buttons on the main window shown underneath the Search or Dial field. Each button can
be customized by the User to set the label shown and what action is performed when the button is clicked.

[rél This is only available when running with a Professional or higher license or when using the built in softphone.

Customizing Buttons
To edit the button:

1. Right click the button and select Edit.

2. Select the Action to perform from the Action drop down list. See the Button Actions section for details.
3. Enter the name that will be shown on the button in the Name field.

4. Configure any Parameters if required by the Action selected.
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5 Professional Features

The following section covers the features that are available in the Professional licensed version of Phone Manager.

ACD Agent Ability for the User to control their ACD status.

Control

Integrated This provides 5 buttons that can be customized on the main window.

Toolbar

Toolbars This give access to the full toolbars.

Application Integration into 3rd party application using AP| Access, Macros, TAPI, Command
Support Line or Application Support Plugins.
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5.1 Application Support

Phone Manager can integrate into 3rd party applications in several ways depending on the requirements and features that are
supported by the application. This can be as simple as Highlight & Dial or more complex full call control and events using API
Access or Macro design.

The following is the list of integration options available.

Method Description

Directories Contact directory imports, to display information about the caller on the toaster.

Highlight & Dial Dialing from other applications by selecting the number and then activating the dial by
using Hot Keys or double clicking on the highlight and dial icon.

Command Line Command line arguments can be passed to the client executable to perform actions.

Macros VBScript macros that can be activated on call events or manually by the User.

TAPI 1st Party TAPI driver for integration into 3rd party applications.

Application Plugins provide specific integration to a range of well known CRM style applications.

Support Plugins

["El If the application or version is not currently supported then complete the integration request process and we can
investigate the possibility of supporting this application.
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5.1.1 API Access

Overview

The client provides APl components that can be used to embed some of the functionality of the Phone Manager client into a
3rd party application. Unlike the other Application Support options the client does not have to be running to do this.

All of the call controls events and methods are available, so applications can react to call ringing events and receive the call
details and then perform their own handling of what to do next, i.e. screen popping, dialing out etc.

& This does require development work to be performed by the application vendor or administrator.

= When using the API the Phone Manager client can be running at the same time and this will only consume a
single license as long as the Phone Manager client and the application are running in the same user session.

" See the Phone Manager API reference for more information.
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5.1.2 Macros

Overview

Phone Manager Professional license supports a scripting interface to allow VBScript macros to be developed. They can then be
configured to trigger on a manual User action, i.e. a toolbar button action, or automatically on pre-defined call events. The
scripting interface provides access to the call information that can be used within the script and extra methods to control the
extension and other features, i.e. call recording.

For example this VBScript example will display a message box when an incoming call is received and display the caller id:

MsgBox "Call from " & PhoneControl.CLI

& See the Phone Manager Macro API reference for more information.

Configuration

The macro design and configuration is available for Users who have the Allow macro editing option enabled on their Client
Profile on the server. Without this option Users can only change the Enable event-driven macros option. This controls if the
macros that have been assigned to the User will be triggered on the associated call events.

When creating new macros they are first designed and tested from within this section. When this is complete they can be
published and this makes them available on the server. Once published they can then be assigned to the relevant Users. A
copy is made of the local version of the macro and this then cannot be edited. Any updates would need to be made on the
original local version and then re published. Users would then need to be reassigned to this new published version. This
provides a level of security to prevent macros being deployed without permission.

The list of macros shown in the Macro Configuration section only shows the local macros not published to the server for this
User. To see the list of published macros see the Macros section on the server user interface.

To create or edit a new macro:

. Click on the New or Edit button.
. Enter a Name that will be used on the server to identify this macro.
. Enter a Description that can be used to detail what this macro is for.
. Select the call event to automatically trigger the macro.
o Direction: inbound, outbound or both.

A WODN =

o State: call ringing, call answered, call cleared, call cleared only when answered or user controlled (i.e. via a
toolbar button).

o Type: external, internal or both.

5. Enter the macro text in the VB Script section.

6. Use the Test button to validate the syntax. If there are any errors then a message box will be displayed indicating the
error.

7. Click on Save to save this macro.
To publish a macro:

Select the macro from the list of macros available.

Click on Publish.

Enter a new name for the macro, it is recommend to include a version or revision number.
Click Ok

From the server user interface, assign this to the relevant Users.

a s~ D~

To delete a published macro:

1. From the server open the Site -> Features -> Phone Manager -> Macros section
2. Select the macro and click on Delete.
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5.1.3 Application Support Plugins

Overview

Phone Manager Professional License contains plugins available that are able to directly integrate with a range of well known
CRM and PIM applications. The plugins generally provide deeper, more seamless integration than other methods as they
leverage the APIs of the specific application.

Features

There are 4 features that the plugins can provide. Depending on the application that is being integrated with, only some
features may be available with varying levels of support and there may need to be integration work performed by the
application vendor or administrator of the system. See the application integration document for the specific plugin for
details.

o Dial out directly from the application: For example having a dial button next to a telephone number field.
e Screen popping: Searching the application for contacts that have matching caller ids and displaying the record.
e Call history: Creating a call history phone call activity in the application with the call details.

e Calendar and DND synchronization: Controlling the DND state of the extension based upon calendar entries
in the application.

Configuration

To configure a plugin for one of the application support features:

1. From the Application Support Configuration section.

2. Click on the New button.

3. From the list of Applications select the application to integrate with.
4

. This will then change configuration on the right hand side to show the specific configuration required for this
plugin. See the relevant integration document for details.

5. Select the Feature to enable either:
o Screen pop
o Call history
o Calendar / DND sync

6. Multiple features can be enabled for each plugin by repeating the process from step 1.
7. Select the event trigger that will cause the feature to be acted on (this is not applicable to Calendar / DND sync).
o Direction: inbound, outbound or both.

o State: call ringing, call answered, call cleared, call cleared only when answered or user controlled (i.e.
via a toolbar button).

o Type: external, internal or both.
8. Click on Save.
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5.1.4 TAPI

Overview

The TAPI Service Provider (TSP) provides a 1st Party TAPI support for client applications, 3rd Party TAPI is not supported.
Multi user environments such as Terminal Service, Remote Desktop or Citrix configurations are not supported in this release.

The TSP service supports the TAPI v2 and TAPI v3 standards.

The TSP only supports call control over the first call at a single device and limited events (new & end) for additional calls will be
provided to the client application.

The TSP cannot be tested against every application that “supports” TAPI due to the different ways that it can be implemented.
Additionally the features available within the client application are dependent on what the 3rd party application has
implemented. The TSP will not necessarily work with every application that has implemented TAPI and would need to be
verified to ensure proper integration.

The TSP supports the following basic telephony functions as defined by Microsoft.

http://msdn.microsoft.com/en-us/library/windows/desktop/ms725522%28v=vs.85%29.aspx#tspi.call_states_and_events_qref
Configuration

When Phone Manager is installed to use the TAPI feature it needs to be configured in Windows. To do this follow this
procedure:

1. From Windows open the "Phone and Modem" control panel form.

L Phone and Modem

Digling Fules | Modems | Advanced

fﬁ* The following telephany providers are installed on this computer:

Providers:

TAP| Kemel-Mode Service Provider
Tapito UCA Service Provider
Unimodem 5 Service Provider

'EE' Remove Configure. ..

0K Cancel Apply

2. Select the Advanced tab and click on the Add button.
3. From the list of providers, select the "Phone Manager TAPI Service Provider" option and click Add.
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(e ) Add Provider

Select the provider you wish to install from the list below, and click Add.

Telephory providers:

Microsoft Windows Remote Service Provider

Phone Manager TAP| Service Provider

o

I I
4. Click Close. The TAPI driver is now ready to use.
5. To test the TAPI driver using Windows Phone Dialer, select Start -> Run -> dialer
6. Select Tools -> Connect Using, select the "Phone Manager TAPI Line" and click Ok.

& Phone Dialer = =
File Edit Teools Help

Mumber to dial: Speed dial

Connect Using ?

Line:
1 iPhone Manager TAF] Line P oW Line Properties...
GHI Address:
4 Address 0 W
F'?S | Use Phone Dialerto handle voice call requests from other programs

Corc

7. With Phone Manager running make a call from Phone Dialer.
8. If this is successful then the TAPI driver is functioning correctly.
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5.1.5 Command Line

Overview

The client can be run via the command line to override the local configuration options on start up and to perform basic call control
actions whilst the client is running.

For example PhoneManager.Client.exe MC: 8889274671, will cause the number 8889274671 to dialed.
Start up Options

If no client is running then the following arguments can be used to override the local configuration of the client when it starts up.
For example to use a different extension number or a different user account.

To override the location: /Override:"true" /Location:"Office"

To override the extension: /Override:"true" /extension:"1001"

To override the server & user

details:

Running Options

/Override:"true" /Host:"appserver" /Username:"domain\user"
/Password:"mypassword"
/Override:"true" /Host:"appserver" /Username:"user1" /Password:"mypassword"

If the client is running then the following arguments can be used to perform basic call control actions.

Call & extension Control Arguments

MC:number:{accountcode}

ANS

cC

HC

RC
AC:accountcode

MD:"{text}"

DND:"{messagetext}"

TOGGLEDND

LN:agentld:{huntgroup}

LF:agentld:{huntgroup}

VD

W

Fl:destination
FB:destination
FN
FNA:destination

Makes a call to the given number, if an accountcode is provided then this used whet
making the call.

Answers a ringing call at the extension.

Clears the current active call at the extension.

Hold the current active call at the extension.

Retrieve the held call at the extension.

Set the accountcode against the current active call at the extension.

Changes the top line display of the screen on the keyset to the text value, up to 16
characters. This requires an external trunk call to be in progress.

Sets DND on the extension using the given messagetext, if no messagetext is speci
then the extension is removed from DND.

Toggle DND at the extension, so if it is enabled then removes it and sets it if not enc
Logs the ACD agentid into the given huntgroup. If no huntgroup is provided then all
groups.

Logs the ACD agentid out of the given huntgroup. If no huntgroup is provided then a
hunt groups.

Decreases the volume at the extension. See Volume Control section for details.
Increase volume at the extension. See Volume Control section for details.

Sets an immediate forward to the destination.

Sets an forward on busy to the destination.

Removes any forwarding.

Sets a forward no answer to the destination.
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FAB:destination Sets a forward no answer busy to the destination.

TC:destination Performs a direct transfer to the destination

Call Recording Integration Arguments (require call recording integration to be enabled)

TAG:field:text Tags the call recording tag field with the text provided, overwriting any existing
information in this tag field.

TAGAPPEND:field:text Tags the call recording tag field with the text provided, appending this to any existing
information in this field.

PR Pauses the recording of the current active call at the extension.

RR Resumes the recording of the current active call at the extension.
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5.2 Toolbars

Overview

Toolbars allow the application to be configured so that commonly performed actions can be performed at the touch of a button.
Specific functions can be programmed under a button such as answering a call, tagging a call recording, or a macro can be
executed for more advanced tasks. Toolbars are configured on the server and assigned to specified Users.

When a toolbar is assigned they become available to the User to open in the Toolbars menu on the main window. (Phone
Manager needs to be restarted to "read in" any new toolbar rights)

\.. Mitel Phone Manager

Elina Marie (Office)

Q o @ T & =2 2
Support Toolbar

Search or Dial p_m
Sales Team

s | e | vmdor

Contacts Call history

Favourites .

Multiple toolbars can be created with varying amounts of buttons that can have custom labels and be colors to highlight or
categorize specific types of buttons. To open a toolbar select the entry from the toolbar drop down.

\.. Sales Team - 0O X

CO Party Mame Set DND

Screen Pop CRM

II
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5.2.1 Integrated Toolbar

Overview

The integrated toolbar provides five buttons on the main window shown underneath the Search or Dial field. Each button can
be customized by the User to set the label shown and what action is performed when the button is clicked.

[rél This is only available when running with a Professional or higher license or when using the built in softphone.

Customizing Buttons
To edit the button:

1. Right click the button and select Edit.

2. Select the Action to perform from the Action drop down list. See the Button Actions section for details.
3. Enter the name that will be shown on the button in the Name field.

4. Configure any Parameters if required by the Action selected.
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5.2.2 Button Actions

Overview

The buttons that can be used on a toolbar have different actions that can be performed when they are clicked. Depending on
the action then additional parameters may need to be configured, or in some cases if they are not provided then the User will

be prompted for these when they click the button.

Action Parameters

ACD end wrap None

ACD status Optional: Huntgroup
Answer call None

Change caller ID Optional: Number
Clear call None

Dial digits Optional: Digits

Do not disturb (DND) Optional: Number

Optional: Text

Enable event driven macros  None

Feature code Optional: Code
Optional: Parameter

Headset mode None
Hold call None
Make call Optional: Number

Pause / resume call recording None

Description
End the wrap state for this agent and place into the free state.

Logs the agent in to specified ACD Huntgroup. If not specified
then logs into all ACD groups.

If already logged in, then toggles the state and logs the Agent
ID out of the specified Huntgroup, if not specified then logs
out of all groups.

Answers a ringing call at the extension.

This changes the outgoing Caller ID (CLI) (or CPN in
telephone system database programming) that is presented
when outside calls are made from this extension. The feature
needs to be enabled on the PBX and the number presented
needs to be allowed by the network trunk line provider.

Clears (or hangs up) the call that is connected to the
extension.

Sends the specified Digits to the extension. If not specified
then prompts the User for the digits.

If the extension is already in the DND state then DND is
switched off. If not in DND then the extension is placed into
DND using the message Number and the message Text if
specified. If not specified then the User is prompted to enter
text associated with the message.

Enables or disables event driven macros.

This represents any feature code that is available on the
MiVoice Office 250 PBX. The list of feature codes available is
downloaded automatically from the MiVoice Office 250 PBX
along with the description.

This will set the feature Code specified or prompt the User to
enter the feature code number. Some feature codes can
accept additional Parameters and this can be configured but
the User cannot enter additional parameters if not specified.

Enables or disables headset mode on the extension.
Holds the call that is currently connected to the extension.

Makes a call from the extension to the Number. If the Number
is not specified then the User is prompted to enter a number.

This pauses or resumes the call recording for the active call
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Play prompt

Record current call

Redial

Retrieve call

Run executable

Run macro
Screen-pop application
Send to voice mail

Set account code

Set account code on monitor

Tag call

Tag recording

Transfer call

Volume down

Volume up

Optional: CRA

Optional: Mailbox

None
None

Required: Path
Optional: Arguments

Required: MacrolD
Required: App/D
None

Optional: Code

Optional: Code

Optional: Text

Required: Field

Optional: Tag

Optional: Destination

None

None

on the extension. (Requires call recording integration to be
enabled).

If the PBX has an IVR system connected then this will
conference in the /VR device number configured into the
current call.

This initiates a Record-A-Call for this call and stores the
recording in the MiVoice Office 250 VoiceMailbox provided. If
no Mailbox is provided then the User is prompted to enter a
valid mailbox number.

Performs a redial at the extension using the PBX redial
feature code.

Retrieves a held call at the extension.

This enables any application installed on the PC to be run.
The Path needs to be set to the full path and file name of the
file to run and if there are any Arguments to pass then this
can be configured.

Runs the published macro with the MacrolD.
Runs the application support screen pop for the given AppID.
Sends the call ringing at the extension directly to voicemail.

Sets an account Code against the current call at the
extension. If not specified then the User is prompted to enter
a code.

When a supervisor is silent monitoring a call this will set an
account Code against the call being monitored. If
not specified then the User is prompted to enter a code.

Changes the top line display of the screen on a MiNet
extension to the Text value, up to 16 characters. The text
entered will then follow the call when transferred.

Tags the call recording tag Field with the Tag provided,
overwriting any existing information in this tag field. (Requires
call recording integration to be enabled).

Performs a direct (blind) transfer to the Destination. If the
Destination is not provided then the User is prompted to enter
a destination.

Decreases the volume at the extension. See VVolume
Control section for details.

Increases the volume at the extension. See VVolume
Control section for details.
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5.3 Campaign Manager

Overview

Phone Manager is the main user interface (Ul) for users making outbound calls from Campaign Manager. Phone Manager
provides a dedicated Campaign Manager form that provides all functions and information necessary.

/&, The user must be configured with a Professional or Team Leader license to use this feature.

To access the form click on the icon shown on the main Phone Manager window toolbar.

frEl If this is not displayed then check that the user has the Campaign Manager client profile option enabled on their
account.

When making outbound calls there is often a need to interact with a third party piece of software. This may be because there is
additional information that the user needs to see when on the call or because the user needs to update data or a process
outside Campaign Manager.

To cater for these different requirements, Phone Manager can display the Campaign Manager form in one of three views:

1. Minimized view: Used when screen popping / using third party applications. The Campaign Manager Ul becomes more
of a toolbar leaving space on the screen for other applications. When using this mode the normal Phone Manager
plugins/macros can be used to screen pop third party applications.

2. Contact details view: Used when no third party applications are required. The Campaign Manager Ul takes up the
whole screen and provides the user with easy access to all the features of the form.

3. Embedded webpage view: Used when the third party application’s interface is a web page. The Campaign Manager
has an embedded browser that will load the web interface.

<" The embedded webpage uses a Chrome browser engine. ere are problems with rendering on screen
1 Th bedded web Ch b If th bl th rend
popping then the minimized view can always be used alongside a full browser window.

End User Features

The Campaign Manager form within Phone Manager is split into four main sections. Depending on the view chosen the
sections will appear differently to the end user.

User Productivity

The user productivity section displays to the user their daily productivity on the system. The statistics displayed outline
the number of calls they have made and how successful they have been at getting through to the right person and then
converting the lead into a sale.

The statistics shown are for all campaigns the user has been working on that day. The statistics will update once the
call has finished wrap up.

2] Depending on how busy the database is there may be a delay in the statistics updating on the users
screen.

Contact Details

The contact details page gives the user as much information as possible about the person they are calling.

At the top of the section it displays the contact’'s name and the result of the last call that was made to them. The
contact’s details are then presented in three ways:

e Imported Fields, fields 1 to 10 from the imported data are shown to the user here. If there is key information
about the contact that the user needs to know they can read it from this section as the call is in progress.
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e Call history, a complete history of all calls to the contact are listed here. This gives the user an idea of how often
the contact has been called and allows them to have knowledge about previous calls if the contact mentions it.

e Notes, the notes section provides an optional way of adding information to a contact record during a call. The
information will then be available to anyone calling that contact record in the future.

For more information on the Phone Manager Ul in relation to the dialing process please reference the Campaign
Manager help.
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6 Team Leader Features

The following section covers the features that are available in the Team Leader licensed version of Phone Manager.

Alarm Notifications
Hunt Group Status
User Control

Silent Monitoring

Voicemail Messages

Global Directory
Management

Provides notifications to the User when any alarms are triggered on the system.
Provides visibility of the status of a hunt group icon.
Ability to set the status of other devices, including ACD, DND and Forward state.

Lets the Users control silent monitoring of Users. This requires specific programming
on the PBX.

Enable the User to see the number of Voicemail messages for a device.

Enable the User to add/edit items in a global directory.
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6.1 Alarm Notifications

Overview

Alarms generated on the PBX can be sent to Team Leader clients to notify them that they have occurred. Specified alarms that
will be sent to the Team Leader Users is configured in the Alarms section on the server.

When an alarm is raised the client will display an alert window and the User can dismiss the alarm. The User may also be able
to clear the alarm from the PBX if the extension they are associated with is programmed as an Administrator.

As an alternative to a pop up alarm form, the system can also send alarms by email.

. MINOR SYSTEM ALARM

-07:709- 12:18 17-06 AD011 ALARM Emergency Call Made
By "1803" - JUAN

Clear Dismiss
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6.2 Hunt Group Status

Overview

Team leader license Users can be provided with information about hunt groups. This gives the User details on the number of
calls queuing and ringing at any hunt groups that they have in their contact list.
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6.3 User Control

Overview

Team leader provides the User with the ability to control another Users extension and can perform silent monitor actions
(requires MiVoice Office 250 programming to enable silent monitor permissions for the extension associated with the Phone
Manager session). The control actions that are available are:

e DND control
o Enabling and disabling DND
e ACD control
o Logging agents out of ACD hunt groups
o Logging agents into ACD hunt groups
e Forward state control
o Setting forwarding
o Removing forwarding
e Silent monitor (this is dependent on the PBX programming)
o Start a silent monitor
o Start a continuous silent monitor

To control another extension, from the Contacts window right click onto the device and this will display a menu where the action
can be selected. Depending on the type of device and its current state the list of available actions may change.
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7  Settings

Overview

The settings section on the client provides the User with the ability to be able to configure how the clients connects and
interacts with the system. This includes the following options.

Connection

User Preferences

Presence Profiles

Softphone

Hot Keys
Macros

Application Support
Plugins

Diagnostics

Configuration and connection settings for how the client will connect to the
server from both local and remote locations and how their extension number is
assigned.

Configuration options for a user's personal settings.

Add/Edit/Remove Presence Profiles. Note: only visible if a user has been
configured to use Presence Profiles on the server.

Options to configure the audio sources, codecs and quality of speech when
Phone Manager is running in softphone mode.

The hot key configuration and assignment.
Enabling event-driven macros and access the macro designer.

Configuration of the plugins for CRM integration.

Options for enabling diagnostics and troubleshooting.
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7.1 Connection

Overview

The connection settings enables the User to configure how the client will connect back to the server. The options shown here
will have been pre configured during the installation process, see the Configuration section for more details, when the client
was first installed and connected.

General

The general section configures how this computer will be used and the default options to connect.

If the PC that the client is installed on remains in the same physical location and uses the same connection details all of
the time then check the Is the location of this PC static? option. This configures the client to always use the
connection settings from the Default Location.

If the PC does move, for example this is a laptop, then uncheck the Is the location of this PC static? option. This will
configure the client to always prompt for the location details to connect with each time that it starts. This is also an
appropriate setting for use with a Terminal Server (TS) or Citrix Server.
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7.1.1 Local Connection

Overview
The local connections settings configures how the client will connect when they use the local / office location to connect.
Server Connection

The Available hosts window shows a list of all the servers that the client has found by broadcasting on the local
network. If the server is not on the same local subnet as the client then it may not be displayed. Selecting an entry from
the Available hosts will populate the Host address entry or if the server is not shown then it can be entered manually.

The client will try and connect using the credentials of the User who is logged into the PC. If this is not correct then
check the Override login details and enter the Username and Password details to use.

& If overriding a Windows account then enter the Username in the format DOMAIN\User.

/v When using Windows authentication and not using Override login details if there is another connection
to the Communication Service server with alternate details then the connection may fail or connect with
an incorrect account. For example if the User has a mapped network drive connected using alternate
credentials then Windows will store these details in the "Windows Credential Manager". These stored
details will be used by Phone Manager to connect with. To prevent this from happening do not connect to
the same server as Phone Manager with alternative credentials.

Connections through web proxies are not supported and the Communication Service server should be
added to any relevant exclusion list. Failure to do so may result in clients not being able to connect.

Extension Details

The Extension details section controls what extension will be assigned to this client when it connects. There are 3
options available:

Always use the extension assigned to my user account

This will use the extension that has been configured against the User in the server. If this is selected but the User does
not have an extension assigned then they will be prompted when they connect. The extension will then be permanently
associated with the User. Any calls that are made on this extension even when the client is not running will be
associated with this User. This means that they will be shown in the call history when the User next opens the client.

Everyone who uses this computer shares the same extension number

This will force each User who runs the client on this PC to use the extension number configured in the Extension field.
The extension will only be temporarily assigned to the User while the client is connected. This means that any calls
made on this extension when the client is not open will not show up on the Users call history. Calls made on the
extension will be assigned to the User who's client is currently running.

This should be used when there are different Users using the same computer and extension at different times.
Everyone who uses this computer uses a different extension number (i.e. TS/Citrix/PBX hot desking)

This will prompt the User each time that the client starts for the extension number to use. The extension will only be
temporarily assigned to the User while the client is connected. This means that any calls made on this extension when
the client is not open will not show up on the Users call history.

This should be used when the client is installed in a multi user environment, for example Microsoft Terminal/Remote
Desktop Services, Citrix XenApp, VMWare Virtual Desktop Infrastructure (VDI) or when using Agent Hot Desking.
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7.1.2 Remote Connection

Overview

The remote connection settings configures how the client will connect when they use the remote location to connect. The same
options as the Local Connection are available except for the broadcast options.

This simply means that we are telling the software that the connection to the server is via a different network to the server
(usually the public internet if configured)
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7.2 User Preferences

Overview

The preferences section enables the options that are specific for the user to be configured. The following options are available.

Section Description

General Configures the user's language, notification and status change on computer lock settings.
Information = Configures the user's Hot Desk, Voicemail and Meet-Me Conference settings.

Numbers Configures the user's telephone numbers and view Active Directory and DEE imported

numbers.
Chat Configures the user's chat preferences.
Profile Configures the user's personal profile image.

Image
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7.2.1 General

Language: This controls what language Phone Manager will be configured with to enable multi-lingual support. When this is
changed all of the captions, prompts, tips and help will be displayed in the selected language.

Notifications: Phone Manager can automatically be activated when a call alerts the associated extension. This provides fast
access to the Contacts view to be able to see other user's status' and transfer calls. When the call is cleared, Phone Manager
will return to its original state.

Status on Lock: To help inform users when you are away from your desk, this feature can be used to automatically set a
status when your computer is locked. When unlocked, Phone Manager will return to its original state.

This feature works in 2 modes:
e Presence Profiles Enabled -> If you are using Presence Profiles, Status on Lock will apply the selected Profile when the
computer is locked.

e Presence Profiles Disabled -> If not using Presence Profiles, Status on Lock will apply the selected DND State when the
computer is locked.
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7.2.2 Information

Overview

The Information section allows configuration of MiVoice Office related user settings.
Configuration

Hot Desk

If the associated extension is a MiVoice Office 250 Hot Desk device then Phone Manager will provide login/logout
features. As part of these features, Phone Manager can save a user's Hot Desk passcode and can automatically log out
the Hot Desk device when it is shutting down.

Logout Hot Desk on Shutdown: When this is checked and the user closes Phone Manager then their hot desk
extension will also be logged out.

Save Hot Desk passcode: Tells Phone Manager whether to automatically enter the Hot Desk passcode when logging
in. If not selected the user will be prompted for the passcode each time.

Hot Desk Passcode: This is the users hot desking passcode for their hot desk profile. Leave blank is the there is no
passcode set.

£ Phone Manager must have a connection to MCS in order to log the hot desk out on shutdown. If the
application is shutdown when not connected it won't log the user's Hot Desk device out.

Voicemail

Phone Manager can automate some of the process of accessing a voicemail box:

Mailbox number: This is the user's mailbox on the telephone system. This will default to the user's Primary Extension.
Configuring this will ensure Phone Manager dials into the correct mailbox even when not connected as a Primary
Device.

Prompt for mailbox passcode: When this option is enabled, Phone Manager will prompt for a passcode when
retrieving messages and will automatically pass it to the voicemail. If disabled, you must enter the passcode manually
on the telephone or using the Phone Manager dial pad.

Save mailbox passcode: If Prompt for mailbox passcode is enabled, Phone Manager can also save the passcode for
the Mailbox number so that it only needs to be entered the first time.

Mailbox passcode: This is the user's mailbox passcode. This is used to automatically access their voicemail mailbox
when retrieving messages.

Meet-Me Conference

This configuration is used when creating Meet-Me conference appointments using the Phone Manager Add-in for
Microsoft Outlook.

Meet-Me Access Code: This is the user's Meet-Me conference access code. This is used to populate the meeting
invitations with the correct information.
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7.2.3 Numbers

Outside Numbers

User configurable numbers that are visible to other users of Phone Manager. Users can configure as many numbers as
they require, each entry can be given a description to describe the number, e.g. Home or Mobile.

When numbers are configured other users will see this number in the list of available numbers when they dial them from
the Phone Manager contacts window. Any Active Directory or Dynamic Extension Express numbers will also be visible
to other users so there is no need to duplicate them here.

Active Directory

This section of the numbers page contains Home, Mobile and Work numbers that have been imported from Active
Directory. These numbers are read-only.

Dynamic Extension Express

If the user's primary device is a DEE device then this section will show all of the user's external numbers that have been
imported from their DEE configuration. These numbers are read-only.
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7.2.4 Chat

Overview

The User Preference Chat section enable the users chat preferences to be configured.

Configuration

Enable chat notification: This enables the audible notifications to be played when a new chat message is received.
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7.2.5 Profile Image

Each user can set a profile image that will be visible to all other Phone Manager users. Pressing the '"Add/Replace' button will
launch a file browser to select a photo image to use.

To remove a Profile Image, press the 'Remove’ button.

Remember to save changes by pressing 'Apply' when closing the Settings form. At this point the image chosen will be saved on
the server and made visible to other users.
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7.3 Presence Profiles

Presence Profiles provide mechanism for controlling many aspects of a user's extension. If enabled to use Presence Profiles,
each user is given a default set of profiles that they can add to, edit or delete as they require.

Profile information

Each profile has a name which will be visible to other users of Phone Manager when it is selected. The profile name can
then be supplemented with Additional Information that can be changed as required and will also be visible to other
users.

For example, the profile 'In a meeting' could be supplemented with 'until 4pm' to provide other users with more
information about status.

["El If the profile selected is configured to enable DND then the Additional Information will be added to the
DND status text on the telephone system.

Extension Control

Each Presence Profile can control the following aspects of the user's primary extension:

Do Not Disturb

UCD Hunt Group Status

e Forwarding

Dynamic Extension Express

When a profile is changed, any extension status changes are applied to the user's primary extension and any extension
they have Phone Manager connected to (apart from the DEE control which is only applied to the primary extension).

For more information on Presence Profiles, read the section on Editing Presence Profiles.

@“ Presence profiles can only control whether each of your devices is active or not (will ring or not).
Configuration for what order they ring in must be made on the phone system.

Using Presence Profiles
The currently in use profile is visible under the username at the top of the main Phone Manager window. To change the

profile in use, use the drop down menu to the right of the current profile and select the new profile to apply. The
currently selected profile will have a tick next to it.
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‘. Mitel Phone Manager

ROBERTO DESK 1

v Extension 14130
Do not disturb
In a meeting

In the office
Search or 0
On holiday

Qut of the office

“ontacts Working from home

[ 1]
Manage Profiles .-

Selecting 'Manage Profiles; is a shortcut to edit the Presence Profiles in Settings.

Configuration Warnings

In some scenarios a warning may appear to warn of a possible configuration issues.

(. Mitel Phone Manager

Frank Spencer
In the office ¥ I Hot Desk 1024 v @)

2

When the warning triangle appears it will be for one of the following scenarios:
Your device status does not match your current Presence Profile configuration

When this message displays, it means the status of the user's Primary Extension is not as configured on the currently
selected Presence Profile. This could be because a manual change has occurred on the extension such as it has
manually been placed in DND. To fix the configuration left-click on the warning triangle and accept the prompt that
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appears.
Your extension will not ring with the currently selected profile

When this message displays it means that the extension that Phone Manager is currently connected to is not configured
to ring in the currently selected Presence Profile. If the extension is required to ring then edit the current profile or select
another one where it is configured to ring.
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7.3.1 Editing Presence Profiles

Default Profiles

When first using Presence Profiles a default set of profiles will be visible:

In the office Default profile, enables all of a user's DEE destinations, no DND,
no Forwarding, Group Calls (UCD) enabled

Do Not Disturb All DEE destinations enabled, DND set to on, prompt on
selection. No Forwarding, Group Calls (UCD) disabled

Out of the office External DEE destinations enabled only, no DND, no
Forwarding, Group Calls (UCD) disabled

In a meeting Only Voicemail DEE destination enabled, DND on, no
Forwarding, Group Calls (UCD) disabled

Working from home Only Voicemail DEE destination enabled, DND off, Forward
Immediate with prompt for the destination, Group Calls (UCD)
disabled

On holiday Only Voicemail DEE destination enabled, DND on, no

Forwarding, Group Calls (UCD) disabled

Adding/Editing Profiles

Each profile can be edited as required or new profiles can be added if needed. The following section outlines each area
of a Presence Profile:

Description: The description of the profile. This will be used to choose the profile when applying it and will also be
visible to all other users to define your status.

Additional Information: Supplementary information to the description, this can be permanently set here or edited on
the main Phone Manager screen after the profile has been selected.

Prompt on selection: If required, Phone Manager can be configured to prompt for the Additional Information each time
the profile is selected.

Send calls to: Outlines where inbound calls should be sent to. There are three options to choose from:

My ring group When selected, each of the DEE destinations that have been
configured on the telephone system will be shown. Destinations
can be configured to ring or not by checking and unchecking the
relevant boxes. Note: If 'My ring group' has been selected, at
least one destination must be set to ring.

Voicemail Applies a forward all calls to Voicemail

Other Allows the user to configure where their calls should be
forwarded to. If required the destination for the Forward can be
prompted for when the profile is selected.

] If the profile selected is configured to enable DND then the Additional Information will be added to the
DND status text on the telephone system.
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Do not disturb: Enables or disables DND. A specific DND message can be selected or Phone Manager can be
configured to prompt for the DND message at runtime. Any Additional Information will be used as the DND Text
property when setting the DND status on the telephone system.

Group Calls: Controls the UCD hunt group remove/replace feature. When enabled, the primary extension will receive
calls from any UCD hunt groups it is a member of.

Chat Notification: Controls whether the chat notification audible alert gets played or not.

Deleting Profiles

Presence Profiles can be deleted as required, however the currently selected profile cannot be deleted so that there will
always be one profile remaining.
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7.4 Softphone

Overview

The softphone settings enable the User to configure how the built in softphone operates and integrates with Phone Manager.
Phone Manager's softphone requires a CAT F SIP extension license on the MiVoice Office 250 PBX

Before using the softphone please read and understand the issues raised in the E911 Warning, Emergency Calls and Security section
and the limitations of using a softphone in the Softphone Limitations section.

The softphone has the following configuration sections.

General Configuration of general settings.

Audio Enables the audio sources for the speakers and microphone that are to be used by the
softphone.

Codecs Enables the audio codecs that will be available to the softphone.

Quality Configures options relating to voice quality and echo cancellation.

NAT and Firewalls Configures firewall and NAT configuration options when connecting remotely.

Keep-Alives Configures the keep alive settings for re-registering the softphone to prevent timeouts.

The Softphone support within Phone Manager requires some configuration to be performed within the PBX. The sections below outline
the changes that are required for the SIP Extension's Phone Group and Call Configuration.

SIP Phone Group
Authentication

When using a SIP Softphone it is critical that authentication is used to help prevent unauthorized access to the PBX. To
configure authentication a username and password need to be set on the PBX for the relevant extension and on device
configuration of the Communication Service.

To configure the authentication on the PBX follow Mitel's recommendations by enabling In-bound Authentication and setting a
complex username and password combination on the associated Sip Phone Group for the extension.

‘# =IP Peers “ Mame Walue
_EH SIP Phone Graups % Enable In-bound &uthentication Yes
_mg--uucju-:nfiguratinn %In-hnund Authentication Usernarme 1371
In-bound Authentication Passwaord HERRAEH

- Authentication

o7 MWW

?Out-baund sernarme
Out-bound Password
xDD not use Out-bound Usernarme in REGISTER Mo

i baen WAT Settings
. [@-#3 Registrations
- az Phones

This same username and password combination would then need to be set on the device configuration on the Communication
Service for this extension.

m
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Device type 5IP Extension
Device Number 1871

Description 1871

Hot desk device ]

Authorisation name 1871

o

Authorisation password | essssssss

Disable |

o e L A

LA

"

Maximum calls

The softphone supports up to 4 concurrent calls, for example two calls on hold, one connected with an announced transfer. The
number of maximum calls needs to be configured to 4 within the Mitel Database Programming as the default value for this is 1.
This can be set in the SIP Phone Groups section for the extension as shown.

=4 Paona [#] Fully Jualitied Domain MNarme
EI Configuration |E':3” Configuration IEIZ 1

Authertication & Carnp-Ons Allowed Yes
o MW = Operating State In-Service
= MAT Settings m Paximurm Murmber of Calls 4

3 Registrations = 8 Call Failure Threshald ]
‘o Phones & Static Binding Mo
[+ POO0Y & Use Peer Address In Frarm Header Mo

Camp-ons

The PBX can only support up to 4 concurrent SIP calls at the Softphone, so it is recommended to set Camp-Ons Allowed to
No. This can be set in the SIP Phone Groups section for the extension as shown.

|_:_|¥ SIP Peers * Mame Walue
E'EH g I:;DD;: Groups Authentication

B 57 MW

ol T o fiquration n-n .

F'h kil Ez-= AT Settings

[ anes

P 22 Registrations

@. pannz

G4 P03 =2 IP Address 255,255,255,255

4 PO 3 Port Number 5060

ﬁ paqns @'Full}-’ Qualified Dormain Marme

& panng [ Call Confiquration @’ 10

@ Panng ‘& Carmp-Ons Allowed ENE v

o @E Danng =¥ (Ineratinn State Th-Servire
DTMF Payload
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The softphone requires that the DTMF payload is set to 101. This can be set in the SIP Phone Groups section.

Call Configuration

DTMF Support

The softphone only supports the RFC 2833 DTMF encoding and this needs to be configured within the MiVoice Office 250 DB
Programming IP Related Information --> Call Configurations section for the corresponding SIP Phone Groups as shown.

9% IP-Related Infarmation B8 2fverage In Tirme Frame Percentage Threshald 60
E'az Call Configurations E.ﬂwerage In Time Frame Tirmer 5

o 1 @ Minirmurn Playback Tirme 30
g 2 = T
QZ 3 (=¥ DTMF Encoding Setting RFC 2833 |
o ! e
02 3 mFax Control-Messages Redundancy Count 3
de ‘ BB Fax Page-Data Redundancy Count 0
H H Ml mim s

Speech Encoding

Phone Manager Desktop Softphone supports G.711 & G.729 speech encoding

Audio Frames/IP Packet

The audio frames per IP packet must be set to 2.

/v, Itis important to connect only one softphone to each extension number on the telephone systems. Registering
more that one SIP extension with the same credentials at the same time is not supported by the telephone
system and will cause problems.

If using the desktop and mobile versions of Phone Manager Softphone for a single user then ensure that each
application uses different extension numbers.
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7.4.1 E911 Warning, Emergency Calls and Security
WARNING

Do not dial emergency hot line numbers from the Phone Manager SoftPhone when remote from the MiVoice Office 250 PBX. In
the case of an emergency, dial the appropriate local emergency-service number directly, or use the nearest local public phone
to dial an emergency hot line or use your cell phone mobile.

The SoftPhone communicates through a central telephone system that routes all emergency calls directly to a number that is
local to the phone system. If the SoftPhone is not at the same address as the central system, then the emergency service
call will not be routed to the proper location.

Therefore, if the SoftPhone does not stay within the premises of the central system, you must configure the SoftPhone’s
programmable keys to dial the local police or fire departments directly, and you must clearly label the key icons. If the
SoftPhone is mobile, meaning it is used in multiple locations, you must know the direct emergency-contact numbers for each
location.

In the case of an emergency, you are responsible for determining the nature of the emergency and dialing the appropriate
emergency-service number directly. You must provide the emergency personnel your location and telephone number because
the emergency service may not receive accurate Caller ID (CLI) or Calling Party Number (CPN) identification information
automatically.

SECURITY

The implementation of SIP within the MiVoice Office 250 like many other systems is NOT based on a secure data connection
using TLS and certificates, and by definition is not secure.

With this in mind when using SIP outside of your firewall infrastructure, ensure that every care is taken that a level of security is
in place in line with your organization's internal security policy. This could involve (but may be not limited to) using NAT or
establishing a secure VPN connection between remote clients and the corporate LAN.

Should you be in any doubt please consult the relevant Mitel documentation on securing your MiVoice Office 250 installation for
SIP extension communications.
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7.4.2 General

Overview

The client has a built in SIP softphone but there may be situations when a third party SIP extension, for example Xlite, Bria etc.,
needs to be used and associated with Phone Manager. When Phone Manager connects it automatically knows that the
extension associated with the User is a SIP extension so will start the built in softphone and register the SIP device. Checking
the Third Party SIP Extension option will prevent this from happening when it runs.

Using a third party SIP extension instead of the built in softphone will significantly reduce the features that are
available since Phone Manager softphone uses the CTI connection to provide a more seamless experience for the User. See
the Softphone Limitations section for details.
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7.4.3 Audio

Overview

The softphone uses the microphone and speakers attached to the local computer to provide audio for the calls that are made.
When the softphone starts it will try and use the first microphone and speakers that it finds. To override this selection select the
Speaker and Microphone from the options available.

For both the speaker and microphone the volume levels can be adjusted and using the level indications you can see what
impact changing this will have. To test the speakers click on the Play button and a message will be played back through the
speaker selected. To test the microphone just speak into the microphone.

Headsets

When using Phone Manager in softphone mode a headset is required to relay audio between callers. Phone Manager
works with headsets that use the 3mm microphone/headphone jacks on a computer or can be used with a USB
headset. Phone Manager has been tested for compatibility with the following headsets:

Plantronics C310, CS60

Jabra GN9350e

Addasound Crystal 2822, 2821
Microsoft LifeChat LX-3000
Agent 500, W880

API support has been added for both Plantronics and Jabra headsets to allow users to answer/clear softphone calls
directly from the headset without having to touch the computer.
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7.4.4 Codecs

Overview
The softphone supports several different audio codecs that can be used depending on the quality of the audio required and the

amount of network bandwidth available. By default the softphone supports G.711 A-Law, G.711 Mu-Law and G729. The
softphone will negotiate with the PBX to determine the one to use based upon what is programmed on the PBX.
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7.4.5 Quality

Overview

The softphone can be configured with different audio quality settings depending on the environment that the softphone is
operating in. In most circumstances the settings should be left at the default.

Echo cancellation provides a way of automatically removing echo from the call, for example echo can occur when using a loud
speaker and the microphone may pick up the audio from the speaker. Removing the echo will also minimize the network
bandwidth used as the silence suppression will prevent the echo from traveling across the network. The Echo delay configures
the delay of the acoustic echo in milliseconds.

Auto gain control provides a way of balancing out the volume levels to provide an average level without excessive highs or
lows. The Max gain setting configures the maximum volume level permitted in decibels.

Noise reduction level configures the amount of noise reduction that is used. Background noise or random white noise can be
reduced using these options. The extent of reduction can be controlled from No Reduction, Low, Medium or High.

The softphone uses a dynamic jitter buffer to handle out of sequence and delayed voice packets to increase quality. This is
always on and cannot be disabled.
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7.4.6 NAT and Firewalls

Overview

Using a softphone remotely causes the voice traffic to have to flow through multiple switches, routers, firewalls etc. to reach its
destination. This can cause audio problems as the devices that handle the voice packets may use a process called NAT
traversal. NAT traversal is a standard technique for establishing and maintaining connections between remote devices on
different networks, i.e. the softphone and the PBX.

This is important because there is no single method for working with NAT that is successful in every scenario. There are
several different options that the softphone supports. Essentially each method is trying to establish which public IP address to
use as the destination for the voice packets.

Session Traversal Utilities for NAT (STUN) is a standardized set of methods, including a network protocol used in NAT
traversal for applications of real-time voice, video, messaging, and other interactive IP communications. STUN is an acronym
for Session Traversal Utilities for NAT, and is documented in RFC 5389.

Traversal Using Relays around NAT (TURN) is a protocol that allows for an element behind a Network address translator
(NAT) or firewall to receive incoming data over TCP or UDP connections. It is most useful for elements behind symmetric NATs
or firewalls that wish to be on the receiving end of a connection to a single peer. TURN does not allow for users to run servers
on well known ports if they are behind a NAT; it supports the connection of a user behind a NAT to only a single peer.

None where no NAT traversal method is used but this can only be used for connections where the server and client are on the
same local network.

Manual where the public IP address to use is manually configured.

Auto Detect where the softphone attempts to automatically determine the type of method to use but if this fails then will fall
back to the configured option.

& This is not just an issue with the built in softphone but any SIP extension.
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7.4.7 Keep-Alives

Overview

The softphone supports sending keep-alive requests back to the PBX. This prevents the network connection from being closed
by any firewalls/routers that may cause the softphone to lose communication when connecting via NAT.

There are three keep-alive options available that can be used depending on the network configuration.
Do not send keep alive messages: This disables any keep alive messages from being sent.
Re-register the softphone: This re-sends a SIP Register request to the PBX.

Send Options message: This sends a SIP Options request to the PBX.

When keep alive requests are being sent, the time interval can be set to determine how often they are sent out. The default is
every 300 seconds or 5 minutes.
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7.4.8 Softphone Limitations

Overview

The softphone does not have access to all of the same features as a Mitel MiNet device (or desk phone). The following
limitations apply to the all SIP devices on the MiVoice Office 250 PBX:

e Redial is not supported (feature code 380).

e Mute causes both parties audio to be muted out, unlike with a MiINET device where only the Mitel extension audio is
muted.

e Mitel Hot Desk
e Unable to transfer a connected call straight to a Voicemail box

In addition to this the following restrictions apply to using a third party SIP extension (i.e. not the in built softphone):

e Cannot make a call using Phone Manager, this means features like highlight and dial and TAPI will not work.
e Cannot place a call on hold or retrieve using Phone Manager.

e When making a call via the SIP extension the dial prefixes need to be set by the User, i.e. a user has to manually enter
the digits for an outside line.
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7.5 Hot Keys

Overview

Hot Keys enable Users to set a combination of keystrokes to access commonly used features within Phone Manager. The
configuration of the hot keys is specific to each User. The following list of hot key actions are supported:

Action

Answer call
Clear call

Directory search

Do not disturb

Highlight and dial
Hold or retrieve
Launch call history
Launch dial pad
Mute

Redial

Restore Phone Manager
Volume up

Volume down

Configuration

Description

Answers the call currently ringing. If there are any calls in progress then this is ignored.
Clears the call that is connected to the extension.

Brings the main window to the front and sets the focus and cursor to the Search or Dial
field.

Toggles the DND state at the extension. If no message is pre configured then it will
prompt for the message to use.

Dials the number that is currently highlighted in other applications.

If a call is on hold then retrieves the call otherwise puts it on hold.

Brings the main window to the front and sets the call history tab in focus.
Shows the dial pad window.

Mutes the audio for the current call. If this is a softphone then both sides of the call are
muted otherwise only the audio from the Users extension is muted. See Softphone
Limitations.

Redials the last number using the Mitel feature (default code 380). Not supported on
softphone (use call history instead), see Softphone Limitations.

Brings the main window to the front.
Increases the volume level. See the VVolume Control section for details.

Decrease the volume level. See the Volume Controlsection for details.

To configure the hot keys:

N O O WODN -

. Open the Settings window.

. Select the Hot Keys tab.

. Double click on the hot key entry to configure.

. Each hot key needs to be enabled, check the Enabled option to do this.

. Select the Key to use for the hot key.

. Check the Alt, Ctrl, Shift and/or Win checkbox's that will be used in combination to the Key selected.
. Click on Apply to save the changes/

/v, Always configure the hotkeys to use at least 3 combinations, for example Alt + Ctrl + D. Using simpler
combinations may result in conflicts with other application that are running at the same time.
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7.6 Macros

Overview

Phone Manager Professional license supports a scripting interface to allow VBScript macros to be developed. They can then be
configured to trigger on a manual User action, i.e. a toolbar button action, or automatically on pre-defined call events. The
scripting interface provides access to the call information that can be used within the script and extra methods to control the
extension and other features, i.e. call recording.

For example this VBScript example will display a message box when an incoming call is received and display the caller id:

MsgBox "Call from " & PhoneControl.CLI

& See the Phone Manager Macro API reference for more information.

Configuration

The macro design and configuration is available for Users who have the Allow macro editing option enabled on their Client
Profile on the server. Without this option Users can only change the Enable event-driven macros option. This controls if the
macros that have been assigned to the User will be triggered on the associated call events.

When creating new macros they are first designed and tested from within this section. When this is complete they can be
published and this makes them available on the server. Once published they can then be assigned to the relevant Users. A
copy is made of the local version of the macro and this then cannot be edited. Any updates would need to be made on the
original local version and then re published. Users would then need to be reassigned to this new published version. This
provides a level of security to prevent macros being deployed without permission.

The list of macros shown in the Macro Configuration section only shows the local macros not published to the server for this
User. To see the list of published macros see the Macros section on the server user interface.

To create or edit a new macro:

. Click on the New or Edit button.
. Enter a Name that will be used on the server to identify this macro.
. Enter a Description that can be used to detail what this macro is for.
. Select the call event to automatically trigger the macro.
o Direction: inbound, outbound or both.

A WODN =

o State: call ringing, call answered, call cleared, call cleared only when answered or user controlled (i.e. via a
toolbar button).

o Type: external, internal or both.

5. Enter the macro text in the VB Script section.

6. Use the Test button to validate the syntax. If there are any errors then a message box will be displayed indicating the
error.

7. Click on Save to save this macro.
To publish a macro:

Select the macro from the list of macros available.

Click on Publish.

Enter a new name for the macro, it is recommend to include a version or revision number.
Click Ok

From the server user interface, assign this to the relevant Users.

a s~ D~

To delete a published macro:

1. From the server open the Site -> Features -> Phone Manager -> Macros section
2. Select the macro and click on Delete.
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7.7 Application Support Plugins

Overview

Phone Manager Professional License contains plugins available that are able to directly integrate with a range of well known
CRM and PIM applications. The plugins generally provide deeper, more seamless integration than other methods as they
leverage the APIs of the specific application.

Features

There are 4 features that the plugins can provide. Depending on the application that is being integrated with, only some
features may be available with varying levels of support and there may need to be integration work performed by the
application vendor or administrator of the system. See the application integration document for the specific plugin for
details.

o Dial out directly from the application: For example having a dial button next to a telephone number field.
e Screen popping: Searching the application for contacts that have matching caller ids and displaying the record.
e Call history: Creating a call history phone call activity in the application with the call details.

e Calendar and DND synchronization: Controlling the DND state of the extension based upon calendar entries
in the application.

Configuration

To configure a plugin for one of the application support features:

1. From the Application Support Configuration section.

2. Click on the New button.

3. From the list of Applications select the application to integrate with.
4

. This will then change configuration on the right hand side to show the specific configuration required for this
plugin. See the relevant integration document for details.

5. Select the Feature to enable either:
o Screen pop
o Call history
o Calendar / DND sync

6. Multiple features can be enabled for each plugin by repeating the process from step 1.
7. Select the event trigger that will cause the feature to be acted on (this is not applicable to Calendar / DND sync).
o Direction: inbound, outbound or both.

o State: call ringing, call answered, call cleared, call cleared only when answered or user controlled (i.e.
via a toolbar button).

o Type: external, internal or both.
8. Click on Save.
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7.7.1 Goldmine

Overview

This describes the features that are available when integrating with Goldmine.

Supported Versions

The following Goldmine versions are supported.

Version Supported
Goldmine v7.0 (SQL)

Goldmine v8.0 (SQL)
Goldmine v9.2 (SQL)
Goldmine v2013.1 (SQL)

Goldmine v2014.2 (SQL)

0000

Features
Integration with Act! supports the features listed below:

e Click to dial - TAPI

Click to dial - GM+

Screen pop for contacts

e Automatic call history entry

e Calendar & DND synchronization

Click to dial - TAPI

Goldmine supports dialing out directly from a Contact using the highlight and dial feature or using TAPI.
To configure this within Goldmine from the Tools -> Options menu select the Telephony tab as shown.
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TTESTS Optians @

| Perzonal | Record I Calendar I Schedule I Alarmz I Lookup I E-tail
Telephany | Pager I Syztem I Speller I Login

FEE Thiz folder allows you o control the wanous zettings for your PC's modern and your
@ dialing options from GaoldMine.

bodem Settings SoftPhone [SIP Client)

T&FILine: |5:Mitel PhoneManager — ~| | SIP Settings... |

[ Start SoftPhone with GoldMine

[ Dialing Properties ] [ Line Properties ]
[ Usge SaoftPhone by default L

Drial Mumber Formatting

@ Let TAPI format phone numbers Dial Prefis: iy
() Dial numbers as entered Crial Suaffis: ¥
Local Area Code: 0000 Hangup after; 30 5| zec

[ (] ] [ Cancel ]

Then select the Phone Manager TAPI option from the TAPI Line drop down box in the Modem Settings. Contacts can then be
dialled by either right clicking on the Phone description field (i.e. Phone 1, Phone 2 or Phone 3) and selecting Dial or clicking on
the button from the toolbar menu — this dials the Phone 1.

/v, See the Phone Manager User Guide for TAPI requirements

Click to dial - GM+

Goldmine supports dialing out directly using a GM+ View that converts the telephone numbers into clickable hyperlinks that call
the number when selected.

When using Goldmine and TAPI for outbound dialing Goldmine displays addition dialogue boxes that "pop-up" within the
Goldmine user interface, these additional dialogue boxes cannot be disabled within Goldmine. Using the GM+ View does not
cause these boxes to be displayed or have any of the limitations of using TAPI, including unable to use in a multi-user
environment.

GM+ Views once created change their content based upon the currently selected contact within Goldmine making it ideal for
creating hyperlinks. GM+ View tab will need to be enabled by a Goldmine system administrator for clients, and can only be
edited / created by a Goldmine Administrator.

- Relationships Details MNotes GM+View Pending Histary Opportunities Projects Cases

| Create Web Form |

The GM+ View tab can have multiple "Templates" associated with it, this allows the user to select which information they wish
to see. These templates can be static or rules based. A full explanation of templates is NOT covered by this document.
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When creating a template you will be provided with the Goldmine template editor, the first step should be to click the HTML
editor button to change it to its HTML editing view (Highlighted in red in the image below).

| Edit SIP Test GM Vi

Template Name: [SIP Test

The following HTML snippet can be pasted into the editor:
<a href="sip://&lt;&lt; samp;phonelsgt; &gt;">Call &lt;&lt; &amp;phonels&agt; &gt;</a>

This snippet when viewed via the GM+ View in Goldmine will provide a SIP URI link containing the phone number contained in
the Phone1 field of the current contact, and will dynamically change based on the selected contact. Addition entries can be
added to the GM+ View template containing Phone2, Phone3 fields from Goldmine by editing the above examples substituting
phone1 with either phone2 or phone3. If a phone field has no number then a blank call entry will be shown.

Comast ¥ Antoric

Ve becon | K| Commncats = Schackis v Compists = AdTa = !i‘]

Masd Miivily - Lash Aty © Lk Nl

Compary: Uta Prone 1444 1250 430000 sarmn Lt
Contact: Amiznio Phona B e Facabock:
haa Mading Phwrss Ea Cay Teier
Pl P Ea S
[l E=al Foatal Codde:
e j T Courtry

Bad

Feert " e e

= Relwospip || Dol || Mates || GHAVIEW | | Pescag || ey || Oppenets || Praens || Ces

Creaie Fot Fom

Call+44 1251 430000

Screen pop for contacts

The Goldmine contacts can be screen popped directly within Goldmine when an incoming call is received using the caller id or
from an outgoing call using the dialled number. The telephone number is then used to find any matching contacts that have this
number. For example an inbound call is received from 02071975186 as shown on the toaster. The plugin performs a search on
the contacts to find any records that have matching telephone numbers. A match was found and the contact record was

Page 106



User Guide

automatically displayed.

EﬂdFrontRange Gold™ine Premium Edition - [Gary Fisher]
File Edt GoTo Tools  Act
A Fr— r— T e T s
=l I contact Gary Fisher
' o
| 5 8 X | [ Communicate ] [ Schedulz - ] [ Complete ] [ AddTo - ] [
Mext Activity - 25/09/200010:30 Last Activity : 18/09/2000 10:36 Last Note :
Compary: Mitel Phone 1: +44 1291 430000 Ext: Address:
Contact: Gary Fisher Phaone 2 Ext: Address:
Last: Fisher Phone 3 Ext: City:
Prefie: Gary Fau Ext: State:
Dept: sales E-mail Postal Code:
Title: Sales Manager wieb Site Country:
Source:
Record Type: Interest Open:
| Industiy: Acct Magr. erge:
- Relationships Details Motes GMH-Vigw Pending History Opportunities Projects Cases
+44 1291 430000 00:01
D... [+]| Ti..[~]| Contact~||U._[v||A._[*]R..[*] R... PRI
T[] f=]|u..[]|a. [7]|R..[7]|R... [*] . +44 1291 430000
18/09.. 1036  GaryFisher MAST.. Callln  ACK GoldMi.. | contact: Gary Fisher, +44 1291 430000 j
Company: Mits|
foooeeoa] Assigned: MASTER (FrontRange Solutions Empla), 10:36,
18/09/2000 = @
Common Contact Set Num [Mitel [25July 2014 [1#27 Clear call

If multiple matches are found then the first Contact found with this telephone number will be displayed.
Contact fields

The range of telephone numbers that are to be searched for can be configured. By default the common telephone number
fields are pre selected.

Field Name Enabled?

Account Number
Phone 1

Phone 2

Fax Number

All Telephone Fields

0000

Telephone number formats

Goldmine does not provide a standard format for storing telephone numbers within the system by default. The plugin supports
searching for multiple different formats dependent on the region (UK or US) where the client is running. The default formats for
the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats
9876543210 987.654.3210 +1 (987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
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1(987) 654-3210 (987)654-3210

Automatic call history entry

Phone Manager can work with the History within Goldmine and can have Call Completed entries automatically created for calls
made or received by the User when a match has been found to an entry in their contacts. The contact to associate with this is
found using the caller id received or dialled number.

The notes section of the call entry is populated with the information shown.

A T o Fane]

LﬂF Completed Outgoing Call M= E
Contack: Bckiviby Lser:
I Sarah Shart j ﬂ ICaII ot j IMiteI j [ Private
i Reference: -
i I Unanswered Call IE r
! Opportunity | Project: Or Case i
r |  HNew | Mew 2
. Il{nnne]l J _I Il{nu:une]l J _l [
N Code: Resulk; Date: Tirne: Dwrakion: Success: i
i IOl [* [1ziogjz04 [o] [1zi12 [ | [omooion [ [successru =] |k
E! Motes: C
H - i
. B2 U LA | %Y
P Phone number:+44 1291 430000 = £
b DDl C
DDl Name:
l: Direction: OQutbound Account Code: LI F
]
. [@ (0] 4 I Cancel | 5
STETE ENMZGOETT ST Ao T ST O L0 1= | 4 I —— P T T I T
Phone number For inbound calls this is the caller ID and for outbound calls this is the dialled
number.
DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.
DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.
Direction The direction of the call.
Account Code The account codes that was set on the call.
Trunk For external calls the outside network trunk number that the call was made or
received on.
Transferring Extension The device that the call was transferred from.
Duration The duration of the call. The call event trigger must have been set to Call End
as they are not known until the call is cleared.
Call Recording If integrating with a call recorder then this can contain a URL link to the call

recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

Calendar & DND synchronization
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The calendar within Goldmine can be synchronized with the DND status of the extension of the User. For example when there
is an appointment in the calendar and this is due the extension can be automatically placed into DND with the DND text set to
the Reference field of the appointment. When the appointment ends, the extension will be automatically removed from DND.

For example the Appointment entry below will place the Users extension into DND between 09:00 and 16.30 with the DND text
set to "Sales Meeting".

ﬂFruntRange GoldMine Premium Edition - [Calendar for Mitel () - 25 July 2014]

File Edit GoTo

Calendar »*

| & 9 X 6d | Show| Tody | User| X4RIDS w || Todwy [+ [  Edi >

28 Julp 2014 Tazk

Iz Tomnas Mendoza: Sales Meeting

[« | 2

Jocazion | Categc
k- Day | Weekl Monthl Yeall @l F'Iannerl g I:Iutlinel Ra] Feg Bnardl
Comman Contact Set Hum [Mitel |25 July 2014 [14:33
Configuration

The integration needs to be configured for the correct version of Goldmine that is running. From the Version tab select the
relevant entry from the drop down list.

GoldMine™®

Settings | Fields

Wersion Goldmine v2013.1 (30L) W
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7.7.2 Maximizer

Overview
This describes the features that are available when integrating with Maximizer.

Supported Versions

Version Supported

2015 (v13.0) Desktop Client @

Features
Integration with Maximizer supports the features listed below:

e Screen pop
e Automatic call history entry

Screen pop

Company, Individual and Company Contact records can be screen popped directly within Maximizer when an incoming call is
received using the caller id or from an outgoing call using the dialled number. The telephone number is then used to find any
matching records that have this number. For example an inbound call is received from 7774441111 as shown on the toaster.
The plugin performs a search to find any records that have this telephone number. A matching Company entity was found and
the associated record was automatically displayed within Maximizer.

@ =~ Ixg "_J -_] =

Home Edit View Search Tools Reports Setup - O X

7 Address Book Entry - D = || & ) [ L %
| Case 7

Email Mote _J_ Phone || Schedule| Insert /| Time Assign to

Opportunity i - - Print~ | aTask | Campaign
Create Write Track Subscribe
Columns:  *Default Address Book View - [ﬂfﬁ
Mame & Phone Mumber Email Address City
= [ ] MITEL (222) 555-4444

1| n 3

faie. e [Hla [¥lolfsk (] Hotes | j=iUser Defined Fislds o Documerts  [gaddress Boak Ord... .
=D 4
Columns: *Default Coi Show:  <All> ~ 4 % ¥ ShowAll Filte

hhatme and Phone Mumbs ¥ ¥ Date Titme Type Texd 7774441111 00:02
[ MITEL -p April 7, 2015 44 PR Outgoing  Phone Call: Pape, Luka '
-y (222)955-4444 . ) N . e T -
(777) 4441111 April 7,2015 43 PM Cutgaing Ehlnnnla Call.l MITEL o 7774441111
Pape, Luka

(2221 555-4444

SUFIEDBAEAEDE »

4| N m 3

(= B3 @) ()| PressFiforHelp  User MASTER | Tuesday April 7,2015  9:47 PM ':E'I Clear call

If multiple matches are found then the Multiple Matches window is shown and enables the User to select the correct record to
be displayed. For example a call is made to 222555444 and this has found three matching records, a Company Contact,
Company and Individual record that have this telephone number.
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Multiple Contacts Found

i Company: Mitel

s~ Company Contact: Andrew Bamber

‘. Individual: Candice Langlais

=N BCR (=™

Display

The correct record can then be highlighted and then clicking on the Display button will open this associated record.

Automatic call history entry

The plugin supports the ability to be able to automatically create a Maximizer "Phone Call" Note. The record to associate this

with is found using the caller id received or the number dialled.

The record is automatically created with the information relating to the call entered into the relevant fields.

Phone number

DDI/DID
DDI/DID Name

Direction
Account Code

Trunk

Transferring Extension

Duration

Call Recording

Configuration

Authentication

For inbound calls this is the caller ID and for outbound calls this is the dialled
number.

For external inbound calls only, the DDI/DID number that the call came in on.

For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

The direction of the call.
The account codes that was set on the call.

For external calls the outside network trunk number that the call was made or
received on.

The device that the call was transferred from.

The duration of the call. The call event trigger must have been set to Call End
as they are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The database authentication details used to connect to the Maximizer database are configured on the Authentication tab.
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B Maximizer
Authentication | Records

Logon Details

Enter a Maximizer username and passuord

sernarme MASTER

ArhhrAA A
Password

Enter a valid Maximizer Username and Password into the relevant fields.

Records

The type of records to include when performing a search can be controlled on the Records tab.
B Maximizer

| Details |.&uthenticatinn| Records |

Zearch Records

Select the type of Corpanies
entities to include
when searching
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7.7.3 Microsoft Office 365

Overview

This document describes the features that are available when integrating Phone Manager with Office 365©.

Supported Versions

Office 3650© is an online product and has no concept of a version numbering scheme, Phone Manager integration was tested
against the version running in November 2015.

Features

Integration with Microsoft®© Outlook®© supports the features listed below:

* Screen pop for contacts
« Calendar / DND Synchronization
* Call History Entry

Screen pop for contacts

Office 3650 personal contacts can be screen popped when an incoming call is received using the caller id from the
inbound call or the dialled number on an outbound call. For example, an inbound call is received from 07718402534, if a
contact exists then it is displayed through the users default web browser:

Dorian Geroux

Dorian Geroux

If multiple matches are found then the Multiple Contact Found dialog is shown.
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Multaple Contacts Found -_— O x
- 7

Contact: Sergio Araya
Contact: Isa Sastre

When searching all the telephone fields with a contact supported by Office 365© are searched for a matching record.
The plugin supports searching for multiple different formats dependent on the region (UK or US) where the client is
running. The default formats for the UK and International are shown below. This is based on the number 08001831234
being searched for.

UK & International Telephone Formats

08001831234 +44 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234
0800 1831234 0800-1831234 (0800)1831234 (0800)-1831234
(080)018-31234 0800 183 1234

The default formats for the US are shown below. This is based on the number 9876543210 being searched for.

US Telephone Formats

9876543210 19876543210 987-654-3210 1-987-654-3210
987.654.3210 1-987.654.3210 (987) 654-3210 1(987) 654-3210
+1(987) 654-3210 (987)654-3210

Calendar & DND synchronization

The personal calendar within Office 365© can be synchronized with the DND status of the extension of the User. For
example, when there is an appointment in the calendar and this is due the extension can be automatically placed into
DND with the DND text set to the subject of the appointment. When the appointment ends, the extension will be
automatically removed from DND.

Busy states The busy status of the appointment can be used to filter what type of appointments will be used to
automatically change the DND status.
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Showr as

Free il

Free
Working elsewhere
Tentative

+ Busy

By

From the Busy Options tab check each entry to include this type of busy status.

I'J Office 365

Connection Busy Options  Settings

Status
Show these types of appointment
[ ] Busy Away Tentative
Free Working Elsewhere

[ ] Private Events

CallHistory Entry

Phone Manager can work with the notes field within an Office 365© Contact and can have Phone call entries
automatically created for calls made or received by the User when a match has been found to an entry in their Office
3650© contacts. The contact to associate with this is found using the caller id received or dialled. If multiple matches are
found then the Search Results window is shown as for the screen pop.

.'B Tomas Mendoza

Contact Motes

CLI 2 +44 1291 430000

Call Direction : Qutbownd

Call Status : Answered

Start Timme @ 18/12/2015 15:15:57

End Time : 01,/01,/0001 00:00:00

Call Recording : http://mitelrecorder/defaultaspxTrecid=2320716

Configuration

The integration to Office 3650© requires the users individual User Id and password.
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] Office 365

Connection  Busy Options  Settings

Office 365 User ID|gary.fisher@ mi'tel.cmmicrcsc:f|

Password I |

There is also an option to show the default contacts page when there is no contact match:

] Office 365

Connection Busy Options  3ettings

[ ] Open Default Contacts Page on ‘Mo’ Match

Test

There is also a ‘Test’ button which will test whether the configured user credentials are correct.
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7.7.4 Microsoft Outlook

Overview

This describes the features that are available when integrating with Microsoft© Outlook®.

Supported Versions

The following Microsoft© Outlook® versions are supported.

Version Supported

-

Outlook® 2010 32bit

N

Outlook®© 2010 64bit

-

Outlook®© 2013 32bit

Outlook®© 2013 64bit

-

Outlook®© 2016 32bit

-

Outlook®© 2016 64bit

CO0000O00

Business Contact Manager for
Outlook®©

' Desktop client for Microsoft® Windows

Features
Integration with Microsoft© Outlook© supports the features listed below:

e Directory import for contacts

e Click to dial

e Meet-Me conference creation

e Screen pop for contacts

e Automatic journal entry

e Calendar & DND synchronization

e Business Contact Manager for Outlook

Directory import for contacts
Users can enable their Outlook®© personal contacts to be linked into Phone Manager. This enables the contact to be searched
for using the Home, Telephone or Mobile/Cell numbers as well as the first, middle, last or company name fields directly from
within Phone Manager. As there can be other types of contacts shown in the Phone Manager contacts window, Outlook©

contacts are shown with a icon next to them.
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. Mitel Phone Manager G~ _ OX

Candice Langlais

BE6S #®

Contacts Call history

- Neville Mayﬁr
77744411

Sergio Araya
535?%?5656 !
pellafong

Endpoint 1803 Agent

Once found they can then be dialed using any of the numbers associated with the contact. Clicking on the dial icon will call the
main number but any number can be selected by right clicking and selecting the relevant number to call.

[ 1 ]
[ ] |
Sun Shu e
77444111 j Call control [ Dial q
'@ 7774441111
fi[{f_'fbf" Add to favourites Retrieve Voicemail 6665554444
it Pl wlalele]

Frequently accessed contacts can be pinned to the Users favorites directory, by right clicking on the contact entry and selecting
Ad(d to favorites, so that they permanently appear on the contacts tab.

| /&, Only contacts in the users personal folder are available for directory searching and adding to favorites.
Click to dial

Calling a contact directly from Outlook®© is supported when using the Phone Manager Outlook© Add-In. This is installed by
default with each Phone Manager client and adds new entries to the contacts screen within Outlook®. When the contact list is
open a User can right click on a contact and select the Phone Manager menu and then select the number to call.
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Ol | FULL MAME EUSIMESS PHONE | MOEBILE PHOME JOEBE TITLE COMPANY FILE AS
Click here to add a new ...
4 Company: Mitel ; 3 item(s)
= Simon Crystal 7774441111 FEE5554444 Mitel Simaon Crystal
&3] Alberto Puga B887TTEEER RARGGGAAAA Mitel Alberto Puga
[Z5]  Shana Bouchard 111222333 E& Copy Mitel Shana Bouchard
#2 Quick Print
|§__|, Forward Contact »

t.
>

%

x

Create k

Phone Manager »

Call 3
Categorize [
Follow Up [
Mowve »
Delete

Business: 8887776666

When in the contact list or contact details view at the top the ribbon bar can also be used. From the Communicate ribbon,

select More and then Phone Manager.

L -

‘v =

Emnail Meeting | Mare List
Communica

O@ | FULL M Phone Manager
Click here to add a new ..,

4 Company: Mitel: 3 item(s)

&3] Milo Joubsrt 7774441111
[E5]  Marco Moreno BRETTTEEEE
B3 PippaCrane 1112223333

Current View

Business; 8887776666

BEE5554444
BEE5554444
BEH5554444

=
P ail

Merge

Actions

Forware

Contact

IC

COMPANY

Maove

IOB TITLE

Mitel
Mitel .
Mitel -

@‘ This requires Phone Manager to be running in the same Windows session as Outlook®©.

Meet-Me conference creation

Creating a new Meet-Me conference appointment directly from Outlook® is supported when using the Phone Manager
Outlook©® Add-In. This is installed by default with each Phone Manager client and adds new entries to the calendar screen

within Outlook®©.
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Ea -"_llj: - Calendar - Qutlook SEARCH TOOLS
FILE HOME Mew Tab SEMD f RECEIVE FOLDER WIEW SEARCH

= R W E
Mew Mew Mew

Mew Today Mext7 Day | Work Week Month Schedule
Appointment Meeting ltems - Meeting Days Week View
Mew Phone Manager GoTo M Arrange G
1 June 2014 b | Create a new meeting
/2014

MO TU WE TH FR SA SU [‘5 Phone Manager Add-In
26 27 28 29 30 31 1 Tell me more TUESDAY

2 3 4 5 & T 8 1
9 10 11 12 13 14 15
16 17 18 19 20 21 22
23 24 25 26 2T 28 29
08

July 2014
09

MO TU WE TH FR 5A 5U

1 2 3 4 5 &
i 8 9 10 11 12 13

When selected, a new appointment is displayed that is pre populated with the telephone number and access code to dial into a
Meet-Me conference.

10

@ | -
APPOINTMENT INSERT FORMAT TEXT REVIEW

[ =
N E?j x ] Calendar E -;QD :,_."b_.,! M Busy ~ |42¥ Recurrence ==l . Q

Save & Delete '9; Forward - APpeintment Schelduling Invite 15 minutes - @ Time Zones  -ategorize N Zaoom

Close Assistant  Attendees - o
Actions Show Attendees Options Pl Tags Zoom ~

Subject Meeting:

Location Meet Me Audio Conference -

Starttime | Mon 30/06/2014 FE| |oes0 - All day event

Endtime | Mon 30/06/2014 FE| | 10:00 -

To join the Mitel Meet Me Audio conference please dial one of the numbers below and enter the access code:

Internal: tel://1300
External: tel://

Access Code:

Screen pop for contacts

The Users local or public contacts can be screen popped directly within Outlook© when an incoming call is received using the
caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching contacts
that have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin has then
performed a search on the Outlook®© contacts to find any records that have matching telephone numbers. A match was found
and the Outlook® contact records was automatically displayed.

Page 120



User Guide

FCE ™ | = Helene Moulin - Contact ? H - 0O
COMNTACT INSERT FORMAT TEXT REVIEW

EWJ-)J x R save8iNew - [ElGeneral [ AlFields [ Email E-_Qi 5;@ ,.—7\/ 10 Categorize -

B3 Forward - [?‘DDETEHE FEMaeting |* Follow Up -
Save & Delete ° - Address Check  Business Picture
Close ~ Certificates £ More = Book MNames Card - Private
Actions Show Communicate MNames Options Tags Zoom
Full Mame... Helene Moulin Helene Moulin
- Mitel
Company Mitel
4441111 Work
Job title 554444 Maobile
File as Moulin, Helene -
Internet
[} E-mail... -
Display as Motes

Web page address
IM address

Phone numbers

Business... - 773441111
Home.. . 7774441111 0004
Business Fax., | = 7774441111
Mobile... - 2225554444
Addresses
Business.. 7
This is the mailing Clear call

If multiple matches are found then the Search Results window is shown and enables the User to select the correct contact to
be displayed. For example a call is made to 222555444 and this has found three contacts that have this telephone number.

Q SearchResults = =

Results

- Contact: Nache Valencia, Mitel [\\nache.valencia@mitel.com\contacts]
.- Contact: Chiara Tremblay, Mitel [\\chiara.tremblayw@mitel.comi contacts]
. Contact: Maureen West, Mitel [\\maureen.west@mitel.com'contacts]

+44 1291 430000
+44 1291 430000

Displary

Clear call

Double clicking on the relevant contact or highlighting and clicking on the Display button will show the required Outlook©
contact.

Contact folders

The Users local Outlook© contact folder is used when trying to find any matching contacts (Default). Additional Outlook©
Public folders can be added to the search from the Contacts tab in the configuration.

To enable public folders to be searched check the Search Public Contact Folders option and then click on the Refresh button.
This will list all of the available public folders for this User and then the appropriate options can then be selected.

/&, Using public folder searching may require additional time to perform the search and could delay any matches
from being found.

Contact fields
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The telephone number fields that are to be searched can be configured for the contacts from the Fields tab in the configuration.
7 look
@< Outloo

Profile | Contacts | Fields | Call Details | Busy Options | QO * |

Select the Cutlook Assistant ~

telephone numbers Business
Business 2

to search
Business Fax W

[] Show Blank Centact

Multiple search matching

The list shows all of the available telephone number fields and if they are enabled for searched by default. These are the
default field names and descriptions and may be different from the ones shown in Outlook®©.

Outlook Outlook Field Name Enabled?
Description
Assistant AssistantTelephoneNumber

Business BusinessTelephoneNumber
Business 2 Business2TelephoneNumber

Business Fax BusinessFaxNumber

Callback CallbackTelephoneNumber

Car CarTelephoneNumber

Company CompanyMainTelephoneNumber
Home HomeTelephoneNumber

Home 2 Home2TelephoneNumber

Home Fax HomeFaxNumber
ISDN ISDNNumber
Mobile MobileTelephoneNumber

Other Fax OtherFaxNumber

Pager PagerNumber

Primary PrimaryTelephoneNumber
Radio RadioTelephoneNumber
Telex TelexNumber

3] 3l N X XK T T I I Xl Xl S J XTI T < %
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TTY/TDD TTYTDDTelephoneNumber

Unmatched Contacts

If no matches are found then a blank contact can be shown with the outside number pre populated into the Business telephone
field. Check the Show Blank Contact option to enable this, or uncheck (Default) to not do anything when no match is found to a

call.
PrER ™ | 5 Untitled - Contact ? H - O X
CONTACT INSERT FORMAT TEXT REVIEW
@ x R Save & New - [23General E alFields  [& Email :_E! é}m ’L/' i1 Categorize ~
= . . |~
(&3 Forward - ['_||:|Deta|ls F‘EMeetmg C k _ |* Follow Up ~
Save & Delete o . Address Check Business Picture
Close n Certificates 5 More - Book Mames Card - Private
Actions Show Communicate MNames Options Tags Zoom A
Full Name...
3332221114 Work
Company
lob title
File as -
Internet
EE E-mail... -
Display as Motes
Web page address
IM address
Phone numbers
Business... - 3332221114
Hame... -
Business Fax.., -

Multiple search matching

When more than one contact is matched and the Multiple search matching option is checked (Default) the Search Results
window is displayed to the User to allow them to select the relevant contact. If this option is not checked then the first match
found will be used and any further searching will be stopped. This can be useful when using public folders to reduce the time
taken to perform the search.

Telephone number formats

Outlook®© does not provide a standard format for storing telephone numbers within the system by default. Depending on the
region where the client is running then different formats will be used:

UK & International Telephone Formats

08001831234 +44 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234
0800 1831234 0800-1831234 (0800)1831234 (0800)-1831234
(080)018-31234 0800 183 1234

US Telephone Formats
9876543210 19876543210 987-654-3210 1-987-654-3210
987.654.3210 1-987.654.3210 (987) 654-3210 1(987) 654-3210
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+1(987) 654-3210

Call details

The call information that is used to search for matching records can be configured. By default the dialed number or the caller id
are used to search depending on the call direction, but other call details can configured. There are options for the direct dial
number (DDI/DID) or the direct dial name (DNIS).

B4 Outlook

Profile | Contacts | Fields | Call Details | Busy Options | Q) 4 | ¥

Information

Select the call details to Caller ID (CLI)

use for the search, Multi [ | Direct Dial (DDI/DID)
select items to use more |:| DMIS/DD Mame
than ocne and re order the
itemns in preference of
search order,

Automatic journal entry

Phone Manager can work with the Journal within Outlook®© and can have Phone call entries automatically created for calls
made or received by the User when a match has been found to an entry in their Outlook®© contacts. The contact to associate
with this is found using the caller id received or dialed. If multiple matches are found then the Search Results window is shown

as for the screen pop.

=2 H s Answered - Journal Entry ?T H - O X

FILE JOURMAL ENTRY IMSERT FORMAT TEXT REVIEW

|3—-| o, - I N [ 34 Q

—/’I [ ] L") 6| "\.

= =3 Ep I . V@
Save & Forward Delete Start Pause (Categorize Private Address Check Zoom

Close Timer Timer - Book Mames

Actions Timer Tags MNames Zoom .

Subject Answered
Entry type Phone call = | Company
Start time Fri 04/07/2014 E 13:05 = | Duration 0 minutes -

Phone number: 0111222333

DDI: 03332221114

DDI Mame: Sales

Direction: Qutbound

Account Code: 655

Trunk: 34309

Transferring Extension: 2001

Contact: Crane, Pippa

Call Recording: https://callrecorder/default.aspx?recid=1556142

The body of the journal item is populated with the information below and the start and duration of the call.

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialed number.
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DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in on.
Direction The direction of the call.

Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or receivec
Transferring Extension The device that the call was transferred from.

Contact The Outlook® contact name in the last name, first name format.

Duration The duration of the call. The call event trigger must have been set to Call End as they

not known until the call is cleared.

Call Recording If integrating with a Xarios Call Recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a browsel
The call event trigger must have been set to at least Call Answered as the call recorde
only create the recording id when the call has been answered.
Calendar & DND synchronization
The calendar within Outlook© can be synchronized with the DND status of the extension of the User. For example when there

is an appointment in the calendar and this is due the extension can be automatically placed into DND with the DND text set to
the subject of the appointment. When the appointment ends, the extension will be automatically removed from DND.

Busy states

The busy status of the appointment can be used to filter what type of appointments will be used to automatically change the
DND status.

B d A
FILE APPOIMNTMENT IMSERT FORMAT TEXT REVIEW

@ x Fq Calendar D Eﬁ :'..I.ﬂ.‘ z.Bus}f - Recurrence

Save & Delete £, Forward ~ Appointment Schelduling Invite Mone - | @ Time Zones
Close Assistant | Attendees
Actions Show Attendees Options

From the Busy Options tab check each entry to include this type of busy status.

@z Outlook

Contacts | Fields | Call Details | Busy Options | Qptions| | 4 | ¥

Status

Show these type of appointment

Busy Cut of Office
Free Tentative

Sensitivity options

The sensitivity type of the appointment can be used to filter what type of appointments will be used to automatically change the
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DND status. From the Options tab check each of the Sensitivity Options to include this type.
"
@2 Outlook

Contacts | Fields | Call Details | Busy Options Options 1]+

Sensitivity Options

Mormal Private
Personal Confidential
Other

Show All Day Events Include Recurrences

Other options

There are other options that can be used to filter the type of appointments to include. Check the Show All Day Events include
all day events. Check the Include Recurrences to include appointments that are recurring.

Business Contact Manager for Outlook

Phone Manager supports integration with contacts stored within Business Contact Manager for Outlook in the same way as for
contacts that are stored within Public Folders.

A, Business Contact Manager contacts are not available for directory searching and adding to favorites.
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7.7.5 Microsoft Dynamics CRM

Overview

This describes the features that are available when integrating with Microsoft Dynamics CRM.

Supported Versions

The following Microsoft Dynamics CRM versions are supported.

On-premise deployment

Version

v5 (2011) @
V6 (2013) @
V7 (2015) @
v8 (2016) @
Features

Internet-facing deployment (IFD)

)
)
)
)

0000

Integration with Microsoft Dynamics CRM supports the features listed below:

e Screen pop for contacts

e Automatic call history entry
e Calendar & DND synchronization

Screen pop

Microsoft Online

CRM Contact, Account and/or Lead entities can be screen popped directly within CRM when an incoming call is received using
the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching entities
that have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs
a search to find any records that have matching telephone numbers. A matching Contact entity was found and the record was
automatically displayed using the Users default browser.

Ay .

CONTALT ~

Luka Pape

Summary

CONTACT INFORMATION

Full Name *

Job Title

Company Mame
Email

Business Phone
Muobile Phone

Fax

Preferred Method o

Address

Active

Luka Pape

By MITEL

2225554444
7774441111

Any

@

Isa Sastre
Mitel
al
Owner™*
Isa Sastre
A
FOST
7774441111
41N
v
H

00:02

Clear call
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If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct record to
be displayed. For example a call is made to 222555444 and this has found three matching Contact entities that have this
telephone number. This also will then show the any related entities, in this example the Account the contact is associated with.

Multiple Contacts Found - O

Results

. - Acrount: BUSINESS CONTACT
|-l Contact: Alberto Puga
- Acrount: BUSINESS CONTACT
=~ Contact: Aurora Rojas
‘.. Account: BUSINESS CONTACT

2225554444 00:01
2225554444

©

Clear call

The correct Entity can then be highlighted and then clicking on the Display button will open this record.

|‘§“-'|‘ The plugin will only search for Accounts and Contacts that are in the Active state. If any records have been
Deactivated then they will not be displayed.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set. For
example it can be configured so that only the Contact Entities are searched. These options are set on the Options tab

Mg Microsoft Dynamics CRM

Settings | Server | Profile | Options | Call Details | Activitie * | ¥

Screen Pop

Accounts Contacts Leads

Mo Match Options
Display blank entity Type |contact v

[] Custom Search

If no match is found then the Custom Search option can be selected and this will display a form to allow the user to enter the
first name, last name, date of birth or post code and these values will then be used to try and find any matching records.
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o] Advanced Search = B
)
Mt

First Mame || | Last Name

Postal/Zip [ ] Check Date of Bith  2014-03-1C
Display

If still no match is found when searching for an Entity than a blank form can be automatically displayed to create a New Entity.
The Type of Entity, Contact, Account or Lead that is created can be set here.

Advanced options

The Advanced tab allows control over if related Entities of a matching Contact, Account or Lead are shown in the Multiple
Contacts Found window.

Ay \Vicrosoft Dynamics CRM

Account Fields | Contact Fields | Lead Fields | Advanced | g+ |+
Related Searches

[] Search for related entities

Select the related Entites to search for

Cpportunities Incidents / Cases Tasks

Any related Entities that have their statecode as Open (for Opportunities & Tasks) or Active (for Incidents/Cases) will then be
displayed in the Multiple Contacts Found window. Selecting these related matches in the Multiple Contacts Found window and
clicking DIsplay will then pop this record.

Search fields
The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or Lead

Entities individually. By default the common telephone number fields are listed on the Leads Fields, Contacts Fields or Account
Fields tab.
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Ay Microsoft Dynamics CRM

Account Fields | Contact Fields | Lead Fields | Advanced | 4 4 | "

Select the CRM Business Phone ~
contact telephone Home Phone
numbers to search Telephone3

Fax

Assistant Telephone
Manager Telephone
Maobile Telephone b

These are the default field name and descriptions and may be different if they have been customized. Contact your Microsoft
Dynamics CRM administrator for details.

Contact Entities

Field name

Business Phone

Home Phone
Telephone3

Fax

Assistant Telephone
Manager Telephone
Mobile Telephone

Pager

Primary Address Phone 1
Primary Address Phone 2

Primary Address Phone 3

Account Entities

Field name

Main Phone
Other Phone

Fax

Lead Entities

Field name

Business Phone

Field description

telephone1
telephone2
telephone3

fax

assistantphone
managerphone
mobilephone

pager
address1_telephone1
address1_telephone2

address1_telephone3

Field description

telephone1
telephone2

fax

Field description

telephone1
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Home Phone telephone?2 @
Other Phone telephone3 @
Fax fax @
Mobile Phone mobilephone @
Pager pager @

Telephone number formats

Microsoft Dynamics CRM does not provide a standard format for storing telephone numbers within the system by default. The
plugin supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The
default formats for the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats
9876543210 987.654.3210 +1 (987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210

Call details

The call information that is used to search for matching records can be configured. By default the dialed number or the caller id
are used to search with, depending on the call direction, but other call details can configured. There are options for the direct
dial number or the direct dial name (or DNIS) as shown.

Adg \Microsoft Dynamics CRM

Profile | Options | Call Details | Activities | Account Fields | * | ¥

Information

Select the call details to Caller ID (CLI)

use for the search, Multi [ | Direct Dial (DDI/DID)
select items to use more |:| DMISDDI Mame
than one and re crder the
items in preference of
search order,

@‘ Caller ID represents either the caller ID for inbound calls or the dialed number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check box next
to each one selected. The order of the searching can also be configured by dragging and dropping the entry and ordering the
list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.
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Automatic call history entry

The plugin supports the ability to be able to automatically create and display a Microsoft Dynamics CRM Phone Call Activity
entity. The Entity to associate this with is found using the caller id received or the number dialed, and if multiple matches are
found then the Multiple Contacts Found window is shown as for the screen popping. The telephone numbers used to search
are set in the screen popping section.

The Activity record is automatically created with the information relating to the call entered into the description field and the
related entities are linked as shown.

ill w 1] Qutbound Qutboun... | « H
Al

v MARK COMPLETE 3 CLOSE PHOME CALL = COMVERT TO - VX DELETE  wes

PHOME CALL ™

OQOutbound Answered

Priority Due Status™ Owner®
MNormal 7/23/2014 11:11 AM Open Sergio Araya

Subject™ Qutbound Answered

Call From * ER sergio Araya

Call To™ Sergio Araya

Phone Mumber +44 1201 430000 Direction Outgoing

Description

Phone number: +44 1291 430000

DDI:

DDI Name:

Direction: Qutbound

Account Code:

Trunk: 94308

Transferring Extension:

Call Recording: http://callrecorder/default.aspx?recid=1574601
Phone number For inbound calls this is the caller ID and for outbound calls this is the dialed number.
DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.
DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in on.
Direction The direction of the call.
Account Code The account codes that was set on the call.
Trunk For external calls the outside network trunk number that the call was made or receivec
Transferring Extension The device that the call was transferred from.
Duration The duration of the call. The call event trigger must have been set to Call End as they

not known until the call is cleared.

Call Recording If integrating with a Xarios Call Recorder then this can contain a URL link to the call

recording (this is not a clickable hyperlink but can be copied and pasted into a browsel
The call event trigger must have been set to at least Call Answered as the call recorde
only create the recording id when the call has been answered.
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The plugin configuration has several options that can be set to determine how the record is created.
Ay Microsoft Dynamics CRM

Server | Profile | Options | Call Details | Activities | Accou * |
Call Activity Record
[] Complete Activity Record

Display Activity Record

Complete Activity Record: This will set the status of the Activity to be Completed.

Display Activity Record: This will display the Activity form, if this is not set then the record will be created without the user
seeing the form.

Calendar & DND synchronization

The calendar within Microsoft Dynamics CRM can be synchronized with the DND status of the extension of the User. For
example when there is an appointment in the calendar and this is due to start the extension can be automatically placed into

extensionDND with the DND text set to the Subject field of the appointment. When the appointment ends, the extension will be
automatically removed from DND.

There are several options to be able to control the types of Activities that cause the extension to go into DND. The Priorities tab
allows Activities with a specific priority to be included or excluded.

Mg Microsoft Dynamics CRM

Lead Fields | Advanced @ Activities | States | Prorities T
Activity Priorities
Select the CRM

activity pricrities to
include,

The States tab allows only Activities with specific states to be included or excluded.

Mg Microsoft Dynamics CRM

Lead Fields | Advanced | Activities | States | Prorities 11"
Activity States
Select the CRM Busy
activity states to Qut of Office
include. Free
Tentative
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The Activities tab allows specific types of Activities to be included or excluded.

Mg Microsoft Dynamics CRM

Lead Fields | Advanced | Activities | States | Prorities 11"
Activities
Select the CRM Appointment
activity types to Task
include. Service Activi

Phaone Call

Fax
Letter

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow
access to Dynamics CRM.

Settings and versions

The correct version of Dynamics CRM that is used needs to be selected from the Version drop down on the Settings tab.

Mg Microsoft Dynamics CRM

Settings | Server | Profile | Options | Call Details | Activitie * | ¥

Information

Version | MSCRM 6.0 (2013) ¥

Test...

Server connection

The specific connection details to the CRM server need to be set on the Server tab.

Mg Microsoft Dynamics CRM

Settings | >erver | Profile | Options | Call Details | Activitie * | *
Server Details

Discovery Server mitel3.server.com

Does this server use S5L7

Crganisation Mame Mitel
Enter the friendly crganisation name (found at the

top right hand corner of the page in CRM),

Discovery Server: This is the URL of the Microsoft Dynamics CRM discovery server. This is normally the same as the CRM

Page 134



User Guide

server. Contact your administrator for details on what this should be.

For the Microsoft hosted version use the following based upon the organization location.

Location Discovery Server
North America crm.dynamics.com
North America 2 crm9.dynamics.com
Europe, Middle East and Africa (EMEA) crm4.dynamics.com
Asia Pacific Area (APAC) crm5.dynamics.com
Oceania crm6.dynamics.com
Japan (JPN) crm7.dynamics.com
South America crm2.dynamics.com

Does this server use SSL: If SSL/HTTPS connection is required to connect to the CRM system enable this option.

Organization Name: This should be set to the organization name configured for the company that will be used to integrate
with. This should match the exact name shown in the top right hand corner of the CRM web page when you are logged in.

Miles Jarvis
Ay o | 1] SALES ~ Contacts | « MNew Contact @ Mitel m

Authentication and profile details

The Profile tab enables the security credentials used to access Microsoft Dynamics CRM to be configured.
Ay Microsoft Dynamics CRM

Settings | Server | Profile | Options | Call Details | Activitie * | ¥
Details

[] Use Integrated Windows Authentication [IWa4)
Using Cffice 365 Account to Legin?

Username: nachowvalencia@mitel.couk

PES.SWDrlj: LAL ALl Ll)

Use Integrated Windows Authentication: If this is set then the username, password and domain details from user who is
logged on the computer will be used.

A, Using Integrated Windows Authentication is NOT supported when using IFD and claims based authentication.

Depending on the configuration of Microsoft Dynamics CRM and how it is accessed will determine what options are required.
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7.7.6 Microsoft Dynamics NAV

Overview

This describes the features that are available when integrating with Microsoft Dynamics NAV.

Supported Versions
The following Microsoft Dynamics NAV versions are supported.
Version Client Supported
v4.0 SP2 Classic Client @
v5.00 Classic Client @
v6.00 (2009) Classic Client @
v6.00 (2009 R2) RoleTailored Client @
v7.00 (2013) Web Client @
v7.00 (2013 R2) RoleTailored Client @
Features

Integration with Microsoft Dynamics NAV supports the features listed below:

e Screen pop

Screen pop

Microsoft Dynamics NAV Contact or Customer cards can be screen popped directly within NAV when an incoming call is
received using the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any
matching entities that have this number. For example an inbound call is received from 7774441111 as shown on the toaster.
The plugin performs a search to find any records that have matching telephone numbers. A matching Contact was found and
the card was automatically displayed within the NAV client.

This example shows the RoleTailored Client.
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_ My View - Contact Card - CTO00145 . Roberto Rivero == ===
Home Actions Navigate Report Mitel @
11 Create Interact
/ = |
“ = New [T Sales Quotes LS
Edit Apply L Contact
7< Delete Template.. Statistics Cover Sheet

7000145 - Roberto Rivero

General A Links ~ "

No.: CT000145 Past Code: - Link Address Descrip

Type:! Person - Country/Region ... -

Campany M., CT000142 - Search Name: ROBERTO RIV...

Cormpany M., Mitel Phone MNo.: 222555 4444 @

Marne: Roberto Riva... | ... Salesperson Code: - |% =

Address: Salutation Code: LIMNISEX -

Address 2 Last Date Modifi.. 0470872014

City - Date of Last Inter... I [ 3

County: Last Date Atternp.., Whas N \'

Mext To-do Date: | 4
Click here to create 3 new note, | 4 7774441 1 “] "] 00:02

Lines v

Communication ~ [rTaATI
Phone No.: 222555 4444 Q@) E-hail: 5]

habile Pho... TIT 4441111 @ Horne Page: @ -

Clear call

This example shows the Microsoft Dynamics NAV web client, the matching contact is shown using the Users default browser
settings.

Wiew - Contact Card - CTO00145 . Matthieu Gagnon B

Horne Avctions MNavigate Report General | Manage |

/’ Wiew j M Create Interact
a T ey 77 Sales Quotes oD

Close  Edit Apply Contact Cover
KDeIete Template.. | Statistics Sheet
hanage Process Report
General ~
Mo, CTO00145 Country/Region Code
Type Persan Search Mame MATTHIEU GAGNON
Company Mo, CTO00142 Phone Ma. 222555 4444
Cormnpany Marme MOTO GP Salesperson Code
Marne Matthieu Gagnon Salutation Code LIMISEX
Address Last Date Modified 04/08/2014 =
Address 2 Date of Last Interaction
City Last Date Atternpted
County Mext To-do Date
Paost Code
I Lines v
Communication A
Phone Mo, 223 555 4444 E-tail

taobile Phone Mo, TIT 4441111 Horne Page

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct card to
be displayed. For example a call is made to 222555444 and this has found three matching Contacts that have this telephone
number.
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Multiple Contacts Found EI@

- Contact: RoDerte Rivera
-~ Contact: Mark Laird
‘- Contact: Shana Bouchard

.

2225554444 00:01
2225554444

Display @

Clear call

The correct entry can then be highlighted and then clicking on the Display button will open this card.
Entity and matching options

Configuration options are available on the plugin that allow the type of cards to be used in the searching to be set. For example
it can be configured so that only the Customer or Contact Entities are searched. These options are set on the Options tab.

Selecting the Create record on no match? will create and open and new card of the type that has been selected.

Mg Microsoft Dynamics NAV
|"-.I'l.-"ehsite | Contact Fields | CustnmerFieIds| Options | Call [+ *

Screen Pop

Custormers Contacts

Create record on no rmatch? [Cu:untau:t v]

|‘§“-'|‘ If no match is found then no records will be displayed.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact or Customer cards
individually. By default the common telephone number fields are listed on the Contact Fields and Customer Fields tab.

These are the default field names and may be different if they have been customized. Contact your Microsoft Dynamics NAV
administrator for details.

Contacts

Field Description Field name Enabled?
Phone Number Phone No_ @
Mobile Phone Number Mobile Phone No_ @

Fax Number Fax No_ @
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Telex Number Telex No_ @
Pager Number Pager @
Customers

Field Description Field name Enabled?
Phone Number Phone No_ @

Telephone number formats

Microsoft Dynamics NAV does not provide a standard format for storing telephone numbers within the system by default. The
plugin supports searching for multiple different formats dependent on the region (UK or US) where the client is running. The
default formats for the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats
9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210

Microsoft Dynamics NAV stores the country code and area code parts of each telephone number separately from the main
number. From the Formats tab the country and area codes can be set to be appended to the telephone number when a search
is made.

Call details

The call information that is used to search for matching records can be configured. By default the dialed number or the caller id
are used to search with, depending on the call direction, but other call details can configured. There are options for the direct
dial number or the direct dial name (or DNIS) as shown.

Ay \Vicrosoft Dynamics NAV

| Contact Fields | Custorner Fields | Optiu:uns| Call Details Ak
Information

Select the call details to Caller ID {CLD

use for the search, bdulti [ Direct Dial (DDLDIDY
select iterns to wse more |:| DMIZDDI narne)
than one and re arder the
iterns in preference of
search arder,

@‘ Caller ID represents either the caller ID for inbound calls or the dialed number for outbound calls.
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The configuration box lets you select multiple different types of call detail with the details to be used having the check box next
to each one selected. The order of the searching can also be configured by dragging and dropping the entry and ordering the
list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.

["E| This field name must be the same with both Contacts and Customers.

Configuration

The integration needs to be configured for the correct version of Microsoft Dynamics NAV that is running.

Ay \Vicrosoft Dynamics NAV

Wersion | SOL Server | Authentication | Yifebsite | ContactF 4 |

Properties
Version | N&Y .00 (2013 R2) RTC Client  ~ |
Server Type 0L Server
Company Mitel

From the Version tab select the relevant entry from the drop down list. Then select the correct Server Type for the type of NAV
server that will be used, this can either be SQL Server or Navision and depends the on the version of the NAV selected.

Authentication
The Authentication tab enables the security credentials used to access Microsoft Dynamics NAV to be configured. Select the

Use Integrated Windows Authentication option if the username, password and domain details from user who is logged on the
computer will be used.

Ay Microsoft Dynamics NAV

|"u"ersi|:|n | S0L Ser-.fer| Authentication |"-.I'l.-"ehsite | ContactF| * | *

settings
Use Integrated Windows Suthentication

sername lsername

Passurord

Depending on the configuration of Microsoft Dynamics NAV and how it is accessed will determine what options are required.
For example if a different user account is used to access NAV than what is currently logged into the computer then they will
need to be manually entered.

SQL Server connection

If the Server Type has been configured as SQL Server then the connection details for the SQL Server needs to be entered.
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Ay Microsoft Dynamics NAV

Wersion | QL Server ‘.&uthenticatiun | Wiehbsite | ContactF 4 | ¢

settings

Server Mame
Database Mame

Server Address

nawserveryBAWDERO
Demo Database MAY (T-0)

havserser TI46/DynamicsMAWTI

The Server Name is the hostname of the SQL Server database, this should also contain any instance names if been used, for

example:

e navserver\NAVDEMO

This will connect to the NAVDEMO database instance on the server with the hostname of navserver. This correct value for this
can be found using the Microsoft Dynamics NAV Administration tool.

-

Microsoft Dynarmics Maw Server - [Console RootiMicrosoft Dynarmics MAY (LocaliDynamicsHAWT]
File Action Wiew ‘\Window Help

= | x2E HBE

| Console Root

The Database Name option is the name of the SQL Server database to connect to and can also be found using the Microsoft

4 i Microsoft Dynamics MAY (Local DynamicsNAYYD - (Running)
A DynarnicsNAVID

General

Credential Type:
Database Instance:
Database Mame:

Database Server

Mata Marhe Siwee

Dynamics NAV Administration tool.

Web server

The Website tab enables the web server details to be configured for the Microsoft Dynamics NAV Web client connection.

Mg Microsoft Dynamics NAV

| Wersion | S0L Server | Authentication | Wfebsite | ComtactF| 4 | ¢

Server Marme

Server Port

MY Mifebserver Details

[] Use HTTPS/S5EL ta connect

dynamicsnaviill

8080
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Enter the Server Name of the Microsoft Dynamics NAV web server and the Server Port to connect with, the default is 8080. If
the connection to the web server is using a secure HTTP connection then check the User HTTPS/SSL to connect option.
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7.7.7 Microsoft Internet Explorer

Overview

This describes the features that are available when integrating with Microsoft Internet Explorer.

Supported Versions

Version Supported
o @

v10 @1

v

@1

" Metro style not supported

Features

Integration with Microsoft Internet Explorer supports the features listed below:

e Screen pop

Screen pop

Microsoft Internet Explorer can be screen popped directly when an incoming call is received or an outgoing call is made and the
call detail information can then be used to embed into the URL. For example an inbound call is received from 7774441111 as
shown on the toaster. The plugin was configured to screen pop using the URL "http://www.google.co.uk/search?
g=%0OutsideNumber%" and this then replaced the placeholder %OutsideNumber% with the outside number - for incoming calls
this is the caller id.

- 0O
. feearch?g="T77444 Pt
E https://www.google.co.uk/searchq=7774441111 O ~ @ & Emmﬂﬂ - Google Search (I P
.- ~ IS - X
Google | 7774441111 KN = ED
7774441111 00:02
Web Maps Images Shopping Videos More « Search tools o] 7774441111
About 229 results (0 40 seconds)
F00% v Clear call

Settings

The configuration options for the plugin on the Settings tab allow the URL configuration options to be set.
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& Internet Explorer

Settings

Web Page

URL http:/fwww.google.co.uk/searchfq=%0utsic

Frame

Title

Cpen in new window

URL: This is the URL that will be popped. This can include any of the supported placeholders listed below.

Frame: The plugin can update a specific web frame with the configured URL, enter the name of the frame here.

Title: The plugin can update a web page that is currently open, enter the HTML title of the page here.

Open in new window: Enable this option to open a new Microsoft Internet Explorer window if there is not one open or if there

is one open the create a new tab for each pop.

Placeholders

The list of supported place holders are shown below. These should be enclosed in % chars in the URL configuration.

Detail

CalllD

OutsideNumber

ActualCLI

DDI

DDI4

DDIName
AccountCode
Extension
AgentID

Trunk
SpeedDialName
HuntGroup
HuntGroupName

Display

Description

This is a variable-length string of characters (0-9, @, #,*, P, F, or X) the
phone system assigns to each call. This ID serves as a reference
identifier so that multiple simultaneous calls can be tracked through the
system. The same ID is assigned to a call until the call is terminated,
even if the call transfers between devices. Maximum length is currently
seven characters.

The caller ID or dialed number.

The unformatted caller ID or dialed number received directly from the
PBX.

The inbound DDI/DID number.

The last 4 digits of the inbound DDI/DID number.

The DNIS associated with the DDI/DID number.

The last account code that was entered against the call.

The extension number associated with Phone Manager.

The agent id number associated with Phone Manager.

The outside trunk number that the call used.

The system speed dial name associated with the outside number.
The hunt group that the call came in on.

The name of the hunt group that the call came in on.

The DNIS or DDI/DID outside number associated with the trunk used for
the call (i.e. was is normally shown on the top line of the keyset display).
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TransferredFrom The number of the device the call was transferred from.
TransferredFromName The name of the device the call was transferred from.
LastRedirectionExtension The number of the last device that redirected (forwarded, deflected,

transferred, or recalled) the call, if applicable; otherwise, this is blank.

LastRedirectionExtensionName The name of the last device that redirected (forwarded, deflected,
transferred, or recalled) the call, if applicable; otherwise, this is blank.

TransferringExtension The number of the device that the call was transferred to the. This may
be blank if the transferred call is a conference call.

TransferringExtensionDescription The name of the device that the call was transferred to the. This may be
blank if the transferred call is a conference call.

ContactField1 The contact field 1 match for the matching contact record.
ContactField2 The contact field 2 match for the matching contact record.
ContactField3 The contact field 3 match for the matching contact record.
ContactField4 The contact field 4 match for the matching contact record.
ContactField5 The contact field 5 match for the matching contact record.
ContactField6 The contact field 6 match for the matching contact record.
ContactField7 The contact field 7 match for the matching contact record.
ContactField8 The contact field 8 match for the matching contact record.
ContactField9 The contact field 9 match for the matching contact record.
ContactField10 The contact field 10 match for the matching contact record.
CallRecorderRecID The call recording record ID that can be used to identify the specific

recording for this call.

CallRecorderServerlD The call recording server ID that the call was recorded on for this call.

DiallerCampaign The name of the Campaign Manager campaign if this is a dialer call.

DiallerField1 The Campaign Manager dialer field 1 for this campaign record if this is a
dialer call.

DiallerField2 The Campaign Manager dialer field 2 for this campaign record if this is a
dialer call.

DiallerField3 The Campaign Manager dialer field 3 for this campaign record if this is a
dialer call.

DiallerField4 The Campaign Manager dialer field 4 for this campaign record if this is a
dialer call.

DiallerField5 The Campaign Manager dialer field 5 for this campaign record if this is a
dialer call.

DiallerField6 The Campaign Manager dialer field 6 for this campaign record if this is a
dialer call.

DiallerField7 The Campaign Manager dialer field 7 for this campaign record if this is a
dialer call.

DiallerField8 The Campaign Manager dialer field 8 for this campaign record if this is a
dialer call.
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DiallerField9 The Campaign Manager dialer field 9 for this campaign record if this is a
dialer call.

DiallerField10 The Campaign Manager dialer field 10 for this campaign record if this is
a dialer call.

Page 146



User Guide

7.7.8 NetSuite CRM+

Overview

This describes the features that are available when integrating with NetSuite CRM+ hosted in the Cloud.

Supported Versions

The integration uses NetSuite v2014.1 web services. Although NetSuite tries to maintain backwards compatibility when they upgrade their
cloud platform this is never guaranteed. This version of the plugin has been tested on the latest version that was available upon release.

Features
Integration with NetSuite CRM+ supports the features listed below:

e Click to dial
e Screen pop for customer and contacts records
e Automatic call history entry

Click to dial

When a record is displayed any telephone numbers will be shown as hyperlinks and clicking the link will call the number selected.

"\ NETSUITE "RE

O * *ﬂ* Activities Payments BoxFiles Transactio

2 Contact Q
Paloma Salamanca MITEL

m Back % +'3 » Actions~¥

Primary Information

CONTACT COMMENTS
Paloma Salamanca

Email | Phone | Address

777 444-1111 HOME PHOMNE

See the Click to dial configuration section for details.

| @ This requires Phone Manager to be running in the same Windows session as NetSuite.

r_;f If the screen popping feature is also been used then this should only be configured for Inbound Calls, so as not to
screen pop on outbound.

Screen pop

CRM Contact and/or Customer records can be screen popped directly within CRM when an incoming call is received using the
caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching records that
have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs a
search to find any records that have matching telephone numbers. A matching Contact record was found and the record was
automatically displayed using the Users default browser.
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- @I ] L David Smit! -
[N NETSUITE Q Ji- @rer R~ Foneycomb Mg - Administrator
J—) * /ﬁ\ Activities Payments BoxFiles Transactions Lists Reports Documents

2 Contact Q -

Sarah Short MITEL
m Back % +'3 v Actions™

Primary Information

CONTACT COMMENTS CATEGORY

Sarah Shert

MR./MS... PRIVATE IMAGE

NAME

COMPANY

MITEL

JOBTITLE (8

+44 1291 430000 00:02
Email | Phone | Address
+44 1251 430000

EMAIL OFFICE PHONE ADDRESS

ALT. EMAIL

MOBILE PHONE
MAIN PHONE
+44 1251 430000 HOME PHONE Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct record to be

displayed. For example a call is made to 222555444 and this has found 2 matching Contact records and 1 matching Customer
record that have this telephone number.

Multiple Contacts Found = =
Results
'+ Contact: Elina Marie (ID=1648)

- Contact: Sergio Araya (ID=1649)
- Customer: MITEL (ID=1649)

+44 1291 430000 00:01

+44 1291 430000

Display

Clear call

The correct record can then be highlighted and then clicking on the Display button or double clicking the entry will open this record.

@‘ The plugin will only search for records that are in the Active state. If any records have been marked as In Active
then they will not be displayed.

Record and matching options

Configuration options are available on the plugin that allow the type of Records to be used in the searching to be set. For example it
can be configured so that only the Contact records are searched. These options are set on the Options tab.
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L\ NETSUITE

Settings | Account | Optiens | Activities

Screen Pop

Customers Contacts

Mew Record

Display blank record en no match

Type | Contact

W

If no match is found when searching than a blank form can be automatically displayed to create a new record. The record type,
Contact or Customer that is created can be set here.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a NetSuite Phone Call Activity entity. The record to
associate this with is found using the caller id received or the number dialed, and if multiple matches are found then the Multiple
Contacts Found window is shown as for the screen popping.

The Activity record is automatically created with the information relating to the call entered into the relevant fields.

Phone number
DDI/DID

DDI/DID Name
Direction

Account Code

Trunk

Transferring Extension

Duration

Call Recording

For inbound calls this is the caller ID and for outbound calls this is the dialed number.

For external inbound calls only, the DDI/DID number that the call came in on.

For external inbound calls only, the DNIS of the DDI/DID that the call came in on.

The direction of the call.

The account codes that was set on the call.

For external calls the outside network trunk number that the call was made or received on.
The device that the call was transferred from.

The duration of the call. The call event trigger must have been set to Call End as they are
known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call recording (this
not a clickable hyperlink but can be copied and pasted into a browser). The call event trigc
must have been set to at least Call Answered as the call recorder will only create the recol
id when the call has been answered.

The plugin configuration has several options that can be set to determine how the record is created.

L\ NETSUITE

Settings | Account | Options

Call Activity Record

Display activity record

Activities

Complete activity record

Edit activity record
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Display activity record: This will display the Activity form, if this is not set then the record will be created without the user seeing
the form.

Complete activity record: This will set the status of the Activity to be Completed.
Edit activity record: This will open the Activity record in edit mode.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow access to
Dynamics CRM.

Settings and versions

The supported version of NetSuite can be seen on the Settings tab.

L\ NETSUITE

Settings | Account | Options | Activities

Information

Version | petSuite CRIM+ 2014.1 v

Test...

Account details

The specific account details need to be set on the Account tab.

LM NETSUITE

Settings | Account | Options | Activities

Details
Account ID TSTORV1
Email maurice.abel@mitzl.com
F'assw Drd Ak kkEEEEEE
Role 3

Account ID: This is the NetSuite CRM Account ID. This can be found from the within NetSuite. From the Setup menu select
Integration -> Manage Integration -> Web Services Preferences .

Web Services Preferences

m Cancel Reset

I.L.CCDJNT D I

TSTDRV1

Email: The email account used to login to NetSuite for this user.

Password: The password used to access NetSuite for this user.
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Role: The role to use to connect to NetSuite for this user. This needs to be to the Internal ID of the specific role. To find the relevant
ID, set the Show Internal IDs preference and the internal ID can be found by going to Setup > Users/Roles > Manage Roles.

Authentication and profile details

The Profile tab enables the security credentials used to access Microsoft Dynamics CRM to be configured.
A4 Microsoft Dynamics CRM

Settings | Server | Profile | Qptions | Call Details | Activitie * | *

Details

[] Use Integrated Windows Authentication [[WA)
Using Office 365 Account to Login?

Username: nacho.valenciai@mitel.couk

Passwc.rd: SRR EEEN

Use Integrated Windows Authentication: If this is set then the username, password and domain details from user who is logged
on the computer will be used.

/. Using Integrated Windows Authentication is NOT supported when using IFD and claims based authentication.
Depending on the configuration of Microsoft Dynamics CRM and how it is accessed will determine what options are required.
NetSuite Configuration

Web services

The integration uses the NetSuite CRM Web Services for the screen pop and phone call activity features. The Web Services are
enabled from within NetSuite and can only be performed by a NetSuite Administrator.

Select Setup -> Company -> Enable Features. In the SuiteCloud tab, scroll down to the Suite Talk (Web Services) section and
enable the Web Services check box.

Each User that is connecting to NetSuite needs to have the Web Services permission set against their role. To assign the Web
Services permission to a role:

1. Select Setup -> Users/Roles -> Manage Roles.

2. Click either Edit or Customize next to the role.

3. From the Permissions tab select Setup.

4. Add the Web Services permission with the Full level.

Click to dial
To enable the click to dial feature from the telephony integration option needs to be enabled.

. Select Setup -> Company -> Enable Features.

. In the SuiteCloud tab, scroll down to the Integration (Add-ons) section
. Enable the Telephony Integration check box.

For each user, select Settings -> Set Preferences.

. Select the Telephony tab.

. Set the Telephony Option to be CTI.

. Enter "tel://{phone}" into the CT/ URL section.

N OAWN
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L NETSUITE 4 |»

d—) ) ¢ 'ﬁ‘* Activities Payments BoxFiles Transactions Lists Reporis

Set Preferences

m | Cancel | | Reset

General Appearance Transactions  Analytics Activities  Alerts Telephony

TELEPHOMY OPTIONM
CTI -

TAPI DEVICE

CTIURL
tel://{phone}

NDCCIY T MlAL AT
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7.7.9 Sage CRM

Overview

This describes the features that are available when integrating with Sage CRM.

Supported Versions

The following Sage CRM versions are supported.

»
c
k=]
°
o
=3
©
o

Version

v5.7 -v7.0

v7.1

v7.2

000

Editions

(72
[=
]
T
]
=X
(11
o

Sage CRM Professional Edition (Cloud)

Sage CRM On-Premise Edition

OO

Sage CRM Essentials Edition (Cloud)

Features
Integration with Sage CRM supports the features listed below:

e Screen pop for contacts

Screen pop

CRM Person, Company and/or Lead entities can be screen popped directly within CRM when an incoming call is received
using the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching
entities that have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin
performs a search to find any records that have matching telephone numbers. A matching Person entity was found and the
record was automatically displayed using the Users default browser.
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Person: Elina Marie Phone: 222 555
Sage CRM % Company: Mitel

Recent Summary Quicklook Marketng Motes Communications Opportunites Cases Addresses  Phone/E-mail  Self Servi ~
Main Menu Person
/ Change
Administration Last Name: First Name: Salutation:
A Marie Elina \3 ;
- Middle: Suffioe: Gender: \ e
[ -
\% Add to
e Title Code: Title: Department: @ Contacts
Territory: Website: Account Manager: Summary
Worldwide System Administrator Report
Opt out of E-marketing communications: =| Add this
New B &, [, record toa
Ll
E}’ Group
" Address » Phone/E-mail » @ iEL
My CRM Street: City: State: Business: 222 555 4434
5 il Mobile: 777444 1111
'%' Zip Code: Country:
Team CRM L
Company b
Company Name: Type: Status: 77?4441 1 1 1
Reports Mitel
Source: Region: Segment: 777
T
- e 177444111
Marketin ichea
q http: )
Territory:
x) Worldwide
Log Off
v
< >

00:02

Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct record to
be displayed. For example a call is made to 222555444 and this has found three matching Person entities that have this

telephone number.

Multiple Contacts Found

Results

[=-Persen: Mark Laird
. Company: Mitel
E| Person: Tomas Mendoza
- Company: Mitel
= Person: Aurora Rojas
" Company: Mitel

2225554444
2225554444

Display

00:01

©

Clear call

The correct Entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set. For
example it can be configured so that only the Person and Company Entities are searched. These options are set on the

Options tab.

Selecting the Search Related Entities option will enable any matching records that have a related entity to be displayed on

the Multiple Contacts Found window.
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Sage CRM

| Yersion | Authentication | FormaE| Options | Phone Field: * I L

Select the entities to search Person
Company

Lead

Search Related Entities

| @’ If no match is found then no records will be displayed.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Person, Company or Lead
Entities individually. By default the common telephone number fields are listed on the PhoneFields tab.

Sage CRM
Authentication | Formats | Options| Phone Fields | Call DelIlI‘

Select the telephone

numbers to search Person Fax
Person Home

Person Mobile
Company Business
Lead Person Phone
Lead Person Fax

These are the default field names and may be different if they have been customized. Contact your Sage CRM administrator for
details.

Contact Entities

Entity Type Field name Enabled?
Person Business Q
Person Fax @
Person Home Q
Person Mobile Q
Company Business Q
Lead Person Phone a
Lead Person Fax e
Lead Alternate Phone @
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Telephone number formats

Sage CRM does not provide a standard format for storing telephone numbers within the system by default. The plugin supports
searching for multiple different formats dependent on the region (UK or US) where the client is running. The default formats for
the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats
9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210

Sage CRM stores the country code and area code parts of each telephone number separately from the main number. From the
Formats tab the country and area codes can be set to be appended to the telephone number when a search is made.

Sage CRM

Authentication = Formats | Options | Phone Fields | CallDe * | *
Telephone Formats

Append Country Code
Append Area Code

For example if the number, 01611234567 is stored within Sage CRM as:

e Country Code: 44
e Area Code: 0161
e Number: 1234567

The following telephone numbers would be searched for:

If the Append Country Code and Append Area Code are not set: 1234567

e |If the Append Country Code is set and Append Area Code is not set: 441234567

If the Append Country Code is not set and Append Area Code is set: 01611234567
If both the Append Country Code and Append Area Code are set: 4401611234567

Call details

The call information that is used to search for matching records can be configured. By default the dialed number or the caller id
are used to search with, depending on the call direction, but other call details can configured. There are options for the direct
dial number or the direct dial name (or DNIS) as shown.
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Sage CRM

Formats | Options | Phone Fields | Call Details o

Information

Select the call details to Caller ID (CLI)

use for the search, Multi [ ] Direct Dial (DDI/DID)
select items to use more [ ] DMIS/DDI Mame
than one and re crder the
items in preference of
search order,

|‘§“-'|‘ Caller ID represents either the caller ID for inbound calls or the dialed number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check box next
to each one selected. The order of the searching can also be configured by dragging and dropping the entry and ordering the
list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.

Configuration

The integration needs to be configured for the correct version of Sage CRM that is running. From the Version tab select the
relevant entry from the drop down list.

Sage CRM

Version | Authentication | Formats | Options | Phone Fields * | *

Properties

Version Sage CRM v7.2 P w

Test

The authentication and server connection details to the CRM server need to be set on the Authentication tab.
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Sage CRM

Settings
Username |admin Password |7
Website
URL http SCEMServer/crm/eWare.dll/f
Service WebServices/SOAP

A valid Sage CRM username and password that has the web service option enabled is required to be configured into the
Username and Password fields. To enable a user for web services, from Sage CRM:

1. Select Administration -> Users -> Users
2. Select Change action button
3. In Security panel set Allow Web Service Access field to True

{g Only one web service user can logon with the same ID at any given time. If a user tries to logon as another
application, an error will be displayed informing the user that they should first log out. However, it is possible to
logon to the desktop or from a device with the same ID while a Web Service application is running.

The plugin uses the Sage CRM web services to integrate and this needs to be enabled on the Sage CRM server. This can be
enabled from within Sage CRM:

1. Select Administration -> System -> Web Services
2. Select Change action button
3. Check the enable web service option

The web service URL can then be configured into the URL section. For example if the server name is called mycrmserver then
enter:

e http://mycrmserver/crm/eWare.dll/

Troubleshooting

When integrating with Sage CRM v7.1+ the plugin uses the PhoneLink table within Sage CRM and this needs to be made
available through the Sage CRM web service. If this is not enabled this error will be shown in the log files:

System.Web.Services.Protocols.SoapHeaderException:
Request Failed. Entity 'phonelink' is not Web Service enabled.

To enable this follow this procedure:

. Log in to Sage CRM SQL Server
. Select Sage CRM database
. Click on the New Query button
Run:
o update Custom Tables set bord WebServiceTable=’'Y’ where Bord Caption =’phonelink®
. Run the IISRESET command
6. Login to the Sage CRM system.

AN~

[,
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7.7.10 SalesForce

Overview

This describes the features that are available when integrating with SalesForce.

Supported Versions

The following SalesForce versions are supported.

Edition Supported

Contact Manager
Group

Professional

@E
Enterprise @
Performance @

£ - Additional SalesForce fees may apply

Features
Integration with SalesForce supports the features listed below:

e Screen pop for contacts
e Automatic call history entry

Screen pop

CRM Contact, Account and/or Lead entities can be screen popped directly within SalesForce when an incoming call is received
using the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching
entities that have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin
performs a search to find any records that have matching telephone numbers. A matching Contact entity was found and the

record was automatically displayed using the Users default browser.

ﬁ)rce

Home | Accounts Cases Solutions | Reports | Dashboards | »

. WSetun-Develo r Console - Help - Logout ﬁr{e.(:?g‘f Call Center

Contact
Luka Pape
Search
Help for this Page 2
Ssarch Al v I :
E Opportunities [01 Cases[0] | Open Activities [0 Activity History [0] Campaign Histery [0]
[ Limitto items | own Motes & Attachments [0] HTML Email Status (01
Advanced Search... Contact Detail [ edit ] Delete J| clone J] Request Update |
Contact Owner  Maureen West [Change Phone  7774441111%
Create New... =
Name  Gary Fisher Home Phone
Account Hame  Mitel Mobile 2225554444 '
Recent Items Title Other Phone
Mark Laird Department Fax
David Smith Birthdate Email
Sun Shu Reports To  [View Org Charf Assistant
§ Alberto Puga Lead Source Asst. Phone
Mailing Other Address
5/ Shana Bouchard Address
Youssef Yount Languages Level
A Sergio Araya Created By  Gary Fisher, 25/07/2014 Last Modified Gary Fisher, 25/07/2014
¥ Br -
§ Gorka Santos 14:52 ¥ 14:52
) Description
&/ Mitel
& sales [ dit ] pelete [ clone J| Request update |

L
7774441111

7774441111

00:02

Clear call
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If multiple matches are found then the Multiple Contacts Found window is shown and enables the User to select the correct
record to be displayed. For example a call is made to 222555444 and this has found one matching Account entity and three
matching Contact entities that have this telephone number.

Multiple Contacts Found

- Account: Mitel

--Contact: Debarah Green

- Contact: Xu Zheng

.. Contact: Bastien Beaumont

2225554444 00:01
2225554444

©

Clear call

The correct entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set. For
example it can be configured so that only the Contact entities are searched. These options are set on the Options tab

ﬁrce

Profile

Screen Pop

Accounts Contacts Leads

Mew Entity
[] Display blank entity cn no match

Type | Contact W

If no match is found when searching for an Entity than a blank form can be automatically displayed to create a New Entity. The
Type of Entity, Contact, Account or Lead that is created can be set here.

Search fields

The range of telephone numbers that are to be searched are not configurable. All SalesForce fields that are have the phone
type will be used.
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Step 1. Choose the field type Step 1

Specify the type of information that the custom field will contain.

Data Type

@ None Selected Select one of the data types below.

O Auto Number A system-generated sequence number that uses a display format you define. The number iz autematically incremented for each
new record.

O Formula A read-only field that derives its value from a formula expression you define. The formula field is updated when any of the

=source fields change.

O Roll-Up Summary A read-only field that displays the sum, minimum, or maximum value of a field in a related list or the record count of all records
listed in a related list.

O Lookup Relationship Creates a relationship that links this object to another object. The relationship field allows users to click on a lockup icon to select
a value from a popup list. The other object is the source of the values in the list.

O Checkbox Allows users to select a True (checked) or Falze (unchecked) value.

O Currency Allows users to enter a dollar or other currency amount and automatically formats the field as a currency amount. This can be
uzeful if you export data to Excel or another spreadsheet.

O Date Allows users to enter a date or pick a date from a popup calendar.

O pateTime Allows users to enter a date and time, or pick a date from a popup calendar. When users click a date in the popup, that date and
the current time are entered into the Date/Time field.

) Email Allows users to enter an email address, which is validated to ensure proper format. If this field is specified for a contact or lead,
users can choose the address when clicking Send an Email. Note that custom email addresses cannot be used for mass emails.

O Geolocation (Beta) Allows users to define locations.

O Number Allows users to enter any number. Leading zeros are removed.

O Percent Allows users to enter a percentage number, for example, 10" and automatically adds the percent sign to the number.

O Phone Allows users to enter any phone number. Automatically formats it as a phone number. I

; ; Picklist ENovrs USers Io Select a valie jrom a it you derne.

) picklist (Multi-Select) Allows users to select multiple values from a list you define.

O Text Allows users to enter any combination of letters and numbers.

The format of the telephone number does not make any difference as any type of format is supported. The number
dialled/received is used for the searching.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a SalesForce Phone Task entity. The Entity to
associate this with is found using the caller id received or the number dialed, and if multiple matches are found then the Multiple
Contacts Found window is shown as for the screen popping. The telephone numbers used to search are set in the screen
popping section.

The Activity record is automatically created with the information relating to the call entered into the Comments field and the
related entities are linked as shown.
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Sa].e\Sf(‘)rce.C()m q Setup - Developer Console - Help - Logout JOrCe.COM | ot Gerter D
!EE Accounts | Contacts IZ-:a:';es Solutions | Reports | Dashboards ;

Recent Items
2/ Luka Pape

&/ Michael Graham

1 Candice Langlais
' Paloma Salamanca

Isa Sastre
Gary Fisher

' David Smith
Xu Fheng
Youssef Yount
Mite

o & .

B

B

B

X

o Task
8 Inbound call from 7774441111 Help for this Page 2
Search
Seach Al v Task e [Save [ Cancel |
| | co! |
[ Limitto items 1 own =
Advanced Search... Assigned | Dorian Geroux | Q) status | InProgress v
To
Create New v | subject |Inbound callfrom 77744< 5| Mame | Contact v |Craig Kenyon | &
DueDate  [25/07/2014 |[25/07/2014] Related | Opportunity v | |y
To
Phone 7774441111 Email

ooty [ Nom |
Description Information

Comments Start Time : 25/07/2014 15:31:08
End Time : 04/08/2014 15:31:08
Call Recording : hitp://mitelrecorder/default.aspx?recid=1574601

[]Send Netification Email

v

Phone number
DDI/DID

DDI/DID Name
Direction

Account Code

Trunk

Transferring Extension

Duration

Call Recording

For inbound calls this is the caller ID and for outbound calls this is the dialed number.
For external inbound calls only, the DDI/DID number that the call came in on.

For external inbound calls only, the DNIS of the DDI/DID that the call came in on.

The direction of the call.

The account codes that was set on the call.

For external calls the outside network trunk number that the call was made or receivec
The device that the call was transferred from.

The duration of the call. The call event trigger must have been set to Call End as they
not known until the call is cleared.

If integrating with a Xarios Call Recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a browsel
The call event trigger must have been set to at least Call Answered as the call recorde
only create the recording id when the call has been answered.

The plugin configuration has several options that can be set to determine how the record is created.
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H;ilcy%rce,u 08

Profile | Security | Options | Activities | Browser
Task Information (for call history records)

Status In Progress "

Pricrity Mormal W
Display activity record

[[] Use Start and End times only

Status: This allows the type of Status for the task to be configured. Valid options are: Not Started, In Progress, Completed,
Waiting on someone else, Deferred.

Priority: This will set the priority of the Task to be High, Normal or Low.
Display activity record: If this is set then the Task will be displayed when it's created in a new browser window.

Use Start and End times only: If this is set then only the start and end time will be populated into the Comments section for a
call history entry.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow
access to SalesForce.

User authentication

The plugin requires a valid SalesForce username and password to be entered. These are the details that will be used for
searching and creating history records. Ensure that the user has the appropriate permissions within SalesForce to do this. As a
minimum they need to have the API Enabled flag set on their Profile.

CollaborationFolder Products
Members
Contacts Solutions
Content Tasks
Contracts
Administrative Permissions
APl Enabled v Manage Mobile
Configurations
Asszign Permission Manage Package
Sets Licenses
Author Apex Manage Password
Policies
Bulk APl Hard Manage Profiles
Delete and Permission

Security

The Security tab enables the type of access and location of the Salesforce services to be set.
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H;ilcj%rce,u T

Profile | Security | Options | Activities | Browser

Server

URL https://nas.salesforce.com/

Token
[] Use security token

Security Token

Server -> URL: This should be set to SalesForce server that your organization uses. This can be found by looking at the URL
that is displayed in the address bar of the web browser once you have logged into SalesForce.

& & hitps//nadsalesforce.com/ 0

Token: Depending on the security configuration of SalesForce and how it is accessed will dictate what options are required. To
connect to the SalesForce API requires that the public IP address that the user is connecting from is configured in the
Administration Setup -> Network Access section under Trusted IP Ranges.

Network Access Help for this Page 2

Quick Find

Expand All | Collapse All
The list below contains IP address ranges from sources that your organization trusts. Users logging in to salesforce.com
with a browser from trusted networks are allowed to access salesforce.com without having to activate their computers.
Force.com Home

Trusted IP Ranges Q
I e Action  Start IP Address ~ End IP Address Description
Personal Setup Edit | Del 78.158.57.34 78.158.57 46
My Personal Information Edit | Del 78.158.57.46 78.158.57.46
Email
Import

Desktop Integration
Call Center Settings

Administration Setup

Manage Users

Manage Apps

Company Profile

B2 Security Controls
Sharing Settings
Field Accessibility
Password Policies

o z oz

Network Access

If this cannot be configured, for example if you have remote workers whose IP address changes all the time. Then the Security
Token option will need to be enabled.

To create a Security Token from the Personal Setup -> My Personal Information- > Reset My Security Token section of
Salesforce.com, select the Reset Security Token button. This will send an email to the associated user with their Security
Token.
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Reset Security Token Help for this Page

| Quick Find Q|

Expand All | Collapse All

1Y Clicking the button below invalidates your existing token. After resetting your token, you will have to use the

new token in all APl applications.
Force.com Home e

System Overview . . )
When accessing salesforce.com from outside of your company's trusted networks, you must add a security token to your

password to log in to the APl or a deskiop client such as Connect for Outlook, Connect Offline, Connect for Office, Connect
Personal Setup for Lotus Motes, orthe Data Loader.

= My Personal Information

_ 6 Your security token is tied to your password and subjectto any password policies your administrators have
Persaonal Information

configured. Whenever your password is reset, your security token is also reset.

Change My Password
Reset My Security Token For security reasons, your security token is delivered to the email address associated with your account. To reset and
send your security token, click the button below.

My Groups

Change My Display

Grant Login Access y
Calendar Sharing

The email will contain the token and will look similar to the one shown below:
e y67IBpMdiBY02RkbDWqwhCEX

This value then needs to be entered into the Security Token section.
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7.7.11 SalesLogix

Overview

This describes the features that are available when integrating with SalesLogix.

Supported Versions

The following SalesLogix versions are supported.

Version Supported

Version 7.0 @*"

Version 7.1 A

v
Version 7.2 @A
v

A

Version 7.5 SP2

* - Click to dial feature is not supported
A - Requires the Windows LAN client

Features
Integration with SalesLogix supports the features listed below:

e Click to dial

e Screen pop

e Automatic call history entry

e Calendar & DND synchronization

Click to dial

When a record is displayed a new telephone icon is shown on the toolbar and a Dial Phone entry in added to the SalesLogix Tools
menu.

+/ Sage SalesLogix - [Contact: Maurice] Z E|r5__<|

@File Edit  Wiew Insert Schedule Lookup ‘Write i i -8 x

@@ EHeBw B & )

D ashboards L - v E
Contacts ®- I Activity Reminder ... M Latest Contacts = =

Sl Contact: ||.'|r. Maurice Abel Literature Fulfilment. .. 41111 Frirnany Contact
Fgn Aecount: [Mitel Processes » 54444 .-.ﬁ\uthc.lri_zed Sery
When the telephone icon is clicked a new window is displayed that shows all of the telephone numbers that are available for this

record.

Page 166



User Guide

E Type Phone Humber

tobile 2225554444 S

o) =

Closz || Dial

Selecting any of the rows and clicking Dial or double clicking the row will cause the selected number to be called.

gf This requires Phone Manager to be running in the same Windows session as SalesLogix.

g If the screen popping feature is also been used then this should only be configured for Inbound Calls, so as not to
screen pop on outbound.

/. This direct dial out replaces the built in TAPI based “Dialer” feature within SalesLogix and should not be used at the
same time.

/. The SalesLogix bundle is available on request and needs to be installed by your SalesLogix administrator (see
the SaleslLogix Bundle section for details)

Screen pop

CRM Contact, Account and/or Lead entities can be screen popped directly within SalesLogix when an incoming call is received using
the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching entities that
have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs a search to
find any records that have matching telephone numbers. A matching Contact entity was found and the record was automatically
displayed with SalesLogix.

+' Sage SalesLogix - [Contact: Phil ]
@File Edit View Insert Schedule Lookup ‘Write Tools Intelisync  Window Help E

@@l BMdd I Yes imygs

Dashboards » M Lookup Results ¥ EY

sdes )| contact: (. Phit Taytor || work: 7714441711 Primary Contact f
@ Account [Mitel || Mobile: [227) 565-4444 L Authorized Servic
1

Contacts ®.

Preferred Contact:  —
Title: | Fax:

. [ 1 v
Dashboard | Asst | Home l:l [] Do Nat Solicit
o o [ Nthar [ ENSVIRCRI. 4
g |¢ | >
ACCounts Drrag a tab here to display a view 7774441111 00:02
@ | Mare Tabs... | Mates/Histary | Activities | Literature Requests | Attachments | Lead Sources | Oppartunities | Processss | 4 * 7774441111
Contac¥ | Bithday: | (3| | Pager | | || contactiD: e
Marketing ] Spouse: ‘ | E-Mail 2: | | Import Sour
Sewice ||| Childien: | | | EMalz | | | Creaelse
Support ] < | >
X "y T Cear call
28 July 2014 10:34 Adrinistrator SALESLOGL:_EVAL ¢! @ Bl

If multiple matches are found then the Multiple Contacts Found window is shown and enables the User to select the correct record to
be displayed. For example a call is made to 222555444 and this has found three matching Contact entities that have this telephone
number.
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L Multiple Contacts Found

Account=Mitel Contact=Neville
Account=Mite| Contact=Aurcra Rojas
Account=Mitel Contact=Paloma Salamanca

2225554444
2225554444

Display

Clear call

The correct entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of records to be used in the searching to be set. For example it can
be configured so that only the Contact entities are searched. These options are set on the Options tab.

saleslog'x

Settings | Profile | Server | Options | Account Fields | Con * | *

Screen Pop

Accounts Contacts || Leads

Display
Uze Existing View

Display Mode | Default v

When SalesLogix is screen popped the display mode for how any matching records are shown can be configured as shown.
Display
Use Existing View

Display Mode | Default v

Details

List

Split

Previous

Selecting the Use Existing View option will use the current view settings. These settings are equivalent to the options available in the
View menu within SalesLogix.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or Lead records
individually. By default the common telephone number fields are listed in the Leads Fields, Contacts Fields or Account Fields tab.
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Select the CRM

account telephone
numbers to search

Contact Entities

Field name

Work
Mobile

Fax

Home
Other
Pager

User Field 1
User Field 2
User Field 3
User Field 4
User Field 5
User Field 6
User Field 7
User Field 8
User Field 9

User Field 10

Account Entities
Field name
Main
Alternate

Fax

Toll Free

Main

Alternate
Fax

Toll Free

Toll Free 2
COther Phone 1
Other Phone 2

m
3
o
g
@
o
N)

3 3l Xl X x Tl ) XY X x M XHH
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Toll Free 2
Other Phone 1
Other Phone 2
Other Phone 3
User Field 1
User Field 2
User Field 3
User Field 4
User Field 5
User Field 6
User Field 7
User Field 8
User Field 9
User Field 10

Lead Entities

Field name Enabled?
Work @
Home @
Mobile V)
Fax
Toll Free @
User Field 1
User Field 2
User Field 3
User Field 4
User Field 5
User Field 6
User Field 7
User Field 8
User Field 9
User Field 10
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Telephone number formats

SalesLogix does not provide a standard format for storing telephone numbers within the system by default. The plugin supports
searching for multiple different formats dependent on the region (UK or US) where the client is running. The default formats for the UK
and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats
9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a SalesLogix Phone Call activity. The record to associate
this with is found using the caller id received or the number dialed, and if multiple matches are found then the Multiple Contacts Found
window is shown as for the screen popping. The telephone numbers used to search are set in the screen popping section.

The activity record is automatically created with the information relating to the call entered into the Notes field and the related records
are linked as shown.

Complete Phone Call For Nacho Valencia rg|
Completed: | 26/07/2014 11:05 ] Scheduled: | 28/07/2014 11:05 ]
Ciuration: |EU “ | | rirbes “ | [ Timeless

Uzers Rezources
Rezult: | L_...]|
Follow-Up [ 150 Meeting... ] [Q. Phone Eall...l [ ToDo... ] [+] Cary Over Motes
Contact: | Sastre, [sa | Opporturity: | |
Arcount: | Mitel | Ticket: | |
Regarding | Inbound call from 2225554444 w]
Notes Start Time : 28/07/2014 11:05:50
End Tirme ; 28/08/2014 12:05:50
Result:
Q Call Recording : hitp://mitelrecarder/default.as pxireciD=123456

Friority: | ) | Categony: | (W |
Leader: |F'ru:u:ess M anager | Scheduled by Adminiztrator on 28407 /2014 11:0%:52

[ 0k l [ Cancel ] ’ Help ]

Start Time The date and time when the call was started.

End Time The date and time when the call was ended.

Result The account code entered on the call.
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Call Recording If integrating with a Xarios Call Recorder then this can contain a URL link to the call recording
is not a clickable hyperlink but can be copied and pasted into a browser). The call event trigge
must have been set to at least Call Answered as the call recorder will only create the recordin
when the call has been answered.

Calendar & DND synchronization

The calendar within SalesLogix can be synchronized with the DND status of the extension of the User. For example when there is a
meeting in the calendar and this is due the extension can be automatically placed into DND with the DND text set to the Regarding
field of the appointment. When the appointment ends, the extension will be automatically removed from DND.

For example the Meeting entry below will place the Users extension into DND between 09:00 and 16.30 with the DND text set to "Sales

meeting".

+ | Sage Saleslogix - [Calendar] |Z||E|rg|
%File Edit ‘Wiew Insert Schedule Lookup Write Tools  Intelisync  Window  Help - ax
@ - @ B &t T ros L o W 9 %

Dashboards | Calendar: 28 July 2014 Administrator
Day | Waek tonth ear Toda""
T

July 2014 28 July 2014

Mon Tue wed Thu Fri

Leads 1 2 3 4
e 8 89 10N
~ 14 15 16 17 18

A2 3 oM B
a tupiti
pportunities R

=
o= [IToday: 28/07/2014
Activities ContactAccount Reqgardin
m 12 E
12
Calendar 1 3

%" 14

(Fiiorg 5
Support < I 2|1 b

28 July 2014 11:13 adrinistratar SALESLOGTN_EVAL P &) 0n
Configuration
For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow access to
SalesLogix.
Wizard

The Settings tab provides a Quick Setup Wizard to enable these to be easily configured.
saleslog'x

i| Profile | Server Options | Account Fields | Con| ¥ | ¥

Information

Version | SalesLogix 7.0-7.5 SP2 w

Configuration

Cuick setup wizard Setup

Click to test your settings Test

Click on the Setup button to start the wizard.
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Quick Setup Wizard 4
Settings
UUsername || |
Password
SLX Server Mame | SalesLogixServer
Database Name Select database.. W
Part Mumber 1706
Cancel Detect Save

Ensure that SalesLogix is open and then click on Detect and this will complete the form automatically.

Quick Setup Wizard g
Settings
Username admin
Pas=zword
SLX Server Mame  |SALESLOGIH
Database Name Select database.. W
Part Mumber 1706
Cancel Detect Save

Select the Database Name for the SalesLogix database to use and then click Save. From the Settings tab click on the Test button to
validate the details and a confirmation message will be displayed if the configuration is successful.

Swiftpage (Sage]) Saleslogix

1 ) Wou are running SalesLogix version 7.2.0.1501 with 1020 account records

If this fails then more options can be configured on the other tabs.

Authentication profile

The Profile tab enables the security credentials used to access SalesLogix to be configured.
saleslog'x

Settings | Profile | Server | Options | Account Fields | Con) * | *
Details
[ ] Use Integrated Windows Authentication [[WA)

Username: |adrr1|r1|

Password:

Use Integrated Windows Authentication: If this is set then the username, password and domain details from user who is logged on
the computer will be used.
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Depending on the configuration of Sage SalesLogix and how it is accessed will dictate what options are required. For example if a
different user account is used to access SalesLogix than what is currently logged into the computer then they will need to be manually
entered.

Server details

The Server tab enables the server details and database that is to be used to be configured.

saleslog'x

Settings | Profile | Server | Options | Account Fields | Con) * | *

SalesLogix
SLX Server Mame SalesLogixServer
Database Mame Select database..

[] Use advanced settings

SLX Server Name: The server name or IP address of the computer hosting the SalesLogix database.
Database Name: The name of the SalesLogix database to use.
Advanced Settings: Enables the Advanced and Extended tabs for extra configuration options.

Advanced options

The Advanced and Extended tab enables more advanced options to be configured.

| ['"E| These options are not normally required to be changed, contact your SalesLogix administrator for details.

saleslog!x

Contact Fields | Lead Fields | Advanced | Btended 1t
Advanced Settings

Cennect Timeout |0 Locale Identifier |0
Location Mode ReadWrite

Persist Security Info | True
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saleslog'x

Contact Fields

Lead Fields

Extended Settings

Port Mumber

1708 DBIDs

RO/RW Password

Server Certifcate

Enable Logging

Sales Logix Bundle

Advanced | Extended I

1

Case Insensitive Find

SalesLogix allows for 3rd party integration components to be installed into the SalesLogix environment to provide additional features.
To install the SalesLogix bundle the following steps need to be performed.

1. Run the SalesLogix Administrator Program.
2. Click the Bundles button.
3. Click the Install button.

4. Locate and select the Phone Manager Bundle.

&M 21BAE G s owd 2
= Bundle Manager
Users
T MHame Wersig
BaME |G alesLogis v7.0 5P 1'web  [7.0.1
Salezlogix w7 .0'Web .00
% SalesLogis v7.0eb Phone |7.0.0
Libramy
= om
-—é_—.l
Systems
Bundles
|
28 July 201412221

Open

Look in: |@ Desktop v| Q & [E-
iy E]My Docurnents
i 2} tgl My Computer
My Recent
Documents |i] Phone
Desktop
o
ty Documents
My Computer
File name: |F'h0ne Manager. s=b hd | [ Open l
My Metwork  Files of type: | SalesLogix Bundle [*.sxb) v | ’ Cancel ]

5. Click OK on the Choose Actions To Install window.
6. If prompted select to allow the plugin to be released and select the group to release to.
7. The Phone Manager Bundle should then be displayed in the list.
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fi SalesLogix Administrator - [Bundle Manager] A
@ File Edit “iew Insert Manage Tools ‘window Help -8 x

S0 TBERLAE R &GN G S

R Bundle Manager

sers .
_ TR ) L5 ¢ 3 '

Install  Upagrade rinztall Defuze  Unlock Fropertiez

Teams MHame “erzion | Modified Description _ _
Phore b anager 4.0.0 28/07/201411:58 |Phone Manager 5 alesLogis .Met Estension
Salezlogi vy 05P 1 wWeb |7.01 MA22006 15:32 | Saleslogix wieb «7 0 Service Pack 1

% SalesLogix v/ .0Web F.0.0 13072006 12202 [SalesLogis Web for 7.0
SalesLogix v7.0eb Phone | 7.0.0 2640172006 10:17  [SalesLogix Web Phone for «7.0

Librany

8. Close SalesLogix Administrator Program.
9. Installation is complete, open SalesLogix.

Page 176



User Guide

7.7.12 SugarCRM

Overview

This describes the features that are available when integrating with SugarCRM.

Supported Versions

Version

V6.4 -v7.6 @

On-premise deployment Cloud

@

@‘ The integration uses SugarCRM Web Services v4.1. Although SugarCRM ftries to maintain backwards compatibility
when they upgrade their cloud platform this is never guaranteed. This version of the plugin has been tested on the
latest version that was available upon release.

Features

Integration with SugarCRM supports the features listed below:

e Screen pop for account, customer and lead records

e Automatic call activity entry

Screen pop

CRM Account,Contact and/or Lead records can be screen popped directly within CRM when an incoming call is received using
the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching records
that have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs
a search to find any records that have matching telephone numbers. A matching Contact record was found and the record was
automatically displayed using the Users default browser.

¥ sSucAR

Sales Marketing Support

Home | Calendar

Recently Viewed:

Collaboration All
Meetings | Emails | Tasks Contads|

P
Welcome, Admin

Actions: fE| Create Contact | §E| Create Contact From vCard | =] View Contacts Import Contacts

Note: To send record assignment notifications, an SMTP server must be configured in Email Seftings.

Milo Joubert

Edit | =

=+| Create

# Overview
Mame: Milo Joubert B
Title:
Department:
Account Name:  Mitel

Primary Address:

Email Address: -none-

Description:
<

Office Phone: 7774441111
Mobile:
Fax:

Other Address:

>

.

1774441111
7774441111

00:02

Clear call

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct record to be
displayed. For example a call is made to 222555444 and this has found 2 matching Contact records and 1 matching Account

record that have this telephone number.
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Multiple Contacts Found

o~ Account: Mitel
-~ Contact: Nacho Valencia
- Contact: Bastien Beaumont

2225554444 00:01
2225554444

Display

Clear call

The correct record can then be highlighted and then clicking on the Display button or double clicking the entry will open this
record.

|‘§“-'|‘ The plugin will only search for records that have not been Deleted. If any records have been marked as Deleted
then they will not be displayed.
Record and matching options

Configuration options are available on the plugin that allow the type of Records to be used in the searching to be set. For
example it can be configured so that only the Contact records are searched. These options are set on the Options tab.

Settings | Profile | Options | Call Details | Activities | Accol * | ¥

Screen Pop

Accounts Contacts Leads

Mew Entity
Display blank entity cn no match

Type | Contact W
If no match is found when searching than a blank form can be automatically displayed to create a new record. The record type,
Account, Contact or Customer that is created can be set here.

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or Lead
records individually. By default the common telephone number fields are listed on the Leads Fields, Contacts Fields or Account

Fields tab.

Page 178



User Guide

Activities | Account Fields | Contact Fields | Lead Fields 1

Select the CRM Main Phone
account telephone Other Phone
numbers to search Fax

These are the default field name and descriptions and may be different if they have been customized. Contact your Microsoft
Dynamics CRM administrator for details.

Contact Records

Field name Field description Enabled?
Business Phone phone_work @
Home Phone phone_home @
Other Phone phone_other @
Fax phone_fax @
Mobile Telephone phone_mobile @
Assistant phone assistant_phone @

Account Records

Field name Field description Enabled?
Main Phone phone_office @
Other Phone phone_alternate @

Fax phone_fax @

Lead Records

Field name Field description Enabled?
Business Phone phone_work @
Home Phone phone_home @
Other Phone phone_other @
Fax phone_fax @
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Mobile Telephone phone_mobile @

Assistant phone assistant_phone @

Telephone number formats

SugarCRM does not provide a standard format for storing telephone numbers within the system by default. The plugin supports
searching for multiple different formats dependent on the region (UK or US) where the client is running. The default formats for
the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1(987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

Call details

The call information that is used to search for matching records can be configured. By default the dialed number or the caller id
are used to search with, depending on the call direction, but other call details can configured. There are options for the direct

dial number or the direct dial name (or DNIS) as shown.

Information

Selectthe call detailsto |[¥] Caller ID (CLI)

use for the search, Multi [ Direct Dial (DDI/DID)
select items to use more [ DMIS/DDI Mame
than one and re order the
items in preference of
search order,

I‘él Caller ID represents either the caller ID for inbound calls or the dialled number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check box next
to each one selected. The order of the searching can also be configured by dragging and dropping the entry and ordering the

list accordingly.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a SugarCRM Call Activity. The record to associate
this with is found using the caller id received or the number dialled, and if multiple matches are found then the Multiple Contacts

Found window is shown as for the screen popping.
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The Activity record is automatically created with the information relating to the call entered into the relevant fields.

For inbound calls this is the caller ID and for outbound calls this is the dialled
Phone number

number.
DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.
For external inbound calls only, the DNIS of the DDI/DID that the call came in
DDI/DID Name
on.
. . The direction of the call.
Direction

The account codes that was set on the call.
Account Code

For external calls the outside network trunk number that the call was made or

Trunk .
received on.

. . The device that the call was transferred from.
Transferring Extension

The duration of the call. The call event trigger must have been set to Call End

Duration . .
as they are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a

Call Recording browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The plugin configuration has several options that can be set to determine how the record is created.

Settings | Profile | Options | Call Details | Activities | Accoy 4 | ¢

Call Activity Record

Display Activity Record

Display activity record: This will display the Activity form, if this is not set then the record will be created without the user
seeing the form.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow
access to Dynamics CRM.

Settings and versions

The supported version of SugarCRM can be seen on the Settings tab.
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N SUGAR

Settings | Profile | Options | Call Details | Activities | Accoy * | *

Information

Version | Sugar 6.4-7.1 W

Profile details

The specific account details that will be used to connect to SugarCRM need to be set on the Profile tab.

N SUGAR
Settings 1 ECh::-tiu:rns Call Details | Activities | Accol * | ¥
Website
URL http://mysugarcrmserver
Dretails

Username  |username

Paszword sasee

URL: This is the URL to the SugarCRM server.
Username: The username of the account used to login to SugarCRM for this user.
Password: The password used to access SugarCRM for this user.
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7.7.13 Swiftpage Act!

Overview

This describes the features that are available when integrating with Swift Page Act!.

Supported Versions

The following Act! versions are supported.

Version Supported

v15 (2013) @
v16 (2014) @
v17 (2015) @
v18 (2016) @

Features
Integration with Act! supports the features listed below:

e Click to dial

e Screen pop for contacts

e Automatic call history entry

e Calendar & DND synchronization

Click to dial

When a Contact record is displayed a new telephone icon is shown on the toolbar.

% Sage ACT! Pro - ACT2013Demo
File Edit View Lookup Contacts Schedule Write Reports Tools  Help

Sage ACT! Q . &g .

Forward ‘ Mew

Back
Contacts « || £ Detail view| &1 List view 14 IR Y
Lookup =1 |acTDemo % 43 &

Contains:

Contact Field:

Phone Im_
H TeChONE Muobile IM_

__| re— 1 |

When the telephone icon is clicked a new window is displayed that shows all of the telephone numbers that are available for

this contact.
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D ¥ Record call history Close [[ Dial | L

[TTme [FESTN [FEgaramy & I [IIIT—E

Selecting any of the rows and clicking Dial or double clicking the row will cause the selected number to be called.
|‘E'-T This requires Phone Manager to be running in the same Windows session as Act!.

When an outbound call is made using this method a call history record can be created and opened once the Dial command has
been selected. To enable this select the Record call history option on the form.

|‘§'-‘f If the screen popping feature is also been used then this should only be configured for Inbound Calls, so as not
to screen pop on outbound.

/= This direct dial out replaces the built in TAPI based “Dialer” feature within Act! and should not be used at the
same time. To disable the built in “Dialer” feature, from the menu bar select Tools -> Preferences ->
Communication -> Dialer Preferences and un check the Use dialer option.

Screen pop for contacts

The Act! contacts can be screen popped directly within Act! when an incoming call is received using the caller id or from an
outgoing call using the dialed number. The telephone number is then used to find any matching contacts that have this number.
For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs a search on the
contacts to find any records that have matching telephone numbers. A match was found and the contact record was
automatically displayed.
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% Sage ACT! Pro - ACT2013Demo _ =10l x|
File FEdit View Lookup Contacts Schedule Write Reports Tools Help - S i,
Sage ACT! Back Forward [ New call Mtilg o ﬂl
Contacts « |[ £ petail view] £7 List view 1of1 Bz e & D@
Lookup = ITCTDE'T'O ;I a2 % @
Contact Field:

. Phone W_l E‘;
‘:Cunlad dlll mcu TeChONE Mobile I{Z’Z‘Z}M _I

""""" Contact | Amy Dawson _I Fax I _I
ﬁ Wel Salutation | Amy E-mail I
@ Connections Company _I Web Site I

a Contacts Key Contact [

{E Groups Title [ = Address |—_

[1; Companies Department | B I—

& [

e d " o2l 7774441111 o002
jiasinbish Documentsl Web Info I Sodal Updates I Contact Aoceml User Heldsl Personal Info | 7774441111

Opportunities Marketing R.esultsl

Notes | History I Activities I Opportunities I Groups/Companies I Secondary Contacts | Relationships I

Reports Dates: (all Dates VI o, Select Users [}/ Options -
E1G 2 ||[Dae [ Time [Regarding (=]

Lookup: All Contacts rotes: 0 |chris Huffman . Clear call

If multiple matches are found then the current Act! view be filtered down for the relevant matches. For example a call is made to
222555444 and this has found three contacts that have this telephone number.

“** Sage ACT! Pro - ACT2013Demo Tl - 0] x|
File Edit View Lookup Contacts Schedule Write Reports Tools Help -. ; e : fe
7 HE= >
Sage ACT) Q. . Searcs o
g Back Forward | New Call Meeting = _I
Contacts « | & Detail view| £ List View| 14 il 30f3 I (M & &R B =
Lookup | I’ Edit Mode !I_ TagMode TagAll Untag All | Lookup Selected  Omit Selected Options =
Contact Field: B |8 [Company | Contact | Phone | Mobile Phone | Extensid
ICnrrtact ﬂ Jorge Rossi (222) hhb-4444
_IL| Carl Pedrosa (77)744-81111  (222) 555-4444
IE— | B Walentino Lorenzo '
i3 Welcome

If no matches are found then there is a setting on the Options tab to enable a new Contact record to be created. The Phone
field is set to the number received and this Contact is then displayed.

act!

Version I Fields I Activiies Options |

View
¥ Show Private Activties W Include Recurrences
W Show All Day Events (with Banner)

¥ Create new Contact on no match

Contact fields

The range of telephone numbers that are to be searched for can be configured. By default the common telephone number
fields are pre selected.
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Act! Description Act! Field Name Enabled?
Business Phone  BUSINESS PHONE

Mobile Phone MOBILE_PHONE

Alternate Phone  ALTERNATE_PHONE

Fax Phone FAX_PHONE
Home Phone HOME_PHONE
Pager Phone PAGER_PHONE

00000

Automatic call history entry

Phone Manager can work with the History within Act! and can have Call entries automatically created for calls made or received
by the User when a match has been found to an entry in their Act! contacts. The contact to associate with this is found using
the caller id received or dialed number.

The body of the call entry is populated with the information shown.

H e

CEO x|
¢ Type: ICaII VI Result: ICaII Completed j :
" Contact: | Santos, Gorka [A1 Madrid]; Yount, Youssef [CH Mitel] ;l Contact... |

Date: |22.-'[II.7;'2[II'I4 vI Time: I‘I‘];,’}E vI B metin: Iﬂ.minute ,.I

_ Aftachment: I Attach W | 1
" Share With: | _| -
Record Manager: ITDn[f Leroy VI

" Regarding: | Answered =l |
Details:

& & %IMiUDsnﬁSansSerif j 8 -A-B JT UF E

Phaone number: 111222333
il |DDI: |
- |DDI Name:
; |Direction: Outbound
L J|Account Code: [
Trunk: 94309
_ |Transfeming Extension: I
Call Recording: hito:/mitelrecorder/default azpx Precid=1572822 =
! :
I
| - n
t r
- [ Private Follow-up... | oK Cancel | ;
1
g A
IT C
Phone number For inbound calls this is the caller ID and for outbound calls this is the dialed number.
DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.
DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in on.
Direction The direction of the call.
Account Code The account codes that was set on the call.
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Trunk For external calls the outside network trunk number that the call was made or receivec
Transferring Extension The device that the call was transferred from.
Duration The duration of the call. The call event trigger must have been set to Call End as they

not known until the call is cleared.

Call Recording If integrating with a Xarios Call Recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a browsel
The call event trigger must have been set to at least Call Answered as the call recorde
only create the recording id when the call has been answered.

Calendar & DND synchronization

The calendar within Act! can be synchronized with the DND status of the extension of the User. For example when there is an
appointment in the calendar and this is due the extension can be automatically placed into DND with the DND text set to the
Regarding field of the appointment. When the appointment ends, the extension will be automatically removed from DND.

For example the Scheduled Activity entry below will place the Users extension into DND between 09:00 and 13.30 with the
DND text set to "Sales Meeting".

Ml schedule Activity x|

Options -
= General | Details I Recumence I
Activity Type: Start Date: Start Time: Duration:
IMeeting j IEZ-'D?;'EDM j IE'EI':ﬂ'D ;l |4 hours 30 minj
7 End Date: End Time:
|22072014 =] [13:30 ~| I Use Banner
|
Schedule \With: 1
|Tony, Marcel [CH TechONE]; Scoti, Marco [CH TechONE] ;| Contactz w -
E [T Send invitation e-mail
n Associate With:
[cH TechonE [cme] _|
Regarding:

nales Meeting ;I

Priarity: Colour: Ring Alarm:

i ILuw "I ._I INu:uaIarm j Schedule For... |
_ [ Private ok | Cancel |

T A 00T

There are options to be able to select the type of Activities that trigger the DND change and these are configured on the
Activities tab.
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act!

Version I Fields Activities |D|:|1J'uns I

—Status
Select the Act Call
activity types to Meeting
include To-do

= nal Activity
Vacation

The Options tab has settings to control if private activities, recurring activities and all day events will be acted upon.

act!

Version | Fields | Activities Options |

—Wiew
W Show Private Activties ¥ Include Recurrences
¥ Show &ll Day Events (with Banner)

—Display
W Create new Contact on no match

Configuration

The integration needs to be configured for the correct version of Act! that is running. From the Version tab select the relevant
entry from the drop down list.

act!

Version |Fields I Acti'u'itiesl Options I

Properties

Select Version

lntialiseActl

Once this has been selected the plugin needs to be initialized with the Act! application. This is performed by clicking on the
Initialize Act button.

I‘él Act! will need to be closed before this can be done.

The plugin uses the Act! plugin framework and when you click /nitialize Act the required files are copied into the Act! plugin
folder. If this is not successful then the current user may not have the permissions to be able to copy files to this location. By
default this is:

C:\Program Files\ACT\Act for Windows\Plugins
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7.7.14 TigerPaw

Overview

This describes the features that are available when integrating with TigerPaw.

Supported Versions

Version Supported

14.1.20 @
15.2.02 @

Features
Integration with TigerPaw supports the features listed below:

e Screen pop for accounts
e Automatic call history entry
e Calendar & DND synchronization

Screen pop

Account records can be screen popped directly within TigerPaw when an incoming call is received using the caller id or from an
outgoing call using the dialed number. The telephone number is then used to find any matching Accounts or Contacts that have
this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs a search
to find any records that have this telephone number. A matching Contact entity was found and the associated Account record
was automatically displayed within TigerPaw.

[

Bg Tigerpa [N S0L2014; Tigerpaw]
File Edit Wiew Tools Tasks Accounts

G P | 8- | c
4 search /V& MITEL X I/‘E]

= MITEL

[ O]

uT

.]ﬂ Liser Forum

General Infarmation Phone Mumbers

M arne: |Mite| J Phone Eut. k 7
2w [222) 555-4444 —
Address 1: Il
e | @J L [777] 4441111
Add 2 4
ess2 | 7774441111 oo:02
City, State: | | j
Zip, Country: | |LIS.& ﬂ 774
Prirmary Rep: == |TDrT|aS j i T p
Surmrmary
Journal entries Open guotes ] -
Felated accounts Open opporturities Pa
Open Invoices Open projects i - Clear call

If multiple matches are found then the Multiple Matches window is shown and enables the User to select the correct record to
be displayed. For example a call is made to 222555444 and this has found three matching records, an Account, and 2 Contacts
that have this telephone number.
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' tate: l l v Lieated |11/2bi2l14
1 28 Multiple Matches for Phane Mumber (222) 555-4444 ==

M | AccountM ame Contact Mame 0
iyl [

J Mitel Gorka Santos =
E Mitel Zhao Ping

I

n I
b

i |
|
]

The correct record can then be highlighted and then clicking on the Display button will open this associated Account record.

1 Even though the telephone numbers for a Contact record can be searched for only their
associated Account can be screen popped.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a TigerPaw Phone Call Task. The Account to
associate this with is found using the caller id received or the number dialed.

& If there are multiple Accounts and/or Contacts with the same telephone number then
the first Account retrieved will be associated with the task.

The Activity record is automatically created with the information relating to the call entered into the relevant fields.

Phone number For inbound calls this is the caller ID and for outbound calls this is the dialed
number.

DDI/DID For external inbound calls only, the DDI/DID number that the call came in on.

DDI/DID Name For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

Direction The direction of the call.

Account Code The account codes that was set on the call.

Trunk For external calls the outside network trunk number that the call was made or
received on.

Transferring Extension The device that the call was transferred from.

Duration The duration of the call. The call event trigger must have been set to Call End

as they are not known until the call is cleared.

Call Recording If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

Calendar & DND synchronization
The calendar within TigerPaw can be synchronized with the DND status of the extension of the User. For example when there

is an appointment in the calendar and this is due the extension can be automatically placed into DND with the DND text set to
the subject of the appointment. When the appointment ends, the extension will be automatically removed from DND.
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Calendar

The type of Tasks that can be included in the synchronization can be configured on the Calendar tab.
-1 l7<:_{P LW";.)!‘»

Settings | Profile | Calendar

Task Types
Showe Appointrments Show To-das
Show Phane Calls

Types
Showe Private Shaowe Glabal

Show Appointments: This enables Appointment task to be included in the synchronization.
Show To-dos: This enables To-do tasks to be included in the synchronization.

Show Phone Calls: This enables Phone Calls tasks to be included in the synchronization.
Show Private: This enables Private tasks to be included in the synchronization.

Show Global: This enables Global tasks to be included in the synchronization.

Configuration

Profile

The database authentication details used to connect to the TigerPaw database are configured on the Profile tab.
=1 l7d_{P=_,w-";5!‘»
Profile | Calendar

Details

se Integrated Wifindows Authentication (W)
Usernarme:

Password:

Select Use Integrated Windows Authentication (IWA) to use the login details of the current user, or enter the Username and
Password details into the relevant fields.
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7.7.15 ZenDesk

Overview

Zendesk is an online ticket/customer support CRM; this Document describes the features that are available when integrating
Phone Manager with Zendesk. Zendesk by default only supports one ‘Phone’ field for storing a telephone number; this is the
field that is searched when attempting to find a contact.

Supported Versions

As Zendesk is an online product they have no concept of a version numbering scheme. Phone Manager integration was tested
against the Zendesk V2 API.

Features
Integration with Zendesk supports the features listed below:
e Screen pop for contacts/open tickets

Screen pop

‘end-user’ people or their open tickets can be screen popped when an incoming call is received using the caller id
(CLI) from the inbound call or the dialled number on an outbound call. For example an inbound call is received from
07718402534, if there are no tickets currently open for this ‘end-user’ then their user profile is displayed.
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If multiple matches are found then the Multiple Contact Found dialog is shown:
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Multiple Contacts Found — O et

- Contact: Test User
i Contact: test user 2

Display

The Multiple Contact Found dialog will also be shown if the ‘Search Open tickets on Contact Match’ setting is enabled in
the Phone Manager Plugin. The dialog will allow the selection of the specific ticket item to display:

Multiple Contacts Found — O et

Results

[=I- Contact: Test Uiser
. - Open ticket:2 some ticket related issue
- Contact: test user 2
Open ticket:3 i have an issue

Display

Configuration

Page 193



Mitel Phone Manager 4.3

The integration requires the Zendesk URL and authentication credentials for the user. User password or authentication
token can be used; these are setup on the Zendesk administration by your administrator in the settings/channel/API
section of the Zendesk configuration.

b
“<zendesk

Zendesk Connection Settings

Connection Information

Zendesk URL |}raurcampan}r.zendesk.mm |

[] Us=e Auth Token

Zendesk User D |user@}rnurcnmpan}r.cnm |

Pazzword | |

The option to search for tickets and whether to open the screen pop in a new browser window or in the same logged in
session as selected in the setting tab of the integration, there is also a ‘Test’ button which will test whether the
configured URL and user credentials are correct.

L9 ]
“2zendesk

Zendesk Connection  Settings

Search Cpen Tickets on Contact Match

Cpen Match In MNew Browser

Test
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7.7.16 Zoho CRM

Overview

This describes the features that are available when integrating with Zoho CRM.

Supported Versions

Version Cloud

2014 @

|‘§“-'|‘ The integration uses Zoho CRM Web Services v2014. Although Zoho CRM ftries to maintain backwards compatibility
when they upgrade their cloud platform this is never guaranteed. This version of the plugin has been tested on the
latest version that was available upon release.

Limitations

The Zoho CRM API limits the number of API requests for a company on a per day limit. When searching over multiple modules there
will be a separate API request for each module.

|‘§“-'|‘ Your version of Zoho will determine how many queries you are allowed per day. If you go over that number Zoho will
return an error when sending the query. You will then not be able to make any more queries that day so the screen
pop will not work.

To increase performance it is recommended that you store your telephone numbers in an unformatted string i.e. 08001831234 and turn
off the Advanced Searching option, see the Advanced section for details.

Features
Integration with Zoho CRM supports the features listed below:

e Screen pop for contacts, accounts and leads
e Automatic call history entry

Screen pop

CRM Contact, Account and/or Lead entities can be screen popped directly within CRM when an incoming call is received using
the caller id or from an outgoing call using the dialed number. The telephone number is then used to find any matching entities
that have this number. For example an inbound call is received from 7774441111 as shown on the toaster. The plugin performs
a search to find any records that have matching telephone numbers. A matching Contact entity was found and the record was
automatically displayed using the Users default browser.

m CRM Announcing 8 New Features! Subscription  Setup Help

Home Feeds Leads Accounts Contacts Potentials Campaigns Reports Dashboards Activities Cases

- Edit = Delete | Clone More Actions ~ *.

- Roberto Rivero - Mitel L
Nacho 7774441111 00:02
7774441111
EiD < (777) 4441111

Clear call

v

If multiple matches are found then the Multiple Contacts Found is shown and enables the User to select the correct record to
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be displayed. For example a call is made to 222555444 and this has found three matching entities, a Account, Contact and
Lead, that have this telephone number.

Multiple Contacts Found > B

Account: Account Mame: Mitel
Contact: First Mame: Derian, LastMame: Geroux
- Contact: First Mame: Luka, Last Name: Fape

2225554444 00:01
2225554444

Display @

Clear call

The correct Entity can then be highlighted and then clicking on the Display button will open this record.

Entity and matching options

Configuration options are available on the plugin that allow the type of Entities to be used in the searching to be set. For
example it can be configured so that only the Contact Entities are searched. These options are set on the Options tab

@@ ICRM

Settings | Profile | Server | Options | Call Details | Activitie * | ¥

Screen Pop

Accounts Contacts Leads
Mew Entity

Display blank entity cn ne match

Type Contact W

If no match is found when searching for an Entity than a blank form can be automatically displayed to create a New Entity. The
Type of Entity, Contact, Account or Lead that is created can be set here.

Advanced options
The Advanced tab control how matching contacts are searched for.

/v, Zoho CRM limits the number of calls to its API, and only lets you search for 1 phone number at a time. Zoho
CRM free addition you may only send 250 queries per company per day, meaning if you are searching for the

number 9876543210 in the US, and only searching for the Main Telephone number and only on the Contacts
module, this search will generate 9 queries.
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Ae@ ICRM

Account Fields | Contact Fields | Lead Fields | Advanced | |+ |+

Search Options

[] Enzble Advanced Search

Enabkling Advanced Search will significantly increase
the number of APl queries used per day. Ensure that
your account has encugh capacity for this,

Search fields

The range of telephone numbers that are to be searched for can be configured for each of the Contact, Account or Lead
Entities individually. By default the common telephone number fields are listed on the Leads Fields, Contacts Fields or Account
Fields tab.

2@ CRM

Call Details | Activities | Account Fields | Contact Fields | [+ | »

contact telephone Mobile

numkbers to search Home Phone
Azst Phone
Other Phone
Fax

These are the default field name and descriptions and may be different if they have been customized. Contact your Zoho CRM
administrator for details.

Contact Entities

Field name Field description Enabled?
Main Phone Phone a
Mobile Mobile @
Home Phone Home Phone @
Asst Phone Asst Phone @
Other Phone Other Phone @
Fax Fax @

Account Entities

Field name Field description Enabled?

Phone Phone a
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Fax Fax @

Lead Entities

Field name Field description Enabled?

Phone Phone @
Mobile Mobile @
Fax Fax @

Telephone number formats

Zoho CRM does not provide a standard format for storing telephone numbers within the system by default. The plugin supports
searching for multiple different formats dependent on the region (UK or US) where the client is running. The default formats for
the UK and International are shown below. This is based on the number 08001831234 been searched for.

UK & International Telephone Formats

08001831234 (0123) 4567890 44 (08001)831234 +44 (080)0183 1234
08001 831234 08001-831234 (08001)831234 (08001)-831234
080 018 31234 080-018-31234 080 0183 1234 080-0183-1234

The default formats for the US are shown below. This is based on the number 9876543210 been searched for.

US Telephone Formats

9876543210 987.654.3210 +1 (987) 654-3210 19876543210
987-654-3210 (987) 654-3210 1-987.654.3210 1-987-654-3210
1(987) 654-3210 (987)654-3210

/. Zoho CRM limits the number of calls to its API, and only lets you search for 1 phone number at a time. Zoho
CRM free addition you may only send 250 queries per company per day, meaning if you are searching for the
number 9876543210 in the US, and only searching for the Main Telephone number and only on the Contacts
module, this search will generate 9 queries. To increase performance and reduce queries you can disable the
telephone format searching as described in Advanced section.

Call details

The call information that is used to search for matching records can be configured. By default the dialed number or the caller id
are used to search with, depending on the call direction, but other call details can configured. There are options for the direct
dial number or the direct dial name (or DNIS) as shown.
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Aem ICRM

Call Details | Activities | Account Fields | Contact Fields | Le * | *

Information

Select the call details to
use for the search, Multi
select items to use more
than ocne and re order the
iterns in preference of
search order,

Caller ID (CLI)
] Direct Dial (DDI/DID)
[ DMIS/DDI Name

@‘ Caller ID represents either the caller ID for inbound calls or the dialed number for outbound calls.

The configuration box lets you select multiple different types of call detail with the details to be used having the check box next
to each one selected. The order of the searching can also be configured by dragging and dropping the entry and ordering the
list accordingly.

When multiple call details are used the searching will stop as soon as a match is found with the first call detail.

Automatic call history entry

The plugin supports the ability to be able to automatically create and display a Zoho CRM Phone Call Activity entity. The Entity
to associate this with is found using the caller id received or the number dialed, and if multiple matches are found then

the Multiple Contacts Found window is shown as for the screen popping. The telephone numbers used to search are set in
the screen popping section.

The Activity record is automatically created with the information relating to the call entered into the relevant fields.

Phone number

DDI/DID
DDI/DID Name

Direction
Account Code

Trunk

Transferring Extension

Duration

Call Recording

For inbound calls this is the caller ID and for outbound calls this is the dialed
number.

For external inbound calls only, the DDI/DID number that the call came in on.

For external inbound calls only, the DNIS of the DDI/DID that the call came in
on.

The direction of the call.
The account codes that was set on the call.

For external calls the outside network trunk number that the call was made or
received on.

The device that the call was transferred from.

The duration of the call. The call event trigger must have been set to Call End
as they are not known until the call is cleared.

If integrating with a call recorder then this can contain a URL link to the call
recording (this is not a clickable hyperlink but can be copied and pasted into a
browser). The call event trigger must have been set to at least Call Answered
as the call recorder will only create the recording id when the call has been
answered.

The plugin configuration has options that can be set to determine how the record is created.
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B@m . ICRM

Profile | Server | Options | Call Details | Activities | Accou * |

Call Activity Record

Display Activity Record

Display Activity Record: This will display the Activity form, if this is not set then the record will be created without the user
seeing the form.

Configuration

For any of the features there needs to be some basic configuration that needs to be performed to authenticate and allow
access to Zoho CRM.

Settings and versions

The correct version of Zoho CRM that is used needs to be selected from the Version drop down on the Settings tab.

@@ ICRM

Settings | Profile | Server | Options | Call Details | Activitie * | ¥

Information

Version | Zgho CRM 2014 v

Server connection

The specific connection details to the CRM server need to be set on the Server tab.
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@@ ICRM

Settings | Profile | 3erver | Options | Call Details | Activitie * | *

Website
URL https://crm.zoho.com
Token Url https://accounts.zoho.com

URL: This is the URL of the Zoho CRM server. Contact your administrator for details on what this should be. Leave this as
https://crm.zoho.com for the hosted version.

Token URL: This is the URL of the Zoho CRM accounts server. Contact your administrator for details on what this should be.
Leave this as https://accounts.zoho.com for the hosted version.

Authentication and profile details

The Profile tab enables the security credentials used to access Zoho CRM to be configured.

@@ ICRM

Settings | Profile | Server | Options | Call Details | Activitie * | ¥

Details
Uzername: maurice.abel@mitel.couk
Password: T ITTT
AuthToken Tdcf23a9e350c2f3 371 coblecidBa5f

Username: This is the Zoho CRM username.
Password: This is the Zoho CRM password for this user.

Auth Token: This button generates an authentication token to log into Zoho CRM. You only need to generate this once. If you
already have an authentication token you may enter it in here. The token is generated by Zoho based on your Zoho Username
and password.

Your Zoho CRM administrator can manage AuthTokens through the settings page under Active AuthTokens setting shown.
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@ https//accounts.zoho.com/u/hZsetting/authtoken el ' Google R ﬁ B ¥ @ =

@6 | Accounts | Help~ | Sign Out
Welcome Michael Home Profile Settings Groups

User Profile Photo

>

Settings

Manage your preferences and access information.

Active Authtokens
Access and manage all the active secret auth tokens of your account authorized to different scopes.

Remove Selected
# Upload vour Profile Photo Scope  Service IP
Name Name Address

[ Token Description Generated Time Action

* preferences
g ; Mov 18, 2014 Remove
crmapi  CRM 78.158.57.46 e
RO et 77986d74baf4383913aedc387ec2fo92 14:58:00 PM

Authentication

O ) Mov 18, 2014 Remove

B

Allowed IP Address 7dcf83a9e3506219f571cc60eco4a55f | CMaPl CRM | 78.158.57.46 15:10:55 PM

* Authorized Websites O Nov 18, 2014 Remove
crmapi  CRM 78.158.57.46 s

* Linked Accounts d605caelbaec654c29188dc9d7a00fe3 15:04:42 PM

Mov 18, 2014 Remove

- - O .
* Active Sessions £4345787585(f63f1966c80b226455F0 | SrMapl  CRM 78.158.57.46 15:06:28 PM

* Active Authtokens
= Activity History

* Close Account
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7.8 Diagnostics

Overview

The diagnostics section enables the Phone Manager diagnostics feature to be enabled.
Checking the Diagnostics Enabled option will, after a restart of the client, create logging information for this User in the folder:
%PROGRAMDATA%\Mitel\Mitel Phone Manager\logs\%USERNAME%

["g This should only be enabled on a temporary short term basis as it can affect the performance of the client and
consume significant amount of disk space.

If you are requested to provide logging information for the client by your support team then use the Download logs button as
this will create a ZIP file containing all the logs and configuration information required on the Users desktop that can be emailed
and analyzed.
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8 How To's
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8.1 Importing Phone Manager v3 Personal Contacts

Overview

If the user has upgraded from Phone Manager v3 then their existing personal contacts can be imported. This is only supported
if the users personal contacts have been stored locally (either in the %PROGRAMFILES% folder on the computer they are on,
or in their "My Documents" folder and NOT centrally. If they are stored centrally then they will need to be migrated before
upgrading. If these files are present then Phone Manager will prompt the user automatically when started to import.

Considerations before upgrade

If the user already has version Phone Manager v3 installed on the PC then they had 3 places to save their personal
contacts

1. C:\Users\[Username]\Documents\Application Data\Xarios\Phone Manager.
2. C:\Program Files\Xarios\Xarios Phone Manager\Phone Manager\ConfigFiles
3. On the Xarios Application Server.

To be able to use the migration tool to import to your v4 and above client you need to make sure that the v3 client has
personal contacts stored in either of the local locations i.e. options 1 and 2 above.

You can check where the client’s directory is currently located in the v3 client by:

1. Right clicking on the Phone Manager Icon in the systray and select Settings -> Connection Settings.

Cuick Directory  AltD

Settings ’ |g‘ﬂ Application Settings
Help |'E.; Connection Settings

About =] Macro Design
Exit 11:50

& i m 7O W
SN O 0500

2. Select the Settings tab from the Connection Settings window.

Py Phone Manager - Connections Settings ?

General | Licensing | Settings | Dial Pattems | Advanced

Setting Location
Select the location to store the Phone Manager configuration settings

() Application Server
(@) My Documents

() Program Files

[ ] Migrate current settings

From here will be able to tell where the contacts are located and if needed you can then migrate them to a local
location. Once you have confirmed that the v3 personal contacts are stored locally you then need to install your v4
client.

Once installed open the v4 client and note the pop up box.
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Would you like to import personal contacts from your previous version of Phone

fanager?

LJ IITTS Td WV TS

Click Yes and this will import all previously stored personal contacts. Click No and it will not import or prompt when next
opened. Once complete you will get another pop up box to advise the number of contacts imported.

o 2 legacy contact(s) imported. |a

gf Whilst the import is taking place you do not get a progress bar but this allows you to carry on using your
client.

) TITTS ThaWvIIT TS
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9 Index

ACD Agent Control, 34

Alarm Notifications, 72

API Access, 58

Application Support, 57
Application Support Plugins, 60
Audio, 95

Button Actions, 67-68

Call Banner Profiles, 54

Call Control, 22

Call History, 46

Call Recording, 47

Campaign Manager, 69-70

Chat, 51-52, 83

Codecs, 96

Command Line, 63-64
Configuration, 20

Connection, 76

Contacts, 39-42

Diagnostics, 203

Dial Pad, 30

Directories, 43-44

Do Not Disturb (DND), 33

E911 Warning, Emergency Calls and Security, 93
Editing Presence Profiles, 88-89
Extension Control, 32

General, 94, 80

Goldmine, 104-109

Highlight & Dial, 24

Hot Keys, 53

Hunt Group Status, 73

Importing Phone Manager v3 Personal Contacts, 205-206
Information, 81

Integrated Toolbar, 55
Keep-Alives, 99

Known Issues, 7

License Comparison, 18-19
Licensing, 17

Local Connection, 77

Macros, 59

Making Calls, 23

Manual Forward, 36

Maximizer, 110-112

Microsoft Dynamics CRM, 127-135
Microsoft Dynamics NAV, 136-142
Microsoft Internet Explorer, 143-146
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Microsoft Office 365, 113-116
Microsoft Outlook, 117-126
Mitel Back Page, 209
Multiple Calls, 28-29

NAT and Firewalls, 98
NetSuite CRM+, 147-152
Notice, 4

Numbers, 82

Outlook Features, 21

Overview, 14

Phone Manager User Guide (PDF), 0

Presence Profiles, 48-50
Professional Features, 56
Profile Image, 84

Quality, 97

Quick Start, 8-13

Remote Connection, 78
Requirements, 15-16
Sage CRM, 153-158
SalesForce, 159-165
SalesLogix, 166-176
Searching, 45

Settings, 75

Softphone, 90-92
Softphone Limitations, 100
SugarCRM, 177-182
Swiftpage Act! , 183-188
TAPI, 61-62

Team Leader Features, 71
TigerPaw, 189-191
Toaster, 25

Toolbars, 65
Transferring, 26-27

UCD Hunt Group Calls, 35
URI Schemes, 31

User Control, 74

User Preferences, 79
Voice Mail Access, 37
Volume Control, 38
What's New, 5-6
ZenDesk, 192-194

Zoho CRM, 195-202
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